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1 Introduction

Thank you for choosing this machine.

The bizhub 362, 282, and 222 are equipped with an integrated printer 
controller that allows you to print directly from a personal computer.

This user manual describes the printing functions, operations, usage, and 
safety precautions of the printer controller. In order to ensure that this 
machine is used efficiently, carefully read this manual before using the 
machine.

In order to ensure that this machine is used safely, carefully read "Installation 
and Operation Precautions" in the User manual [Copy Operations] before 
using the machine.

The illustrations used in this user manual may differ from the actual model.
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1.1 Energy Star®

As an ENERGY STAR® Partner, we have determined that this machine meets 
the ENERGY STAR® Guidelines for energy efficiency.

What is an ENERGY STAR® Product?

An ENERGY STAR® product has a special feature that allows it to 
automatically switch to a "low-power mode" after a period of inactivity. An 
ENERGY STAR® product uses energy more efficiently, saves you money on 
utility bills and helps protect the environment.
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1.2 Trademarks and copyright

KONICA MINOLTA, the KONICA MINOLTA logo, and The essentials of 
imaging are registered trademarks of KONICA MINOLTA HOLDINGS, INC.

PageScope and bizhub are registered trademarks of KONICA MINOLTA 
BUSINESS TECHNOLOGIES.

Netscape Communications, the Netscape Communications logo, Netscape 
Navigator, Netscape Communicator, and Netscape are trademarks of 
Netscape Communications Corporation.

Novell and Novell NetWare are registered trademarks of Novell, Inc.

Microsoft, Windows, and Windows NT are registered trademarks of 
Microsoft Corporation.

IBM is a registered trademark of International Business Machines, Inc.

Apple, Macintosh, and Mac are registered trademarks of Apple Computer, 
Inc.

Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and the 
PostScript logo are either registered trademarks or trademarks of Adobe 
Systems Incorporated.

Ethernet is a registered trademark of Xerox Corporation.

PCL is a registered trademark of Hewlett-Packard Company Limited.

All other product and brand names are trademarks or registered trademarks 
of their respective companies or organizations.

Compact-VJE
Copyright 1986-2003 VACS Corp.

RC4® is a registered trademark or trademark of RSA Security Inc. in the 
United States and/or other countries.

RSA® is a registered trademark or trademark of RSA Security Inc. RSA 
BSAFE® is a registered trademark or trademark of RSA Security Inc. in the 
United States and/or other countries.

License information

This product includes RSA BSAFE 
Cryptographic software from RSA Security 
Inc.



1 Introduction

1-6 bizhub 362/282/222

OpenSSL Statement

OpenSSL License

Copyright © 1998-2000 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, 

this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must 
display the following acknowledgment:
"This product includes software developed by the OpenSSL Project for 
use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used 
to endorse or promote products derived from this software without prior 
written permission. For written permission, please contact openssl-
core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor 
may "OpenSSL" appear in their names without prior written permission 
of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following 
acknowledgment:
"This product includes software developed by the OpenSSL Project for 
use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND 
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING 
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young 
(eay@crypt-Soft.com). This product includes software written by Tim 
Hudson (tjh@cryptsoft.com).
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Original SSLeay License

Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young 
(eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.
This library is free for commercial and non-commercial use as long as the 
following conditions are aheared to. The following conditions apply to all 
code found in this distribution, be it the RC4, RSA, Ihash, DES, etc., code; 
not just the SSL code.
The SSL documentation included with this distribution is covered by the 
same copyright terms except that the holder is Tim Hudson 
(tjh@cryptsoft.com).
Copyright remains Eric Young’s, and as such any Copyright notices in the 
code are not to be removed. If this package is used in a product, Eric Young 
should be given attribution as the author of the parts of the library used. This 
can be in the form of a textual message at program startup or in 
documentation (online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list 

of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must 
display the following acknowledgement:
"This product includes cryptographic software written by Eric Young 
(eay@crypt-soft.com)"
The word ‘cryptographic’ can be left out if the rouines from the library 
being used are not cryptographic related.

4. If you include any Windows specific code (or a derivative thereof) from 
the apps directory (application code) you must include an 
acknowledgement:
"This product includes software written by Tin Hudson 
(tjh@cryptsoft.com)"
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THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT 
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or 
derivative of this code cannot be changed. i.e. this code cannot simply be 
copied and put under another distribution licence [including the GNU Public 
Licence.]

All other product names mentioned are trademarks or registered trademarks 
of their respective companies

Kerberos

Copyright © 1985-2005 by the Massachusetts Institute of Technology. All 
rights reserved.

permission notice

WITHIN THAT CONSTRAINT, permission to use, copy, modify, and 
distribute this software and its documentation for any purpose and without 
fee is hereby granted, provided that the above copyright notice appear in all 
copies and that both that copyright notice and this permission notice appear 
in supporting documentation, and that the name of M.I.T. not be used in 
advertising or publicity pertaining to distribution of the software without 
specific, written prior permission. Furthermore if you modify this software 
you must label your software as modified software and not distribute it in 
such a fashion that it might be confused with the original MIT software.
M.I.T. makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty.

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED 
WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.

THIS SOFTWARE IS NOT ORIGINAL MIT SOFTWARE, MODIFIED BY 
KONICA MINOLTA BUSINESS TECHNOLOGIES, INC.
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Copyright

© 2008 KONICA MINOLTA BUSINESS TECHNOLOGIES, INC. All Rights 
Reserved.

2
Note 

This user manual may not be reproduced in part or in full without 
permission.

Konica Minolta Business Technologies, Inc. will not be held liable for any 
incidents caused by using this printing system or user manual. 

Information included in this user manual is subject to change without 
notice.

Konica Minolta Business Technologies, Inc. maintains the copyright of 
the printer drivers.
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1.3 Software license agreement

This package contains the following materials provided by Konica Minolta 
Business Technologies, Inc. (KMBT): software included as part of the printing 
system ("Printing Software"), the digitally-encoded machine-readable outline 
data encoded in the special format and in the encrypted form ("Font 
Programs"), other software which runs on a computer system for use in 
conjunction with the Printing Software ("Host Software"), and related 
explanatory written materials ("Documentation"). The term "Software" shall 
be used to describe Printing Software, Font Programs and/or Host Software 
and also include any upgrades, modified versions, additions, and copies of 
the Software.

The Software is being licensed to you under the terms of this Agreement.

KMBT grants to you a non-exclusive sublicense to use the Software and 
Documentation, provided that you agree to the following:
1. You may use the Software and accompanying Font Programs for imaging 

to the licensed output de-vice(s), solely for your own internal business 
purposes.

2. In addition to the license for Font Programs set forth in Section 1 above, 
you may use Roman Font Programs to reproduce weights, styles, and 
versions of letters, numerals, characters and symbols ("Typefaces") on 
the display or monitor for your own internal business purposes.

3. You may make one backup copy of the Host Software, provided your 
backup copy is not installed or used on any computer. Notwithstanding 
the above restrictions, you may install the on any number of computers 
solely for use with one or more printing systems running the Printing 
Software.

4. You may assign its rights under this Agreement to an assignee of all of 
Licensee’s right and interest to such Software and Documentation 
("Assignee") provided you transfer to Assignee all copies of such 
Software and Documentation Assignee agrees to be bound by all of the 
terms and conditions of this Agreement.

5. You agree not to modify, adapt or translate the Software and 
Documentation.

6. You agree that you will not attempt to alter, disassemble, decrypt, 
reverse engineer or decompile the Software.

7. Title to and ownership of the Software and Documentation and any 
reproductions thereof shall remain with KMBT and its licensor.

8. Trademarks shall be used in accordance with accepted trademark 
practice, including identification of the trademark owner’s name. 
Trademarks can only be used to identify printed output produced by the 
Software. Such use of any trademark does not give you any rights of 
ownership in that trademark.
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9. You may not rent, lease, sublicense, lend or transfer versions or copies 
of the Software Licensee does not use, or Software contained on any 
unused media, except as part of the permanent transfer of all Software 
and Documentation as described above.

10. IN NO EVENT WILL KMBT OR ITS LICENSOR BE LIABLE TO YOU FOR 
ANY CONSEQUENTIAL, INCIDENTAL INDIRECT, PUNITIVE OR 
SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS OR LOST 
SAVING, EVEN IF KMBT HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY. KMBT 
OR ITS LICENSOR DISCLAIMS ALL WARRANTIES WITH REGARD TO 
THE SOFTWARE, EXPRESS OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT OF 
THIRD PARTY RIGHTS. SOME STATES OR JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTIAL, 
CONSEQUENTIAL OR SPECIAL DAMAGES, SO THE ABOVE 
LIMITATIONS MAY NOT APPLY TO YOU.

11. Notice to Government End Users: The Software is a "commercial item," 
as that term is defined at 48 C.F.R.2.101, consisting of "commercial 
computer software" and "commercial computer software 
documentation," as such terms are used in 48 C.F.R. 12.212. Consistent 
with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4, all 
U.S. Government End Users acquire the Software with only those rights 
set forth herein.

12. You agree that you will not export the Software in any form in violation of 
any applicable laws and regulations regarding export control of any 
countries.
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1.4 About this user manual

This user manual contains information for using the printing functions of the 
Konica Minolta printer controller. For details on the copy functions, scanning 
functions, box functions, and fax functions, refer to the respective user 
manual.

This user manual is aimed at users who already have the basic knowledge of 
computer and copier operations. For Windows or Macintosh operating 
system and application operations, refer to the operation manual of the 
respective product.

User manuals

The user manuals for this machine are divided by function and consist of the 
following:

Notations

Screen images in this user manual

Unless stated otherwise, the printer driver functions are described using the 
printer driver for Windows XP.

User manual Description

Print Operations This user manual. Read this guide when using this machine as 
a printer.

Copy Operations Read this guide when you want to learn about the basic oper-
ations and copy operations of this machine.

Network Scanner Operations Read this guide when using this machine as a scanner.

Box Operations Read this guide when using this machine’s box functions.

Facsimile Operations Read this guide when using the optional fax functions.

Advanced Scan Operations Read this guide when using the optional scanner unit func-
tions.

Product name Description

KONICA MINOLTA 362/282/222
This machine

This machine, copier, or printer

Integrated network controller Printer controller

Printer controller, including this machine, 
and printing system

Printing system

Microsoft Windows Windows
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1.5 Explanation of manual conventions

The marks and text formats used in this manual are described below.

Safety advices

6 DANGER
Failure to observe instructions highlighted in this manner may result in 

fatal or critical injuries in fact of electrical power.

% Observe all dangers in order to prevent injuries.

7 WARNING
Failure to observe instructions highlighted in this manner may result in 

serious injuries or property damage.

% Observe all warnings in order to prevent injuries and to ensure safe use 
of the copier.

7 CAUTION 
Failure to observe instructions highlighted in this manner may result in 

slight injuries or property damage.

% Observe all cautions in order to prevent injuries and to ensure safe use 
of the copier.

Sequence of action

1 The number 1 as formatted here 
indicates the first step of a sequence 
of actions. 

2 Subsequent numbers as formatted 
here indicate subsequent steps of a 
sequence of actions.

? Text formatted in this style 
provides additional assistance. 

% Text formatted in this style describes the action that will ensure the 
desired results are achieved. 

An illustration inserted 
here shows what operations 

must be performed.
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Tips

2
Note 

Text highlighted in this manner contains useful information and tips to 
ensure safe use of the copier.

2
Reminder 

Text highlighted in this manner contains information that should be 
reminded.

!
Detail 

Text highlighted in this manner contains references for more detailed 
information.

Special text markings

[Copy] key
The names of keys on the control panel are written as shown above.

MACHINE SETTING

Display texts are written as shown above.
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2 Overview

2.1 Printer controller

The printer controller is a device for performing printing functions and 
network printing functions with this machine.

Role of the printer controller

The printer controller is built into the machine.

You can print from applications on the computer connected to the printing 
system. When using this machine as a network printer, you can print from 
applications on the computer.

Available printer controller functions

The printer controller provides the following functions.
- Printing from a computer (using a printer driver)
- Support of network protocols including TCP/IP, NetBEUI, IPX/SPX, and 

AppleTalk
- Direct printing over a network using Windows (SMB), LPR, and IPP 

printing
- Access to settings for this machine and the printer controller from a client 

computer over the network (using a Web browser)
- Control of the number of pages printed ("User Authentication" and 

"Account Track" function, excluding external server authentication)

2
Note 

Only the PCL printer driver can be used with Windows printing.

Computer

Printing system

Machine

Printer 
controller
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Machine modes

The printer driver settings are mainly set using a computer, however, the font 
list can be printed, and the printer controller settings and default print 
settings can be set using the control panel of this machine. In addition, fax 
and scanning operations can be used by switching the mode.

To switch between modes, press the mode keys on the control panel.

[Copy]
Switches to the copy mode.

[Fax/Scan]
Switches to the fax/scan mode.
To use the fax function, optional fax kit is required.

[Extra Scan]
Switches to the extra scan mode.
To use the extra scan function, optional fax kit or scanner unit is required.

[Box]
Switches to the box mode.

!
Detail 

You can use this machine as a printer in all modes.

Change the default print settings in the Utility mode.

Accessibility

Access ABC DEF

JKLGHI MNO

TUVPQRS WXYZ

Interrupt

ResetResetCopyCopyFax/ScanExtra ScanBox

Mode Memory

Mode Check

Main PowerMain Power

StopStop

PowerPower
Proof CopyProof Copy

StartUtility/
Counter

Enlarge Display

Contrast
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Printing flow

When using this printing system as a printer, the flow of the main process is 
described below.

Print commands transmitted from the application are received by the printer 
driver.

Data is transmitted to this machine over a parallel interface (IEEE 1284) when 
this machine is used as a local printer, over a USB interface when this 
machine is used as a USB printer, or over an Ethernet interface (TCP/IP, 
IPX/SPX, or AppleTalk) when this machine is used as a network printer. The 
printer controller then performs image rasterization (development of output 
characters and images to bitmap data). Finally, this data is printed from this 
machine.
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2
Note 

To connect the parallel interface, the optional local interface kit is 
required.

When a print job is received during copying, the data is stored in the memory 
of this machine. When copying is complete, the print job is automatically 
printed.

Used as a local 
printer

Application

Printer driver

Parallel interface 
(IEEE 1284)

Print

Computer

Used as a USB 
printer

Application

Printer driver

Machine

PS/PCL processing (rasterizing)

Used as a network 
printer

Application

Printer driver

Ethernet (TCP/IP,IPX/ 
SPX, or AppleTalk)

Printer controller

USB
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2.2 Operating environment

The system requirements for using this printing system and the interfaces 
used for connection are explained below.

Connectable computers and operating systems

Check that the computer being connected meets the following conditions.

Windows

Item Operating environment

Operating system Windows NT 4.0 (Service Pack 6a or later), Windows 2000 Pro-
fessional (Service Pack 4 or later), Windows XP Home Edi-
tion/Professional (Service Pack 2 or later), Windows XP 
Professional x64 Edition, Windows Vista Home Basic/Home Pre-
mium/Ultimate/Business/Enterprise, Windows Vista Home Ba-
sic/Home Premium/Ultimate/Business/Enterprise x64 Edition, 
Windows Server 2003 Standard Edition, Windows Server 2003 
x64 Edition, Windows Server 2008, or Windows Server 2008 x64 
Edition

Processor Pentium or higher

Memory Capacity recommended for the operating system
With sufficient memory resources in the operating system and 
application being used

Drive DVD-R

Web browser
(when using PageScope 
Web Connection)

Windows NT 4.0
• Microsoft Internet Explorer 4 or later recommended
• Netscape Navigator 4.73 or 7.0
Windows 2000
• Microsoft Internet Explorer 5 or later recommended
• Netscape Navigator 7.0
Windows XP/Server 2003
• Microsoft Internet Explorer 6 or later recommended
• Netscape Navigator 7.0
Windows Vista/Server 2008
• Microsoft Internet Explorer 7 or later
• Netscape Navigator 7.0
*If using Microsoft Internet Explorer 5.5, use Service Pack 1 or 
later.
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Macintosh

Connectable interfaces

The various interfaces that can be used to connect this printing system to a 
computer are described below.

Ethernet interface

Connect when using this printing system as a network printer.

Supports 10Base-T and 100Base-TX standards. In addition, the Ethernet 
interface supports the TCP/IP (LDP/LPR), IPX/SPX (NetWare), and AppleTalk 
(EtherTalk) protocols.

Parallel interface (optional)

Connect when using this printing system as a local printer.

A computer running Windows and an IEEE 1284 parallel cable are required 
for connection. Use a parallel cable that uses a terminal with an Amphenol 
36-pin male connector.

The parallel interface supports the compatible, nibble, and ECP modes.

USB interface

Connect when using this printing system as a network printer.

The USB interface can be connected to a computer running Windows 
2000/XP/Vista/Server 2003/Server 2008. A USB cable is required for 
connection. Use a type A (4 pin, male) or type B (4 pin, male) USB cable. A 
USB cable measuring 3 meters or less is recommended.

2
Note 

The USB interface cannot be connected to computers running Windows 
NT 4.0 or Mac OS 9/OS X.

Item Operating environment

Operating system Mac OS 9.2, Mac OS X 10.2, Mac OS X 10.3, Mac OS X 10.4, or 
Mac OS X 10.5

Processor PowerPC, Intel Processor (Intel Processor for Mac OS X 10.4 on-
ly)

Memory Capacity recommended for the operating system

Drive DVD-R

Web browser
(when using PageScope 
Web Connection)

Netscape Navigator 7.0



Overview 2

bizhub 362/282/222 2-9

Connection diagram

The printer cables can be connected to each port at the back of this 
machine.

2
Note 

To connect this machine to a computer using a parallel connection, 
optional local interface kit is required.

TEL PORT 1

LINE PORT 1

TEL PORT 2

LINE PORT 2

Parallel cable
Parallel port

USB port

USB 
cable

Ethernet (10Base-T or 100Base-TX)
Machine (rear view)
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2.3 Setting up the system

In order to use this printing system, it must first be set up.

Setup consists of connecting this machine to a computer and installing the 
printer driver onto the computer being used.

To set up the printing system

Setup the printing system as described below.

1 Connect this machine to a computer. (Refer to "Connectable 
interfaces" on page 2-8.)

2 Install the printer driver. (Refer to "Installing the printer driver" on 
page 3-3.)

3 When using a network connection, set up the network. (Refer to 
"Setting up network printing" on page 4-3.)

4 Check the setup by printing a test page. (Refer to "Test printing" on 
page 5-4.)

5 Install the screen fonts.

– The DVD-R contains the Latin TrueType fonts as the screen fonts.
– Install the screen fronts after adding the operating system standard 

fonts.
– For details, refer to Help of the operating system.
– The screen fonts are located on the DVD-R.
– To install the Macintosh fonts, install the fonts after decompressing 

them.

Installation of the printer driver may differ depending on the connection 
method used with this machine in addition to the operating system of the 
computer and the type of printer driver being used.

!
Detail 

For details on connecting this machine to a computer, refer to 
"Connectable interfaces" on page 2-8.
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2
Note 

To update an existing printer driver, delete the existing printer driver first. 
For details, refer to "Uninstalling the printer driver" on page 3-19 and 
page 3-30.

If using the optional parallel interface, set the interface time settings and 
mode (Compatible, Nibble, or ECP) as necessary with the PageScope 
Web Connection and on the control panel. For details, refer to "Print tab 
- Local I/F" on page 11-62.
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3 Installing the printer driver

3.1 Printer drivers and supported operating systems

In order to use this printing system, the printer driver must be installed. The 
printer driver is a program that controls the processing of data for output. 
Install the printer driver onto the computer from the provided DVD-R.

The printer drivers included on the DVD-R and the supported computer 
operating systems are listed below. Install the required printer driver.

* The DVD-R contains the PCL printer driver and the PostScript drivers.

Printer driver Page description 

language

Supported operating systems

Konica Minolta PCL 
driver

PCL Windows NT 4.0 (Service Pack 6a or later), 
Windows 2000 Professional (Service Pack 4 or 
later), Windows XP Home Edition/Professional 
(Service Pack 2 or later) and Windows Server 
2003

Konica Minolta PCL 
driver (VXL) for Win-
dows Vista

Windows Vista Home Basic/Home Premi-
um/Ultimate/Business/Enterprise, Windows 
Vista Home Basic/Home Premium/Ulti-
mate/Business/Enterprise x64 Edition, Win-
dows Server 2008, Windows Server 2008 x64 
Edition

Konica Minolta
(PostScript driver)

PostScript 3
emulation

Windows NT 4.0 (Service Pack 6a or later), 
Windows 2000 Professional (Service Pack 4 or 
later), Windows XP Home Edition/Professional 
(Service Pack 2 or later), Windows XP Profes-
sional x64, Windows Server 2003 and Win-
dows 2003 Server x64

Konica Minolta Post-
Script driver (VPS) for 
Windows Vista

Windows Vista Home Basic/Home Premi-
um/Ultimate/Business/Enterprise, Windows 
Vista Home Basic/Home Premium/Ulti-
mate/Business/Enterprise x64 Edition, Win-
dows Server 2008, Windows Server 2008 x64 
Edition

PostScript PPD
driver

Mac OS 9.2 or later,
Mac OS X 10.2, Mac OS X 10.3,
Mac OS X 10.4, and Mac OS X 10.5
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3.2 When used with Windows

The installation procedure for the Windows printer driver differs depending 
on how this machine is connected to the computer and depending on which 
printer driver is used. The installation method also differs depending on the 
version of Windows that you are using. Refer to the table below for the 
appropriate procedure for installing the printer driver on your computer.

Printer driver Connection 

method

Refer to

Konica Minolta 
PCL driver
Konica Minolta 
PostScript driver

All connection 
methods

"Automatic installation using the installer" on 
page 3-6

Network connec-
tion

"Installing the printer driver using the Add Printer 
Wizard" on page 3-12
"For Windows 2000/NT 4.0" on page 3-17
"For Windows XP/Server 2003" on page 3-12
"For Windows Vista/Server 2008" on page 3-14

Parallel connection "Installing the printer driver using Plug and Play" on 
page 3-9
"For Windows 2000" on page 3-9
"For Windows XP/Server 2003" on page 3-10
"For Windows Vista/Server 2008" on page 3-11
"Installing the printer driver using the Add Printer 
Wizard" on page 3-12
"For Windows 2000/NT 4.0" on page 3-17
"For Windows XP/Server 2003" on page 3-12
"For Windows Vista/Server 2008" on page 3-14

USB connection "Installing the printer driver using Plug and Play" on 
page 3-9
"For Windows 2000" on page 3-9
"For Windows XP/Server 2003" on page 3-10
"For Windows Vista/Server 2008" on page 3-11
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2
Note 

For details on installing the printer driver in a network environment, refer 
to "Setting up network printing" on page 4-3. Because it is necessary to 
specify other network settings in advance when installing the printer 
driver using a network connection, install it using a local connection at 
this time.

To install the printer driver under Windows XP, Windows Vista, Windows 
Server 2008, Windows Server 2003, Windows 2000, or Windows NT 4.0, 
log on using a user name that is authorized by the administrator.

The printer driver can be installed using the Add Printer Wizard, however, 
if used, the Plug and Play screen will appear each time the computer is 
started.

To connect this machine to a computer using a parallel connection, the 
optional local interface kit is required.
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Automatic installation using the installer

With the installer, this machine is detected to determine whether it is 
connected by USB or is on the same TCP/IP network as the computer, and 
then the required printer is automatically installed. You can also manually 
specify the printer driver to be installed.

2
Note 

Since this machine is automatically detected with a network connection, 
be sure to set the IP address of this machine before connecting it. For 
details on specifying the settings, refer to "Setting the IP address for this 
machine" on page 4-7.

When installing on Windows NT 4.0, 2000, XP, Vista, Server 2003, or 
Server 2008, administrator permissions are required.

If the wizard starts up in order to add new hardware with a USB or parallel 
connection, click [Cancel].

For IPP printing, it is not necessary to install the printer driver at this time 
since IPP printing setup is performed when the printer driver is installed. 
For further details on IPP printing, refer to "IPP printing 
(Windows 2000/XP/Vista/Server 2003/Server 2008)" on page 4-17.

Installer operating environment

* With Windows NT 4.0, in order to install a machine that is connected directly to a network using 
the TCP/IP protocol, Microsoft TCP/IP Printing Service must first be installed on the computer 
being used.

Item Operating environment

Operating system Windows NT 4.0 (Service Pack 6a or later), Windows 2000 Pro-
fessional (Service Pack 4 or later), Windows XP Home Edi-
tion/Professional (Service Pack 2 or later), Windows XP 
Professional x64 Edition, Windows Vista Home Basic/Home Pre-
mium/Ultimate/Business/Enterprise, Windows Vista Home Ba-
sic/Home Premium/Ultimate/Business/Enterprise x64 Edition, 
Windows Server 2003 Standard Edition, Windows Server 2003 
x64 Edition, Windows Server 2008, or Windows Server 2008 x64 
Edition

Processor Pentium 300 MHz or higher recommended

Memory 64 MB or more (128 MB or more recommended)
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To install the printer driver

1 Insert the DVD-R into the computer’s DVD-R drive.

2 Click "Printer Install".

– If the "User Account Control" window appears when installing on 
Windows Vista/Server 2008, click the [Allow] button or the 
[Continue] button.

The installation of the printer driver starts.

3 Click the [AGREE] button if you agree with all terms and conditions of 
the license agreement.

– If you do not agree with the terms and conditions of the license 
agreement, the software cannot be installed.

– You can change the display language of the installer box in the 
lower-left corner.

4 When the setup selection dialog box appears, click the [Install 
Printers/MFPs] button, and then click the [Next] button.

The connected printers and copiers are detected.
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5 Select this machine and proceed with the installation.
Follow the on-screen instructions to complete the installation.

– If the connection of this machine cannot be recognized or for 
parallel connections, the machine will not be listed. When this 
occurs, select "Specify the Printer/MFP Except for the Above. (IP 
Address, Host Name...)", and then select the print from the box.
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Installing the printer driver using Plug and Play

For Windows 2000

1 After using a parallel cable or a USB cable to connect this machine to 
a computer, turn the main power of this machine on.

– Do not disconnect or connect the cable while the computer is 
starting up.

2 Start the computer.

The Found New Hardware Wizard starts up.

3 Insert the DVD-R into the computer’s DVD-R drive.

4 Select "Search for a suitable driver for my device (recommended)", and 
then click the [Next] button.

5 Select "Specify a location", and then click the [Next] button.

6 Specify the folder on the DVD-R that contains the printer driver for the 
operating system that you are using, and then click the [OK] button.
Printer drivers that can be selected:

7 Click the [OK] button, and then follow the on-screen instructions.

8 Click the [Finish] button.

9 When installation is complete, make sure that the icon of the installed 
printer appears in the Printers window.

10 Remove the DVD-R from the DVD-R drive.

This completes the printer driver installation.
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For Windows XP/Server 2003

1 After using a parallel cable or a USB cable to connect this machine to 
a computer, turn the main power of this machine on.

– Do not disconnect or connect the cable while the computer is 
starting up.

2 Start the computer.

The Found New Hardware Wizard starts up.

3 Insert the DVD-R into the computer’s DVD-R drive.

4 Select "Install from a list or specific location (Advanced)", and then 
click the [Next] button.

5 Under "Search for the best driver in these locations", select "Include 
this location in the search", and then click the [Browse] button.

6 Specify the folder on the DVD-R that contains the printer driver for the 
operating system that you are using, and then click the [OK] button.

7 Click the [Next] button, and then follow the on-screen instructions.

– When the Digital Signature dialog box appears, click the [Continue] 
button.

8 Click the [Finish] button.

9 When installation is complete, make sure that the icon of the installed 
printer appears in the Printers and Faxes window.

10 Remove the DVD-R from the DVD-R drive.

This completes the printer driver installation.
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For Windows Vista/Server 2008

1 After using a parallel cable or a USB cable to connect this machine to 
a computer, turn the main power of this machine on.

– Do not disconnect or connect the cable while the computer is 
starting up.

2 Start the computer.
The Found New Hardware dialog box appears.

– If the Found New Hardware Wizard dialog box does not appear, 
turn off this machine, then on again.

– When turning off the power, then on again, wait at least 10 seconds 
before turning it on again. Otherwise, this machine may not function 
properly.

3 Click "Locate and install driver software (recommended)".
The dialog box prompting you to insert the disk appears.

4 Insert the printer DVD-R into the computer's DVD-R drive.

The information on the disk is retrieved. A list of software supporting 
this machine appears.

5 Specify the name of the desired printer driver, and then click the [Next] 
button.

– Printer drivers that can be selected:
Windows Vista/Server 2008: Konica Minolta PCL driver (VXL), 
Konica Minolta PostScript driver (VPS)

6 Follow the on-screen instructions.

– If the "User Account Control" window appears, click the [Continue] 
button.

– If the dialog box of Windows Security appears, click "Install this 
driver software anyway".

7 When the installation is completed, click the [Close] button.

8 When the installation is completed, make sure that the icon of the 
installed printer appears in the Printers window.

9 Remove the DVD-R from the DVD-R drive.

This completes the printer driver installation.
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Installing the printer driver using the Add Printer Wizard

2
Note 

For IPP printing, it is not necessary to install the printer driver at this time 
since IPP printing setup is performed when the printer driver is installed.

For further details on IPP printing, refer to "IPP printing 
(Windows 2000/XP/Vista/Server 2003/Server 2008)" on page 4-17.

For details on installing the printer driver in a network environment, refer 
to "Setting up network printing" on page 4-3. Because it is necessary to 
specify other network settings in advance when installing the printer 
driver using a network connection, install it using a local connection at 
this time.

For Windows XP/Server 2003

1 Insert the DVD-R into the computer’s DVD-R drive.

2 Click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the 
Control Panel from the Start menu, select "Printers and Other 
Hardware", and then select "Printers and Faxes".

3 For Windows XP, click "Add a printer" on the "Printer Tasks" menu.

– For Windows Server 2003, double-click the "Add Printer" icon.

The Add Printer Wizard starts up.

4 Click the [Next] button.

Windows Server 2003Windows XP
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5 Select "Local printer attached to this computer", and then click the 
[Next] button.

– Clear the "Automatically detect and install my Plug and Play 
printer" check box.

6 The Select a Printer Port dialog box appears. Select "LPT1" here, and 
then click the [Next] button.

7 Click the [Have Disk] button.

8 Click the [Browse] button.

9 Specify the folder on the DVD-R that contains the printer driver for the 
operating system that you are using, and then click the [OK] button.

10 Click the [OK] button.

The "Printers" list appears.
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11 Click the [Next] button.

12 Follow the on-screen instructions.

– When the Digital Signature message appears, click the [Continue] 
button.

– When using a network connection, perform a test print after the 
network settings have been specified.

13 When installation is complete, make sure that the icon of the installed 
printer appears in the Printers and Faxes window.

14 Remove the DVD-R from the DVD-R drive.

This completes the printer driver installation.

For Windows Vista/Server 2008

1 Insert the printer DVD-R into the computer's DVD-R drive.

2 Click the [Start] button, and then click "Control Panel".

3 Click "Printers" under "Hardware and Sound".

– If Control Panel is displayed with Classic View, double-click 
"Printers".

The Printers window appears.

4 Click "Add a printer" from the toolbar.

The Add Printer window appears.
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5 Click "Add a local printer".

– For details on installing the printer driver in a network environment, 
refer to "Setting up network printing" on page 4-3. Because it is 
necessary to specify other network settings in advance when 
installing the printer driver using a network connection, install it 
using a local connection at this time.

– If an IP address is specified on this machine, the machine can be 
installed by retrieving it on the network by clicking "Add a network, 
wireless or Bluetooth printer" in step 5.

The Select a Printer Port dialog box appears.

6 Select "LPT1: (Printer Port)" from "Use an existing port", and then click 
the [Next] button.

7 Click the [Have Disk] button.

8 Click the [Browse] button.

9 Specify the desired folder on the DVD-R that contains the printer driver, 
and then click the [Open] button.
Select the specified folder according to the printer driver to be used 
and the language.

10 Click the [OK] button.

The "Printers" list appears.
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11 Select the printer to be installed, and then click the [Next] button.

12 Follow the on-screen instructions.

– If the User Account Control window appears, click the [Continue] 
button.

– If the Verify the publisher dialog box of Windows Security appears, 
click "Install this driver software anyway".

– When using a network connection, perform a test print after the 
network settings have been specified.

13 After installation is completed, make sure that the icon of the installed 
printer appears in the Printers window.

14 Remove the DVD-R from the DVD-R drive.

This completes the printer driver installation.
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For Windows 2000/NT 4.0

1 Insert the DVD-R into the computer’s DVD-R drive.

2 Click the [Start] button, point to "Settings", and then click "Printers".

The Printers window appears.

3 Double-click the "Add Printer" icon.

The Add Printer Wizard starts up.

4 Follow the on-screen instructions.

5 On the screen for selecting the printer connection, select "Local 
Printer".

6 Click the [Next] button.

7 For Windows 2000, specify the connection port. 
Select "LPT1" here, and then click the [Next] button.

8 Click the [Have Disk] button.

9 Click the [Browse] button.
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10 Specify the folder on the DVD-R that contains the printer driver for the 
operating system that you are using, and then click the [OK] button.

11 Click the [OK] button.

The "Printers" list appears.

12 Click the [Next] button.

– For Windows 2000, proceed to step 14.

13 Specify the connection port. Select "LPT1" here.

14 Follow the on-screen instructions.

– When using a network connection, perform a test print after the 
network settings have been specified.

15 When installation is complete, make sure that the icon of the installed 
printer appears in the Printers window.

16 Remove the DVD-R from the DVD-R drive.

This completes the printer driver installation.
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Uninstalling the printer driver

If it becomes necessary to delete the printer driver, for example, when you 
want to reinstall the printer driver, follow the procedure below to delete the 
driver.

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", 
and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click 
"Printers and Faxes".
For Windows Vista/Server 2008, click the [Start] button, and then click 
"Control panel", "Hardware and Sound", and "Printers".

– If "Printers and Faxes" does not appear in the Start menu in 
Windows XP/Server 2003, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select 
"Printers and Faxes".
For Windows Vista/Server 2008, if the control panel is in the classic 
view, double-click "Printers".

2 In the Printers window (for Windows XP/Server 2003, Printers and 
Faxes window), select the icon of the printer that you want to delete.

3 Press the [Delete] key on the computer keyboard to delete the printer 
driver.

4 Follow the on-screen instructions.

– When the printer driver has been deleted, the printer icon will 
disappear from the Printers window (for Windows XP/Server 2003, 
Printers and Faxes window).

For Windows NT 4.0, this completes the uninstallation procedure. 
Continue with step 11.
For Windows 2000/XP/Vista/Server 2003/Server 2008, delete the 
driver from the server properties.

5 Open "Server Properties".

– For Windows 2000/XP/Server 2003, click the "File" menu, and then 
click "Server Properties".

– For Windows Vista/Server 2008, right-click space in the Printers 
window and click "Run as administrator", then click "Server 
Properties".

6 Click the Drivers tab.
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7 Select the printer driver to be deleted from the "Installed printer drivers" 
list, and then click the [Remove] button.

– For Windows 2000/XP/Server 2003, continue with step 9.
– For Windows Vista/Server 2008, continue with step 8.

8 Select "Remove driver and driver package" on the deletion 
confirmation screen and then click the [OK] button.

9 Click the [Yes] button on the deletion confirmation screen.

– For Windows Vista/Server 2008, when the deletion confirmation 
screen is additionally displayed, click the [Delete] button.

10 Close the Print Server Properties dialog box and Printers window (for 
Windows XP/Server 2003, "Printers and Faxes" window).

11 Restart the computer.

This completes the uninstallation procedure.

2
Note 

Be sure to restart the computer.

Even if the printer driver is deleted using the method described above, 
the model information file will remain in the computer for Windows 
2000/XP/Server 2003. Therefore, the driver may not be able to be 
overwritten when reinstalling the same version of the printer driver. When 
installing the same version of the printer driver, be sure to also delete the 
files described below.
Check the "C:\WINDOWS\system32\spool\drivers\w32x86" folder and 
delete the folder of the corresponding model if it is available. If the Konica 
Minolta PCL driver and Konica Minolta PostScript driver are both 
installed, the model information of both drivers is deleted. If one driver is 
remaining, do not delete it.
Delete the "oem*.inf" and "oem*.PNF" files in the "C:\WINDOWS\inf" 
folder. (The asterisk (*) in the file name displays a number, and the 
number varies according to the environment of the computer.)
Before deleting the files, open the INF file, check that the model name is 
described in the last several lines, and then check that the file of the 
corresponding model is available.
The PNF file is the same number as the INF file.

In Windows Vista/Server 2008, when you have deleted a file using 
"Remove driver and driver package", this operation is not required.
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3.3 When used with Macintosh

Installation procedure of the Macintosh printer driver differs depending on 
the Mac OS version and printer driver being used. Refer to the table below 
for the appropriate procedure for installing the printer driver on your 
Macintosh computer.

Installing the printer driver

For Mac OS X

1 Turn the Macintosh computer on.

2 Insert the DVD-R into the computer’s DVD-R drive.

– Quit all running applications that may have started when the 
Macintosh computer was turned on.

3 Open the "OS10_2_x", "OS10_3_x" or "OS10_5_x" folder from 
"Driver", which is located in a language folder on the DVD-R.

4 Select the Mac OS version being used, and then copy the drive file onto 
the desktop.
Mac OS X 10.2: KONICAMINOLTA_362_102.pkg
Mac OS X 10.3: KONICAMINOLTA_362_103.pkg
Mac OS X 10.4: KONICAMINOLTA_362_103.pkg

The Mac OS X 10.5 offers different driver files according to how the 
machine is used. Select the appropriate file according to your use 
environment.
Mac OS X 10.5:
If you mainly use A4 size for printing
In "A4" folder: KONICAMINOLTA_362_105.pkg
If you mainly use Letter (8 1/2x11) size for printing
In "Letter" folder: KONICAMINOLTA_362_105.pkg

Mac OS Printer driver Refer to

Mac OS X 10.2, 
Mac OS X 10.3, 
Mac OS X 10.4, 
and Mac OS X 10.5

PostScript PPD "Installing the printer driver" on page 3-21

Mac OS 9.2 or later PostScript PPD "Selecting a printer" on page 3-23
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5 Double-click the file copied onto the desktop.

– Enter the requested administrator’s name and password.
– For the administrator’s name and password, ask your network 

administrator.
– To quite the installation, click the [Cancel] button.

6 Click the [Continue] button and follow the on-screen instructions until 
the Installation dialog box appears.

7 On the Easy Install dialog box, click the [Install] button.

– For Mac OS X 10.2/10.3/10.4/10.5, the [Install] button may appear 
as the [Upgrade] button at the second and subsequent installation 
of the printer driver.

The printer driver is installed onto the Macintosh computer. When 
installation is complete, a message appears.

8 Click the [Close] button.

This completes the printer driver installation.
Next, select the printer.
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Selecting a printer

For Mac OS X 10.2/10.3/10.4

After connecting this machine to a Macintosh computer, it can be used as a 
printer by selecting it in Print Center or the Printer Setup Utility as the printer 
to be used.

1 Open Print Center or Printer Setup Utility, located in "Applications"-
"Utilities" of "Hard Disk".

2 When the Add Printer dialog box appears, click the [Add] button. When 
the printer list appears, click the [Add] button.

– For Mac OS X 10.4, proceed to step 3.
– For Mac OS X 10.2 and Mac OS X 10.3, proceed to step 4.
– If usable printers have already been set up, the Add Printer dialog 

box does not appear.
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3 If this machine appears as a printer for AppleTalk connection, select 
"KONICA MINOLTA" in "Print Using", select "KONICA MINOLTA 
362/282/222 PS" from the Model list, and then click the [Add] button.

– If the selected printer is registered in the printer list, this completes 
the setting procedure.

– When connecting with another connection method and this 
machine does not appear as a printer, click the [More Printers] 
button, and then proceed to step 4.

4 Select the applicable connection method and printer name.

– You can check the printer name from AppleTalk Configuration in 
PageScope Web Connection. For details, refer to "Printing with 
Macintosh" on page 4-34.

– When specifying "IPP" for the protocol in IP Printer, the text box for 
entering the queue name appears. For Mac OS X 10.3, leave the 
queue name text box empty. For Mac OS X 10.4, enter "ipp" in the 
queue name text box.

The following procedure is an example of when AppleTalk was 
selected by the connection method.

5 Select "KONICA MINOLTA" from the "Printer Model" drop-down list.
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6 Select "KONICA MINOLTA 362/282/222 PS", and then click the [Add] 
button.

The selected printer is registered in the printer list.

2
Note 

If connecting using AppleTalk, the AppleTalk settings on this machine 
must be specified. For specifying the AppleTalk settings, refer to 
"Printing with Macintosh" on page 4-34.
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For Mac OS X 10.5

After connecting this machine to a Macintosh computer, it can be used as a 
printer by selecting it in Print & Fax as the printer to be used.

1 On the Apple menu, select "System Preferences".

2 Click the "Print & Fax" icon.

3 On the "Print & Fax" screen, click the [+] button. 
"Printer Browser" will appear and the printers connected are detected.

– If no printers are detected, turn off this machine, then on again.
– When turning off the power, then on again, wait at least 10 seconds 

before turning it on again. Otherwise, this machine may not function 
properly.

4 If this machine appears as a printer for AppleTalk connection, select 
"Select a driver to use..." in "Print Using", select "KONICA MINOLTA 
362/282/222 PS" from the list, and then click the [Add] button.

– You can check the printer name from AppleTalk Configuration in 
PageScope Web Connection. For details, refer to "Printing with 
Macintosh" on page 4-34.

– If the selected printer is registered in "Print & Fax", this completes 
the setting procedure.

– To use another connection method, select that applicable 
connection method on "Printer Browser" and go to step 5.
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5 Select the appropriate protocol on "Protocol" and enter the IP address 
of this machine in "Address".

– When specifying "IPP" for the protocol, enter "ipp" in the queue 
name text box.

6 Select "Select a driver to use..." in "Print Using", select "KONICA 
MINOLTA 362/282/222 PS" from the list, and then click the [Add] 
button.

The selected printer is registered in "Print & Fax".

2
Note 

If connecting using AppleTalk, the AppleTalk settings on this machine 
must be specified. For specifying the AppleTalk settings, refer to 
"Printing with Macintosh" on page 4-34.
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For Mac OS 9.2

After connecting this machine, it can be used as a printer by selecting 
"PostScript printer" under "Chooser" and by specifying the printer 
description (PPD) File.

First, copy the printer description (PPD) file onto the Macintosh computer.

1 Insert the DVD-R into the computer’s DVD-R drive.

2 Open the "OS 9_x" folder from "Driver", which is located in a language 
folder on the DVD-R.

3 Select the PPD file "KONICAMINOLTA362UVxxx.ppd", and then copy 
it into the "Printer Descriptions" folder in "System Folder"-"Extensions" 
of "Hard Disk".

– Next, select a printer.
The printer driver can use a standard Macintosh LaserWriter.

4 On the Apple menu, click "Chooser".

5 Make sure that "AppleTalk" is set to "Active", and then click the 
[LaserWriter] icon.

6 From the "Select a PostScript Printer" list, click the applicable printer 
for the printing system, and then click the [Create] button.

– You can check the printer name from AppleTalk Configuration in 
PageScope Web Connection. 
For details, refer to "Printing with Macintosh" on page 4-34. 

– If a different PPD file has already been selected, click the [Setup] 
button in step 6, and then click the [Select PPD] button from the 
screen that is already displayed.

The PostScript printer description (PPD) file selection screen appears.

7 Select the applicable PPD file, and then click the [Select] button or 
[Open] button.
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The setting screen for adding Options appears.

8 Select the options that are installed on this machine from "Options 
Installed 1" and "Options Installed 2".

9 Click the [OK] button.

The Chooser window appears again.

10 Close the Chooser window.
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Uninstalling the printer driver

If it becomes necessary to delete the printer driver, for example, when you 
want to reinstall the printer driver, follow the procedure below to delete the 
driver.

2
Note 

Quit all running applications that may have started when the Macintosh 
computer was turned on.

For Mac OS X

1 Open the "Print & Fax", "Printer Setup Utility" or "Print Center" screen.

– For Mac OS X 10.3/10.4/10.5, open the "Print & Fax" screen from 
"System Preferences" of the "Apple" menu.

– Open the "Printer Setup Utility" or "Print Center" screen located in 
"Applications"-"Utilities" of "Hard Disk".

2 Select the name of the printer to be deleted and click the [-] button or 
the [Delete] button.

The selected printer is deleted.

3 Close the "Print & Fax", "Printer Setup Utility" or "Printer Center" 
screen.

4 Drag the following file, which is located in "Library"-"Printers"-"PPDs"-
"Contents"-"Resources"-"en.lproj" ("Library"-"Printers"-"PPDs"-
"Contents"-"Resources" for Mac OS X 10.5) of "Hard Disk", to the 
"Trash" icon.

– "KONICA MINOLTA 362.gz"

5 Delete the unnecessary files from "Library"-"Printers".

6 For Mac OS X 10.3/10.4, drag the "pstokm362" folder, which is located 
in "Library"-"Printers"-"KONICAMINOLTA"-"filter", and the following 
folders, which are located in "Library"-"Printers"-"KONICAMINOLTA"-
"PDEs", to the "Trash" icon.

– KONICAMINOLTA362 Finishing.plugin
– KONICAMINOLTA362 ImageLayout.plugin
– KONICAMINOLTA362 Security.plugin
– KONICAMINOLTA362 Setup.plugin
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7 For Mac OS X 10.2, drag the following folders, which are located in 
"Library"-"Printers"-"PPD Plugins", to the "Trash" icon.

– KONICAMINOLTA362 Finishing.plugin
– KONICAMINOLTA362 ImageLayout.plugin
– KONICAMINOLTA362 Security.plugin
– KONICAMINOLTA362 Setup.plugin

8 For Mac OS X 10.5, drag the "362" folder, which is located in "Library"-
"Printers"-"KONICAMINOLTA", to the "Trash" icon.

9 For Mac OS X 10.2, enter "/usr" in "Move to"-"Move to folder", move it 
to the "/usr" folder, and then drag the "pstokm362" folder, which is 
located in "libexec"-"cups"-"filter", to the "Trash" icon.

10 Restart the Macintosh computer.

This completes the uninstallation procedure.

For Mac OS 9.2

1 Drag PPD file "KONICAMINOLTA362UVxxx.ppd", which is located in 
"System Folder"-"Extensions"-"Printer Descriptions" of "Hard Disk", to 
the "Trash" icon.

The related printer driver files are deleted.

2 Restart the Macintosh computer.

This completes the uninstallation procedure.
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4 Setting up network printing

4.1 Overview of network functions

Network functions

By connecting this machine to a network through the Ethernet port, this 
printing system can be used as a network printer.

This printing system supports 10Base-T and 100Base-TX standards. In 
addition, the Ethernet interface supports the TCP/IP (LDP/LPR, IPP, 
Windows printing), NetBEUI (Windows printing), IPX/SPX (NetWare), and 
AppleTalk (EtherTalk) protocols.

2
Note 

Only the PCL printer driver can be used with Windows printing.

2
Note 

When setting up the network, the administrator password is required to 
enter Administrator mode.

Ask the administrator of this machine for the administrator password.

Hub

Network

Ethernet

Machine

Printing system
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Features of the network functions

This printing system is equipped with the following network functions to 
flexibly support various network environments.
- Automatic selection of 10Base-T or 100Base-TX (Fast Ethernet)
- Supports multiple network protocols including TCP/IP, NetBEUI, 

IPX/SPX, and AppleTalk (EtherTalk)
- Supports LPD/LPR over TCP/IP from Windows NT 4.0, Windows 2000, 

Windows XP, Windows Vista, Windows Server 2003 or Windows Server 
2008

- Supports Novell NetWare Pserver and Rprinter (Nprinter)
- Supports the Novell NetWare print server functions and supports both 

bindery mode and Novell Directory Service (NDS)
- Acquires IP address automatically through DHCP

With Windows printing

Windows printing is a printing method that does not require a dedicated print 
server on computers.

2
Note 

Only the PCL printer driver can be used with Windows printing.

With LPR (Windows NT 4.0/2000/XP/Vista/Server 2003/Server 2008)

You can print with LPD/LPR using Windows NT 4.0, Windows 2000, 
Windows XP, Windows Vista, Windows Server 2003, or Windows Server 
2008.

!
Detail 

LPR (Line Printer Request): This print request system can be used under 
Windows NT 4.0, Windows 2000, Windows XP, Windows Vista, Windows 
Server 2003, or Windows Server 2008. The queue name is input as 
"Print".
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Port 9100 (Windows 2000/XP/Vista/Server 2003/Server 2008):

You can print (Raw print) using Port 9100 under Windows 2000, Windows 
XP, Windows Vista, Windows Server 2003, or Windows Server 2008.

With NetWare

The Novell NetWare 4.x—6 print server functions are supported.

You can connect this printing system to a network using Novell NetWare 
4.x—6 as the network operating system and send print jobs from the client 
to the print server (network controller). The three modes supported are as 
follows:
- Nprinter
- Pserver
- NDS/NDPS

2
Note 

For details on the NetWare functions, refer to the NetWare operation 
manual.

With Macintosh

You can print from your Macintosh computer using LPR or AppleTalk.

You can connect this printing system to a print server in an AppleTalk 
environment and send print jobs from the Macintosh computer to this 
machine.

Network connection methods that can be selected in each Windows 

operating system

This chapter describes the settings that must be specified for network 
printing.

Setting procedures differ depending on the method of networking printing 
used (Windows, LPR, or IPP printing). Select the best method of network 
printing for your Windows environment.
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Network printing from a Windows operating system

For details, refer to "Windows printing" on page 4-10.

2
Note 

Before setting up network printing, install the printer driver. For details, 
refer to "Installing the printer driver" on page 3-3.

To perform network printing, change the printer port for the installed 
printer driver to one for a network connection, and then change the 
settings on this machine as necessary. For an IPP connection, it is 
necessary to install the printer driver first.

Only the PCL printer driver can be used with Windows printing. If network 
printing with the PostScript printer driver, use LPR printing or Port 9100 
printing.

Network printing in a NetWare environment

Protocol 

used

Windows 

2000

Windows 

XP/Vista

Windows 

NT 4.0

Windows 

Server 

2003/Server 

2008

Windows 
printing

TCP/IP, 
NetBEUI

+ + + +

LPR printing TCP/IP o o o o

IPP printing TCP/IP o o o

Port 9100 
printing

TCP/IP o o o

NetWare version Protocol used Emulation Service mode

NetWare 4.x IPX NDS/Bindery Pserver/Nprinter

NetWare 5.x/6 IPX NDS Pserver

TCP/IP NDPS(lpr)
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4.2 Setting the IP address for this machine

Use this machine’s control panel to assign an IP address to this machine.

2
Note 

When specifying network settings, follow the instructions of the network 
administrator.

Setting the IP address

1 Press the [Utility/Counter] key on this machine’s control panel, touch 
[Admin. Management], and then enter the administrator password.

– The administrator password is required to enter Administrator 
mode. Ask the administrator of this machine for the administrator 
password.

2 Touch [Admin. 2].

3 Touch [Network Settings].

– If the [Network Setting 1]/[Network Setting 2] selection screen 
appears, touch [Network Setting 1].

4 Touch [Basic Settings].

5 Touch [IP Address Settings].

6 Enter the IP address, and then touch 
[Enter].
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7 Touch [Subnet Mask] and enter the subnet mask address.

8 Touch [Gateway] and enter the default gateway address.

9 To apply the settings, restart this machine (turn the main power off, 
then on again).
Turn this machine back on to apply the IP address.

2
Reminder 

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.

!
Detail 

Although the IP address is entered without using the DHCP server in the 
procedure described here, it is also possible to automatically assign the 
IP address from the DHCP server. When "DHCP Configuration" is set to 
"Auto-Obtain", the IP address, subnet mask, and gateway address 
settings are automatically assigned from the DHCP server on the 
network, so it is not necessary to assign them manually. However, note 
the following when setting "DHCP Configuration" to "Auto-Obtain".

Check with the network administrator that the DHCP server exists. If the 
DHCP server does not exist, be sure to specify settings for "IP Address", 
"Subnet Mask", and "Gateway Address".

If the settings for the IP address and other items have been assigned 
using the DHCP server, there is a possibility that they may be 
automatically changed. When the settings for the IP address and other 
items are changed, if the IP address has been used to specify a printer 
on the network for printing, there is a possibility that printing may not be 
possible because this machine cannot communicate with the network. If 
"DHCP Configuration" has been set to "Auto-Obtain", it is recommended 
that the IP address assigned to this machine be fixed in the DHCP server 
settings.
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4.3 Accessing PageScope Web Connection

Setting the IP address for this machine enables you to access PageScope 
Web Connection.

Use your Web browser to directly access PageScope Web Connection.

To access PageScope Web Connection

1 Start up the Web browser.

2 In the "Address" bar, enter the IP address for this machine as shown 
below, and then press the [Enter] key.

– http://<IP_address_for_this_machine>/
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/

The initial page of PageScope Web Connection appears.

!
Detail 

For further details on PageScope Web Connection, refer to "Using 
PageScope Web Connection" on page 11-29.



4 Setting up network printing

4-10 bizhub 362/282/222

4.4 Windows printing

You can use Windows printing (SMB printing) to print directly over the 
Microsoft network from computers running Windows.

2
Note 

Only the PCL printer driver can be used with Windows printing.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to 
"Setting the IP address for this machine" on page 4-7.

In PageScope Web Connection, specify the settings described below for 
Windows printing.

1 Start up PageScope Web Connection.

2 Enter the administrator password, and then click [Log-in].
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3 On the Network tab, click "Common Setting", then "Windows".

4 Specify settings for the following:

– Enable Windows Printing Service: Set whether to use the Windows 
printing service. Select "Enable" here.

– NetBIOS Name: Specify the NetBIOS name. Up to 15 of the 
following alphanumeric characters and symbols can be used.
Uppercase and lowercase letters, numbers, hyphens (-), and 
underscores (_).

– Printing Service Name: Specify the printing service name. Up to 12 
alphanumeric characters can be used, excluding the following 
characters.
Spaces, backslashes (\), and commas (,).

– WorkGroup Name: Specify the work group name. Up to 15 
alphanumeric characters can be used, excluding the following 
characters.
\ * + = | : ; "? < > ,.
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5 To apply the settings, restart this machine (turn the main power off, 
then on again).

2
Reminder 

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.

Printer driver settings

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", 
and then click "Printers". 
For Windows XP/Server 2003, click the [Start] button, and then click 
"Printers and Faxes".
For Windows Vista/Server 2008, click the [Start] button, and then click 
"Control panel", "Hardware and Sound", and "Printers".

– If "Printers and Faxes" does not appear in the Start menu in 
Windows XP/Server 2003, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select 
"Printers and Faxes".
For Windows Vista/Server 2008, if the control panel is in the classic 
view, double-click "Printers".

2 Right-click the icon of the installed printer, and then click "Properties".

3 Click the [Add Port] button on the Ports tab, double-click "Local Port" 
or select "Local Port" and click the [New Port] button, and then enter 
"\\<NetBIOS_name>\<printing_service_name>".

– Enter the same NetBIOS name and printing service name that you 
entered in PageScope Web Connection. For the setting procedure, 
refer to "Operations on this machine" on page 4-10.

4 Click the [Close] button to apply the setting.



Setting up network printing 4

bizhub 362/282/222 4-13

4.5 LPR printing

The LPR print service is supported as standard in Windows 2000, Windows 
XP, Windows Vista, Windows NT 4.0, Windows Server 2003, and Windows 
Server 2008. TCP/IP is used as the network protocol.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to 
"Setting the IP address for this machine" on page 4-7.

Printer driver settings

For Windows 2000/XP/Vista/Server 2003/Server 2008

1 For Windows 2000, click the [Start] button, point to "Settings", and 
then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click 
"Printers and Faxes".
For Windows Vista/Server 2008, click the [Start] button, and then click 
"Control panel", "Hardware and Sound", and "Printers".

– If "Printers and Faxes" does not appear in the Start menu in 
Windows XP/Server 2003, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select 
"Printers and Faxes".
For Windows Vista/Server 2008, if the control panel is in the classic 
view, double-click "Printers".

2 Right-click the icon of the installed printer, and then click "Properties".

3 On the Ports tab, click the [Add Port] button.

4 In the "Available port types" list, select "Standard TCP/IP Port", and 
then click the [New Port] button.

5 When the Add Standard TCP/IP Printer Port Wizard starts up, click the 
[Next] button.

6 In the "Printer Name or IP Address" box, enter the IP address for this 
machine, and then click the [Next] button.

7 Select "Custom", and then click the [Settings] button.

8 Select "LPR", enter "Print" in the "Queue Name" box.

– The uppercase letters and lowercase letters must be entered 
correctly.
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9 For Windows XP, select "LPR Byte Counting Enabled", and then click 
the [OK] button.

– If "LPR Byte Counting Enabled" is not selected, the data may not 
be printed.

10 Click the [Next] button, and then click the [Finish] button to apply the 
setting.

For Windows NT 4.0

1 Click the [Start] button, point to "Settings", and then click "Printers".

2 Right-click the icon of the installed printer, and then click "Properties".

3 On the Ports tab, click the [Add Port] button.

4 In the "Available Printer Ports" list, select "LPR Port", and then click the 
[New Port] button.

– If "LPR Port" is not in the list, click the [Start] button, point to 
"Control Panel", and then click "Network". Then, on the Service 
tab, click the [Add] button and install the Microsoft TCP/IP Printing 
service.

5 In the "Name or address of server providing lpd" box on the Add LPR 
Compatible Printer dialog box, enter the IP address for this machine.

6 In the "Name of printer or print queue on that server" box, enter "Print".

– The uppercase letters and lowercase letters must be entered 
correctly.

7 Click the [OK] button to apply the setting.
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4.6 Port 9100 Printing (Windows 2000/XP/Vista/Server 
2003/Server 2008)

The Port 9100 print service is supported as standard in Windows 2000, 
Windows XP, Windows Vista, Windows Server 2003, and Windows Server 
2008. TCP/IP is used as the network protocol.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to 
"Setting the IP address for this machine" on page 4-7.

Printer driver settings

When using Port 9100 to print, change the printer driver port to the Port 9100 
port.

1 For Windows 2000, click the [Start] button, point to "Settings", and 
then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click 
"Printers and Faxes".
For Windows Vista/Server 2008, click the [Start] button, and then click 
"Control panel", "Hardware and Sound", and "Printers".

– If "Printers and Faxes" does not appear in the Start menu in 
Windows XP/Server 2003, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select 
"Printers and Faxes".
For Windows Vista/Server 2008, if the control panel is in the classic 
view, double-click "Printers".

2 Right-click the icon of the installed printer, and then click "Properties".

3 On the Ports tab, click the [Add Port] button.

4 In the "Available port types" list, select "Standard TCP/IP Port", and 
then click the [New Port] button.

5 When the Add Standard TCP/IP Printer Port Wizard starts up, click the 
[Next] button.

6 In the "Printer Name or IP Address" box, enter the IP address for this 
machine, and then click the [Next] button.

7 Select "Custom", and then click the [Settings] button.
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8 Click [Raw], and then enter the RAW port number (default setting: 
9100) in the Port Number box.

– If the RAW port number of this machine is changed, input the 
specified port number. When the RAW port is disabled in "TCP/IP 
Configuration", printing cannot be performed. For details, refer to 
"Network tab - Common Setting - TCP/IP" on page 11-68.

9 Click the [Next] button, and then click the [Finish] button to apply the 
setting.
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4.7 IPP printing (Windows 2000/XP/Vista/Server 
2003/Server 2008)

The IPP (Internet Printing Protocol) print service is supported as standard in 
Windows 2000, Windows XP, Windows Vista, Windows Server 2003, and 
Windows Server 2008. TCP/IP is used as the network protocol.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to 
"Setting the IP address for this machine" on page 4-7.

Also, specify the IPP printing settings in PageScope Web Connection. 
(Printing can be performed with the default settings.)

1 Start up PageScope Web Connection.

2 Enter the administrator password, and then click [Log-in].
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3 On the Network tab, click "Common Setting", then "IPP".

4 Specify settings for the following:

– Printer URI: The URI of the printer that can be used for IPP printing 
is displayed.

– Enable IPP: Set whether to perform IPP printing. Select "Enable" 
here.

– Accept IPP Jobs: Set whether to use the IPP reception function.
– Operations-Supported: Specify print operations supported by IPP.
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5 On the Print tab, click "IPP Configuration".

6 Specify settings for the following:

– Printer Name: Specify the printer name (up to 127 alphanumeric 
characters and symbols).

– Printer Location: Specify the printer location (up to 127 
alphanumeric characters and symbols).

– Printer Information: Specify the printer manufacturer details (up to 
127 alphanumeric characters and symbols).
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Installing the printer driver (Windows 2000/XP/Server 2003)

For IPP printing, reinstall the printer driver.

1 Insert the DVD-R into the computer’s DVD-R drive.

2 For Windows 2000, click the [Start] button, point to "Settings", and 
then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click 
"Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu in 
Windows XP/Server 2003, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select 
"Printers and Faxes".

3 For Windows 2000/Server 2003, double-click the "Add Printer" icon.
For Windows XP, click "Add a printer" on the "Printer Tasks" menu. 

The "Add Printer Wizard" starts up.

4 Click the [Next] button.

5 In the Local or Network Printer dialog box, select "Network printer", 
and then click the [Next] button.

6 In the Locate Your Printer dialog box, select "Connect to a printer on 
the Internet or on your intranet".

7 In the "URL" field, enter the URL for this machine in the following 
format, and then click the [Next] button.

– http://<IP_address_for_this_machine>/ipp
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/ipp

8 When the confirmation dialog box appears, click the [OK] button.

9 Click the [Have Disk] button.
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10 Click the [Browse] button, specify the folder on the DVD-R that 
contains the printer driver, and then click the [OK] button.

11 Check that the printer name is displayed in the "Printers" list, and then 
click the [Next] button.

12 Select whether to set the printer as the default printer, and then click 
the [Next] button.

13 Click the [Finish] button to exit the Add Printer Wizard.

Once the settings for the printer have been specified, you can use the 
printer in the same way as a default local printer.

Installing the printer driver (Windows Vista/Server 2008)

1 Insert the printer DVD-R into the computer's DVD-R drive.

2 Click the [Start] button, and then click "Control Panel".

3 Click "Printers" under "Hardware and Sound".

– If Control Panel is displayed with Classic View, double-click 
"Printers".

The Printers window appears.

4 Click "Add a printer" from the toolbar.

The Add Printer window appears.

5 Click "Add a network, wireless or Bluetooth printer".

The connected printers are found.

6 In the window showing the search results, click "The printer that I want 
isn't Listed".
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7 In the "Select a shared printer by name" text box, enter the URL for this 
machine in the following format, and then click the [Next] button.

– http://<IP_address_for_this_machine>/ipp
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/ipp

8 Click the [Have Disk] button.

9 Click the [Browse] button.

10 Specify the desired folder on the DVD-R that contains the printer driver, 
and then click the [Open] button.
Select the specified folder according to the printer driver to be used 
and the language.

11 Click the [OK] button.
The "Printers" list appears.

12 Click the [Next] button.

13 Follow the on-screen instructions.

– If the User Account Control window appears, click the [Continue] 
button.

– If the Verify the publisher dialog box of Windows Security appears, 
click "Install this driver software anyway".

14 Click the [Finish] button.

15 After installation is completed, make sure that the icon of the installed 
printer appears in the Printers window.

16 Remove the DVD-R from the DVD-R drive.
This completes the printer driver installation.

Once the settings for the printer have been specified, you can use the 
printer in the same way as a default local printer.
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4.8 Printing with NetWare

The printer controller supports the following environments.

Network printing in a NetWare environment

2
Note 

Before using bindery emulation, check that bindery emulation is 
compatible with the NetWare server.

For Remote Printer mode with NetWare 4.x bindery emulation

1 From a client computer, log on with Supervisor permissions to access 
the NetWare server where the Pserver is registered.

2 Start up Pconsole.

3 From the "Available Options" list, select "Quick Setup", and then click 
the [Enter] button.

4 Enter the appropriate names in the "Printer Server Name", "Printer 
Name", "Print Queue Name", and "Print Queue Volume" fields, select 
"Other/Unknown" from the "Printer type" field, and then save the 
specified settings.

5 Click the [Esc] button to quit Pconsole.

6 Use the NetWare server console to load PSERVER.NLM.

– For queue user privileges, printer notification option, assignment of 
multiple queues, and passwords, refer to the NetWare 
documentation, and specify settings as necessary.

NetWare version Protocol used Emulation Service mode

NetWare 4.x IPX NDS/Bindery Pserver/Nprinter

NetWare 5.x/6 IPX NDS Pserver

TCP/IP NDPS(lpr)
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7 In Administrator mode of PageScope Web Connection, select 
"Common Setting", then "NetWare" from the Network tab, and then 
specify the following settings.

– Enable NetWare: Select "Enable".
– Frame Type: Select "Auto Detect". (Select the frame type according 

to the network environment.)
– Bindery/NDS: Select "Bindery".
– Print Server Name: Specify the print server name created in step 4.
– Print Server Password: Specify only when setting from the NetWare 

server. (Displayed by "••••".) If changing the password, delete 
"••••", and then input the password.

– Preferred File Server: Specify the name of the file server that 
connects to the Pserver.

– Print Queue Scan Rate: Specify "1". (Change as necessary.)
– Mode: Select "Nprinter/Rprinter".
– Printer Number: Specify "255". (Set the number assigned to the 

printer (0 to 254) or 255.)
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8 Restart this machine (turn the main power off, then on again).

9 Use the NetWare server console to display the print server screen, and 
then check that the created printer is shown as "Waiting for Job" for 
the connected printer (0).

2
Reminder 

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.

For Print Server mode with NetWare 4.x bindery emulation

Before using bindery emulation, check that bindery emulation is compatible 
with the NetWare server.

1 From a client computer, log on with Supervisor permissions to access 
the NetWare server where the Pserver is registered.

2 Start up Pconsole.

3 From the "Available Options" list, select "Quick Setup", and then click 
the [Enter] button.

4 Enter the appropriate names in the "Printer Server Name", "Printer 
Name", "Print Queue Name", and "Print Queue Volume" fields, select 
"Other/Unknown" from the "Printer type" field, and then save the 
specified settings.

5 Click the [Esc] button to quit Pconsole.
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6 In Administrator mode of PageScope Web Connection, select 
"Common Setting", then "NetWare" from the Network tab, and then 
specify the following settings.

– Enable NetWare: Select "Enable".
– Frame Type: Select "Auto Detect". (Select the frame type according 

to the network environment.)
– Bindery/NDS: Select "Bindery".
– Print Server Name: Specify the print server name created in step 4.
– Print Server Password: Specify only when setting from the NetWare 

server. (Displayed by "••••".) If changing the password, delete 
"••••", and then input the password.

– Preferred File Server: Specify the name of the file server that 
connects to the Pserver.

– Print Queue Scan Rate: Specify "1". (Change as necessary.)
– Mode: Select "PServer".
– Printer Number: Specify "255". (Set the number assigned to the 

printer (0 to 254) or 255.)
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7 Restart this machine (turn the main power off, then on again).

8 Use the NetWare server console to load MONITOR.NLM.

9 Select the connection information and, in the active connection 
column, check that the created Pserver is connected.

2
Reminder 

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.

For NetWare 4.x Remote Printer mode (NDS)

1 Log on to NetWare as an administrator from a client computer.

2 Start up NWadmin.

3 Select either the organization or organizational unit container that 
offers the print service, and then click "Print Services Quick Setup" on 
the "Tools" menu.

4 Enter the appropriate names in the "Printer Server Name", "Printer 
Name", "Print Queue Name", and "Print Queue Volume" fields, select 
"Other/Unknown" from the "Printer type" field, and then save the 
specified settings.

– For queue user privileges, printer notification option, assignment of 
multiple queues, and passwords, refer to the NetWare 
documentation, and specify settings as necessary.
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5 In Administrator mode of PageScope Web Connection, select 
"Common Setting", then "NetWare" from the Network tab, and then 
specify the following settings.

– Enable NetWare: Select "Enable".
– Frame Type: Select "Auto Detect". (Select the frame type according 

to the network environment.)
– Bindery/NDS: Select "NDS".
– Print Server Name: Specify the print server name created in step 4.
– Print Server Password: Specify only when setting from the NetWare 

server. (Displayed by "••••".) If changing the password, delete 
"••••", and then input the password.

– Preferred NDS Context: Specify the name of the context that 
connects to Pserver.

– Preferred NDS Tree: Specify the name of the tree that Pserver logs 
on to.

– Print Queue Scan Rate: Specify "1". (Change as necessary.)
– Mode: Select "Nprinter/Rprinter".
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– Printer Number: Specify "255". (Set the number assigned to the 
printer (0 to 254) or 255.)

6 Restart this machine (turn the main power off, then on again).

7 Use the NetWare server console to load PSERVER.NLM.

8 Use the NetWare server console to display the print server screen, and 
then check that "XXX" (created printer) is shown as "Waiting for Job" 
for the connected printer (0).

2
Reminder 

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.

For NetWare 4.x/5.x/6 Print Server mode (NDS)

To use the Print Server mode, IPX protocol must be loaded on the NetWare 
server.

1 Log on to NetWare as an administrator from a client computer.

2 Start up NWadmin.

3 Select either the organization or organizational unit container that 
offers the print service, and then click "Print Services Quick Setup 
(non-NDPS)" on the "Tools" menu.

4 Enter the appropriate names in the "Printer Server Name", "Printer 
Name", "Print Queue Name", and "Print Queue Volume" fields, select 
"Other/Unknown" from the "Printer Type" field, and then click the 
[Create] button.

– For queue user privileges, printer notification option, assignment of 
multiple queues, and passwords, refer to the NetWare 
documentation, and specify settings as necessary.



4 Setting up network printing

4-30 bizhub 362/282/222

5 In Administrator mode of PageScope Web Connection, select 
"Common Setting", then "NetWare" from the Network tab, and then 
specify the following settings.

– Enable NetWare: Select "Enable".
– Frame Type: Select "Auto Detect". (Select the frame type according 

to the network environment.)
– Bindery/NDS: Select "NDS".
– Print Server Name: Specify the print server name created in step 4.
– Print Server Password: Specify only when setting from the NetWare 

server. (Displayed by "••••".) If changing the password, delete 
"••••", and then input the password.

– Preferred NDS Context: Specify the name of the context that 
connects to Pserver.

– Preferred NDS Tree: Specify the name of the tree that Pserver logs 
on to.

– Print Queue Scan Rate: Specify "1". (Change as necessary.)
– Mode: Select "PServer".
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– Printer Number: Specify "255". (Set the number assigned to the 
printer (0 to 254) or 255.)

6 Restart this machine (turn the main power off, then on again).

7 Use the NetWare server console to load MONITOR.NLM.

8 Select the connection information and, in the active connection 
column, check that the created Pserver is connected.

2
Reminder 

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.

For NetWare 5.x/6 Novell Distributed Print Service (NDPS)

Before specifying settings for NDPS, check that the NDPS broker and NDPS 
manager have been created and loaded.

Also, before performing the following procedure, check that the TCP/IP 
protocol has been set in the NetWare server, and check that the IP address 
has been set for this machine and that this machine is on.

1 Log on to NetWare as an administrator from a client computer.

2 Start up NWadmin.

3 Right-click the organization or organizational unit container where you 
will create the printer agent, and then click "NDPS Printer" on the 
"Create" sub-menu.

4 In the "NDPS Printer Name" box, enter the printer name.

5 In the "Printer Agent Source" column, select "Create a New Printer 
Agent", and then click the [Create] button.

6 Check the printer agent name, and then in the "NDPS Manager Name" 
box, browse through the NDPS manager names, and register one.

7 In "Gateway Types", select "Novell Printer Gateway", and then register 
it.
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8 In the Configure Novell DPS for Printer Agent window, select "(None)" 
for the printer type and "Novell Port Handler" for the port handler type, 
and then register the settings.

9 In "Connection type", select "Remote (LPR on IP)", and then register it.

10 Enter the IP address set for this machine as the host address, enter 
"Print" as the printer name, and then click the [Finish] button to register 
the settings.

11 The printer driver registration screen appears. Select "None" for each 
operating system to complete the registration.

2
Note 

For settings for the queue user rights, printer notification option, 
assignment of multiple queues, and passwords, refer to the NetWare 
documentation, and set them as necessary.
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Setting up a client (Windows) settings when using the NetWare server

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", 
and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click 
"Printers and Faxes".
For Windows Vista/Server 2008, click the [Start] button, and then click 
"Control panel", "Hardware and Sound", and "Printers".

– If "Printers and Faxes" does not appear in the Start menu in 
Windows XP/Server 2003, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select 
"Printers and Faxes".
For Windows Vista/Server 2008, if the control panel is in the classic 
view, double-click "Printers".

2 For Windows 2000/NT 4.0/Server 2003, double-click the "Add Printer" 
icon.
For Windows XP, click "Add a printer" on the "Printer Tasks" menu.
For Windows Vista/Server 2008, click "Add a printer" on the toolbar.
The "Add Printer Wizard" starts up.

3 In the port settings, browse the network, and specify the name of the 
created queue (or NDPS printer name).

4 In the "Printer Model" list, specify the folder on the DVD-R that contains 
the operating system and printer driver to be used.

5 Follow the on-screen instructions to complete the installation.
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4.9 Printing with Macintosh

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to 
"Setting the IP address for this machine" on page 4-7.

In the PageScope Web Connection, specify the settings described below for 
AppleTalk.

1 Start up PageScope Web Connection.

2 Enter the administrator password, and then click [Log-in].

3 On the Network tab, click "Common Setting", then "AppleTalk".
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4 Specify settings for the following:

– AppleTalk: Set whether to use AppleTalk. Select "Enable" here.
– Printer Name: Specify the printer name (up to 31 alphanumeric 

characters and symbols, excluding = ~).
– Zone Name: Specify the zone being connected to (up to 31 

alphanumeric characters and symbols, excluding = ~).

5 To apply the settings, restart this machine (turn the main power off, 
then on again).

2
Reminder 

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.

Setting the Macintosh computer

Use the Macintosh computer that is connected to specify the TCP/IP and 
AppleTalk settings.

2
Note 

For network settings, consult the network administrator.

For printer driver installation, refer to "Installing the printer driver" on 
page 3-3.

For Mac OS X

1 On the Apple menu, select "System Preferences".

2 Click the "Network" icon.

3 From "Show", select "Built-in Ethernet".
For Mac OS X 10.5, select "Ethernet", and then click the [Advanced] 
button.

4 Click the TCP/IP tab.

5 Select the items from "Configure" that correspond to the network 
settings for the Macintosh computer that is connected to the network, 
and then set the IP address and subnet mask.
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6 If using an AppleTalk connection, click the AppleTalk tab, and then 
check that the "Make AppleTalk Active" check box is selected.

7 Click the close button at the top left of the dialog box.

– For Mac OS X 10.2/10.3/10.4, the "Apply configuration changes?" 
message appears.

– For Mac OS X 10.5, the "This service has unsaved changes" 
message appears.

8 Click the [Apply] button.

The AppleTalk and Ethernet settings are saved.

For Mac OS 9.2

1 On the Apple menu, point to "Control Panels", and then click 
"AppleTalk".

2 From the "Connect via" drop-down list, select "Ethernet".

3 On the Apple menu, point to "Control Panels", and then click "TCP/IP".

4 From the "Connect via" drop-down list, select "Ethernet".

5 Select the items from "Configure" that correspond to the network 
settings for the Macintosh computer that is connected to the network, 
and then set the IP address and subnet mask.

6 Click the close button at the top left of the dialog box.

The "Save changes to the current configuration?" message appears.

7 Click the [Save] button.



5 Various printing methods





Various printing methods 5

bizhub 362/282/222 5-3

5 Various printing methods

5.1 Printing operations

For Windows

Printing is possible when the printer driver is installed and the network 
settings have been specified. Print jobs are specified from the application 
software.

1 Open the data in the application, click [File], then click "Print".

2 Check that the printer name has been selected in Printer Name or 
Select Printer.

– If the printer is not selected, click to select the printer.

The Print dialog box differs depending on the application.

3 Specify the page range and the number of copies to print.
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4 Click the [Preferences] button or the [Properties] button to change the 
printer driver settings as necessary.

– By clicking the [Preferences] button or the [Properties] button on 
the Print dialog box, you can specify the settings of each model on 
the printer driver dialog box that appears. For details, refer to 
"Setting up the PCL driver" on page 6-3, "Setting up the PostScript 
driver (Windows)" on page 7-3, "Setting up the VXL/VPS driver 
(Windows Vista/Server 2008)" on page 8-3.

5 Click the [Print] button.

The Data indicator of this machine flashes.

2
Note 

Changes made to the printer driver settings on the Print dialog box are 
not saved. When the application is exited, the settings return to their 
default settings.

Do not the select the "Collate" check box on the Print dialog box.

Test printing

Printing is possible when the printer driver is installed and the network 
settings have been specified. To check that connection has been made 
properly, you can print the standard Windows test page.

Print a test page from the printer driver Properties dialog box.

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", 
and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click 
"Printers and Faxes".
For Windows Vista/Server 2008, click the [Start] button, and then click 
"Control panel", "Hardware and Sound", and "Printers".

– If "Printers and Faxes" does not appear in the Start menu in 
Windows XP/Server 2003, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select 
"Printers and Faxes".
For Windows Vista/Server 2008, if the control panel is in the classic 
view, double-click "Printers".

2 Right-click the icon of the installed printer, and then click "Properties".

3 Click the General tab, and then click the [Print Test Page] button or the 
[Print Test] button.

The test page is printed and the confirmation dialog box appears.
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4 Check the printout, and then click the [OK] button or the [Yes] button.

2
Note 

If the test page is not printed properly, check that the printer driver has 
been installed properly and that the network settings are complete.

For Macintosh

Printing is possible when the printer driver is installed and the network 
settings have been specified. Print jobs are specified from the application 
software.

For Mac OS X

1 Open the data in the application, choose [File], and then click "Print".

– For Mac OS X 10.3.x, printing speed may be slower for some 
applications if you print by clicking "Print". Always select "Print" 
from the "File" menu to print data.

2 Check that the printer name has been selected.

3 Specify the print range and the number of copies to print, and then 
click the [Print] button.

– The settings specified on this machine have precedence if multiple 
copies are specified in "Default Set" of this machine.

The Data indicator of this machine flashes.
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2
Note 

If the printer name does not appear in the list, select the printer in Print 
Center or the Print Setup Utility. For details, refer to "Selecting a printer" 
on page 3-23.

The Print dialog box differs depending on the application.

Do not the select the "Collated"check box on the Print dialog box.

For Mac OS X 10.2.x, printing speed may be slower if the data contains 
colors.
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For Mac OS 9.2

1 Open the data in the application, choose [File], and then click "Print".

2 Check that the printer name has been selected.

3 Select "General".

4 Specify the print range and the number of copies to print, and then 
click the [Print] button.

– The settings specified on this machine have precedence if multiple 
copies are specified in "Default Set" of this machine.

The Data indicator of this machine flashes.

2
Note 

If the printer name does not appear in the list, select the printer in the 
Chooser window. For details, refer to "Selecting a printer" on page 3-23.

The Print dialog box differs depending on the application.

The settings can be saved by clicking the [Save Settings] button.
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5.2 Setting the printing functions

The functions of this machine such as sorting and folding can be set when 
printing from a computer. Depending on the operating system running on the 
connected computer, the setting procedure of this machine’s functions may 
differ.

Function list

The function list contains a summary of the main settings related to printing 
and printer driver support.

2
Note 

The function names in this list are based on those displayed by the PCL 
printer driver in Windows XP. In addition, the items and setting values 
displayed may differ depending on whether the options are installed or 
the settings are available.

Function Overview

Printer driver

PCL Post-

Script

PPD

Orientation Selects the print orientation. o o o

Original Size Specifies the size of the original docu-
ment.

o o

Output Size Specifies the output paper size. o o o

Zoom Prints enlarged or reduced. o o o

Paper Source Selects the paper source for printing. o o o

Paper Type Set-
tings

Specifies the paper type of the paper 
source.

o o o

Binding Position Selects the binding position. o o o

Print Type Selects the print type (simplex, duplex, or 
booklet).

o o o

Combination Prints multiple pages on one page. o o o

File Margin Sets margins for punch holes and sta-
ples.

o

Staple Staples documents. o o o

Center Staple and 
Fold

Folds the printouts in half and staples. o o o

Hole-Punch Punches holes in documents. o o o

Output Method
(Job Manage-
ment)

For non-conventional printing, selects the 
special output format for secured docu-
ments or saves data in a box.

o o (Mac 
OS X 
only)
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Function overview

An overview of each function is summarized in this section.

Copies Specifies the number of copies to print. o o o

Output Tray Selects the tray where to output the print-
ed pages.

o o o

Collate Specifies whether to print multiple copies 
in sets.

o o o

Offset When printing multiple copies, shifts the 
output position of each set.

o o o

Skip Blank Pages Does not print blank pages in the data. o

Front Cover Page 
(Front Cover)

Attaches a front cover page. o o o

Back Cover Page 
(Back Cover)

Attaches a back cover page. o o o

Transparency In-
terleave

Inserts interleaves between overhead 
projector transparencies.

o o o

Per Page Setting Switches the paper and trays per page. o

Overlay Prints the original document on top of 
form data that was created separately.

o
(Win-
dows 
Vista 
only)

Watermark Prints a watermark (text stamp) on the 
page being printed.

o o

Distribution 
Number Stamping

Prints the number of the copy. o

Use Printer Fonts Specifies the replacement of TrueType 
fonts with printer fonts.

o o o

User Authentica-
tion

Printing is performed after the registered 
user name and password are entered.

o o (Mac 
OS X 
only)

Account Track Tracks operations performed by each ac-
count.

o o (Mac 
OS X 
only)

Function Overview

Printer driver

PCL Post-

Script

PPD
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Orientation

You can specify "Portrait" or "Landscape" as the orientation of the page 
being printed.

Landscape
Portrait

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Setup tab settings" on 
page 7-9.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Basic tab settings" on 
page 8-9

Mac OS X PostScript PPD "Page Attributes (basic settings)" on 
page 10-7.

Mac OS 9.2 "Page Attributes (basic settings)" on 
page 9-7.
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Original Size and Output Size

You can specify the original document size and the output paper size. By 
specifying each size, you can specify the enlargement and reduction ratio.

2
Note 

Only the output paper sizes can be specified with the PostScript PPD 
driver for the Macintosh.

Output sizeOriginal size

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Setup tab settings" on 
page 7-9.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Basic tab settings" on 
page 8-9

Mac OS X PostScript PPD "Page Attributes (basic settings)" on 
page 10-7.

Mac OS 9.2 "Page Attributes (basic settings)" on 
page 9-7.
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Zoom (enlargement and reduction)

You can specify the enlargement or reduction ratio using numeric values.

Original
Enlarged

Reduced

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Setup tab settings" on 
page 7-9.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Basic tab settings" on 
page 8-9

Mac OS X PostScript PPD "Page Attributes (basic settings)" on 
page 10-7.

Mac OS 9.2 "Page Attributes (basic settings)" on 
page 9-7.
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Input tray (paper source)

You can select the input tray as the paper source for printing. When changing 
the paper type, you can select an input tray according to the paper type.

Tray

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Setup tab settings" on 
page 7-9.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Basic tab settings" on 
page 8-9

Mac OS X PostScript PPD "Paper Feed" on page 10-11.

Mac OS 9.2 "General (basic settings)" on page 9-10.
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Paper Type

You can specify the paper type being printed.

2
Note 

With the Konica Minolta PCL driver for Windows, the paper type of the 
paper tray can be specified.

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Setup tab settings" on 
page 7-9.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Basic tab settings" on 
page 8-9
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Print type (duplex printing/booklet printing)

You can print onto both sides of a page or in a booklet format (two facing 
pages or center binding). This comes in handy when you want to bind 
multiple-page documents.

The binding area can be specified by specifying the binding position.

Duplex printing

Booklet printing

Top binding

PrintoutPrint dataPrintoutPrint data

Left binding

PrintoutPrint data

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Layout tab settings" on 
page 7-18.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Layout tab settings" on 
page 8-18
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Printing multiple pages on one page

You can print multiple document pages on one page. This comes in handy 
when you want to reduce the number of output pages.

Mac OS X PostScript PPD "Finishing" on page 10-13.

Mac OS 9.2 "Printer specific options (finishing options 1 
to 3)" on page 9-12.

Operating system Printer driver Refer to

4 up

16 up9 up

2 up

6 up

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Layout tab settings" on 
page 7-18.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Layout tab settings" on 
page 8-18

Mac OS X PostScript PPD "Layout (printing multiple pages on one 
page)" on page 10-10.

Mac OS 9.2 "Layout (printing multiple pages on one 
page)" on page 9-11.
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Stapling and hole punching

Documents can be stapled together or holes punched into the document.

By specifying the file margin, you can specify the margin for stapling or hole 
punching.

2
Note 

The staple function is available only when optional finisher is installed.

The hole punch function is available only when punch unit is installed on 
optional finisher.

Hole punchingStapling

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Layout tab settings" on 
page 7-18.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Finish tab settings" on 
page 8-21

Mac OS X PostScript PPD "Finishing" on page 10-13.

Mac OS 9.2 "Printer specific options (finishing options 1 
to 3)" on page 9-12.



5 Various printing methods

5-18 bizhub 362/282/222

Output Method (job management)

You can select "Secure Print", which requires a password to print, or "Save 
in User Box", which saves documents in a document folder.

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Setup tab settings" on 
page 7-9.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Basic tab settings" on 
page 8-9

Mac OS X PostScript PPD "Security" on page 10-15.
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Sorting (Collate) and classifying (Offset)

You can print the document sets the specified number of times or each page 
the specified number of times.

By specifying offset, each copy can be output in sets.

!
Detail 

The offset function consists of two types. When optional finisher is 
installed, the output position of each set is shifted and sorted. When the 
finisher is not installed, crisscross sorting is performed when the 
following conditions are met.

Crisscross sorting conditions:
- When letter, executive, or 16K paper is used. 
- When paper of the same size and type is loaded in both the [ w ] and 
[ v ] directions. 
-When all pages in the document are the same size. 
-When stapling or hole punching setting have not been specified. 
-When printing multiple pages (when not printing only one page). 

Collate

Offset (shift)

Offset (crisscross)
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Skip Blank Pages (saving paper)

Does not print blank pages in the data.

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Setup tab settings" on 
page 7-9.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Basic tab settings" on 
page 8-9

Mac OS X PostScript PPD "Finishing" on page 10-13.

Mac OS 9.2 "General (basic settings)" on page 9-10 and 
"Printer specific options (finishing options 1 
to 3)" on page 9-12.

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008

"Specifying the Layout tab settings" on 
page 8-18
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Front Cover Page, Back Cover Page, and Transparency Interleave

A front cover and back cover can be added and interleaves can be inserted 
between overhead projector transparencies.

Front cover

Back cover

Front cover

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Per Page Setting tab set-
tings" on page 6-21.
"Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Per Page Setting tab set-
tings" on page 7-22.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Cover Mode tab settings" on 
page 8-23

Mac OS X PostScript PPD "Setup" on page 10-12.

Mac OS 9.2 "Printer specific options (finishing options 1 
to 3)" on page 9-12.
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Per Page Setting

You can specify to have paper inserted between pages and specify simplex 
printing or duplex printing and the paper for printing for each page.

Overlay

Prints the original document on top of form data that was created separately.

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Per Page Setting tab set-
tings" on page 6-21.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008

"Specifying the Cover Mode tab settings" on 
page 8-23

Created dataForm data

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Overlay tab settings" on 
page 6-24.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Stamp/Composition tab set-
tings" on page 8-27
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Watermark

Prints a watermark (text stamp) on the page being printed.

URGENT

CIRCULAR

Conf
iden

tial

DRAFT

IMPORTANT

Pro
of

COPY

URGENT

CIRCULAR

WITHDRAW

NO

REPRODUCTION
TO

P

SECRET
INTERNAL

USE
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Use Printer Fonts (substitute fonts)

Specifies the replacement of TrueType fonts with printer fonts.

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Watermark tab settings" on 
page 6-28.

Konica Minolta Post-
Script

"Specifying the Watermark tab settings" on 
page 7-23.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Stamp/Composition tab set-
tings" on page 8-27

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Font tab settings" on 
page 6-32.

Konica Minolta Post-
Script

"Specifying the Quality tab settings" on 
page 7-25.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Quality tab settings" on 
page 8-35

Mac OS 9.2 PostScript PPD "PostScript Options" on page 9-9.
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User Authentication

When the user authentication settings have been applied on this machine, 
you must enter the required user name and password.

Account Track

Specifies when this machine is operating in Account Track.

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Setup tab settings" on 
page 7-9.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Basic tab settings" on 
page 8-9

Mac OS X PostScript PPD "Security" on page 10-15.

Operating system Printer driver Refer to

Windows Konica Minolta PCL "Specifying the Setup tab settings" on 
page 6-7.

Konica Minolta Post-
Script

"Specifying the Setup tab settings" on 
page 7-9.

Konica Minolta PCL driv-
er (VXL) for Windows Vis-
ta/Server 2008
Konica Minolta Post-
Script driver (VPS) for 
Windows Vista/Server 
2008

"Specifying the Basic tab settings" on 
page 8-9

Mac OS X PostScript PPD "Security" on page 10-15.
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For Windows

The functions of this machine that can be used when printing can be 
specified in the printer driver setup dialog box, which can be displayed from 
the Printers window (for Windows XP/Server 2003, Printers and Faxes 
window).

Settings specified in the printer driver setup dialog box displayed using the 
procedure described below will be applied when printing from any 
application.

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", 
and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click 
"Printers and Faxes".
For Windows Vista/Server 2008, click the [Start] button, and then click 
"Control panel", "Hardware and Sound", and "Printers".

– If "Printers and Faxes" does not appear in the Start menu in 
Windows XP/Server 2003, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select 
"Printers and Faxes".
For Windows Vista/Server 2008, if the control panel is in the classic 
view, double-click "Printers".

2 For Windows 2000/XP/Vista/Server 2003/Server 2008, right-click the 
icon of the installed printer, and then click "Printing Preferences".
For Windows NT 4.0, right-click the icon of the installed printer, and 
then click "Document Default".

The following printer driver setting dialog box appears. For the settings that 
can be specified with each printer driver, refer to the following:
- Konica Minolta PCL driver: "Setting up the PCL driver" on page 6-3
- Konica Minolta PostScript driver: "Setting up the PostScript driver 

(Windows)" on page 7-3
- Konica Minolta PCL driver (VXL) for Windows Vista/Server 2008: "Setting 

up the VXL/VPS driver (Windows Vista/Server 2008)" on page 8-3.
- Konica Minolta PostScript driver (VPS) for Windows Vista/Server 2008: 

"Setting up the VXL/VPS driver (Windows Vista/Server 2008)" on 
page 8-3.
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PCL driver

PostScript driver
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Konica Minolta PCL driver (VXL) for Windows Vista/Server 2008

Konica Minolta PostScript driver (VPS) for Windows Vista/Server 2008
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For Macintosh

The functions of this machine that can be used when printing can be 
specified on the Print dialog box or the Page Setup dialog box.

The settings can only be applied while using the application. When the 
application is exited, the settings return to their default settings.

To display the Print dialog box

Open the data in the application, choose "File", then click "Print".

To display Page Setup dialog box

Open the data in the application, choose "File", and then click "Page Setup" 
or "Paper Setup".

For the settings that can be specified with each printer driver, refer to the 
following:
- OS X: "Setting up the PPD driver (Mac OS X)" on page 10-3
- OS 9.2: "Setting up the PPD driver (Mac OS 9.2)" on page 9-3
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2
Note 

The contents of the Print dialog box and the Page Setup dialog box may 
differ.

Depending on the application, the Page Setup dialog box can be 
displayed by selecting "Paper Setup"—"Options" from the "File" menu.



6 Setting up the PCL driver





Setting up the PCL driver 6

bizhub 362/282/222 6-3

6 Setting up the PCL driver

6.1 Settings

Common settings

The following describes the common settings and buttons that are displayed 
on all tabs.

Button Function

OK Click this button to close the dialog box and apply any settings that 
have been changed.

Cancel Click this button to cancel any settings that have been changed and 
close the dialog box.

Help Click this button to display the help for each item on the currently dis-
played dialog box.

Save/Restore Setting Click this button to save the current settings and to view them at a later 
time.

Restore Defaults Click this button to return the settings to their defaults, which were se-
lected when the driver was installed.
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2
Note 

To enable any installed options, you must specify the Option settings. For 
details, refer to "Specifying the Option tab settings" on page 6-33.

Setup tab

View When "Paper" is selected, a preview of the page layout as specified in 
the current settings is displayed and a preview image of the print job 
can be checked.
When "Printer" is selected, a printer figure is displayed showing any 
options, such as the paper tray, that are installed on this machine.

Button Function

PrinterPaper

Item Function

Paper Specifies the orientation, original size, output size, paper source, 
and paper type.

Binding Specifies the folding format such as the binding position, duplex 
printing, booklet printing, printing multiple pages on one page, file 
margin, stapling, hole punching or center staple and fold.

Output Specifies the output format such as the output method, number 
of copies, output tray, collate, or offset.
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Per Page Setting tab

Overlay tab

Watermark tab

Quality tab

Font tab

Version tab

Item Function

Front Cover Page Attaches a front cover page.

Back Cover Page Attaches a back cover page.

Per Page Setting Inserts paper between pages and switches simplex/duplex and 
paper for each page.

Item Function

Overlay Specifies overlay printing.

Item Function

Watermark Prints a watermark (text stamp) on the document being printed.

Distribution Number 
Stamping

Prints the number of the copy.

Item Function

Print with Black Specifies the data to be printed in black.

Pattern Selects the print pattern.

Item Function

Use Printer Fonts Selects whether to use TrueType fonts or the printer fonts when 
printing.

Download Font Format Selects whether the fonts are downloaded to the printer as bitmap 
or outline.

Item Function

Version Displays the version of the printer driver.
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Option tab

2
Note 

To display the Option tab in Windows 2000/XP/NT 4.0/Server 2003, right-
click the icon of the installed printer, and then click "Properties".

Item Function

Option Specifies the options installed on this machine.

Option Information Automatically specifies the printer driver option settings.
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6.2 Specifying the Setup tab settings

Printing to suit the paper size

You can enlarge or reduce documents created when printing to match the 
output paper size.

1 Click the Setup tab.

2 From the "Original Size" and "Output Size" drop-down lists, select the 
desired settings.

– You can also specify any enlargement or reduction ratio in the 
"Zoom" box.
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Saving a custom size

A custom size can be specified and saved in advance as described below.

1 From the "Original Size" or "Output Size" drop-down list, select 
"Custom Size Settings". The Custom Size Settings dialog box appears.

2 Specify settings for the following:

– List of Custom Sizes: Select the size for the custom size being set.
– Custom Size Name: Input the name of the custom size being 

registered.
– Size: Specify the width and length of the custom size according to 

the selected measurement units.

3 Click the [OK] button.

2
Note 

The custom size settings can only be specified in the printer driver setup 
dialog box, which can be displayed from the Printers window in Windows 
2000/NT 4.0 or from the Printers and Faxes window in Windows 
XP/Server 2003.
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Selecting the paper source

When changing the paper type, you can register it to an input tray and you 
will be able to select the input tray according to the desired paper type.

1 Click the Setup tab.

2 From the "Paper Source" drop-down list, select the paper tray that 
contains the paper to be used.

Setting the paper source of the paper type

Follow the procedure described below to assign a paper type to a paper tray.

1 Click the [Paper Type Settings] button.

2 Select the "Paper Source" being changed, and then click the [Edit 
Paper Type] button.

3 Select the desired setting from the "Paper Type" drop-down list, and 
then click the [OK] button.
Only the paper types that can be selected in each input tray are 
displayed.
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If "Transparency" is selected as the paper type in "Auto" of Paper 
Source, you can specify transparency interleaving. 
When the "Transparency Interleave" check box is selected, the 
Transparency Interleave Settings dialog box appears, allowing you to 
select the source of the interleaf paper. 
The Transparency Interleave Settings dialog box can also be displayed 
by clicking the [Settings] button.

Specifying duplex/booklet printing

You can print a document onto both sides of a page or in a booklet format 
(two facing pages). This comes in handy when you want to bind multiple-
page documents.

1 Click the Setup tab.

2 From the "Print Type" drop-down list, select "Duplex" or "Booklet".

2
Note 

The binding orientation can be specified from the "Binding Position" 
drop-down list.
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Printing multiple pages on one page (N in 1)

You can print multiple document pages on one page. This comes in handy 
when you want to reduce the number of output pages.

1 Click the Setup tab.

2 Select the "Combination" check box.

3 From the "Combination" drop-down list, select the number of pages to 
be printed on one page.

To change the border line and printing order settings, select the 
"Details", and then change the settings in the Combination Details 
dialog box that appears.

2
Note 

When printing a job that contains pages of different sizes and 
orientations, images may be missing or overlapping when the document 
is printed.
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Setting the file margin

File margins are added to the document before it is printed.

1 Click the Setup tab.

2 Select the "File Margin" check box.

3 To set the width of the file margin, click the [Details] button, and then 
specify the desired settings in File Margin Details dialog box that 
appears.

– Front Side/Back Side: Sets the file margin values. By clearing the 
"Same Value for Front and Back Sides" check box, you can specify 
each value for the front and back sides.

– Shift Mode: To add a file margin, select how the image is to be 
shifted.

2
Note 

When "Double Sided" is selected in "Print Type" and "Auto Reduction" is 
specified in Shift Mode in the File Margin Details dialog box, the reduction 
ratio according to the larger (reduction magnification) value of the file 
margin width is used from the values specified in Front Side/Back Side.
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Stapling

Multiple-page documents can be stapled.

The staple function is available only when optional finisher is installed.

1 Click the Setup tab.

2 Select the "Staple" check box.

3 From the drop-down list, specify the number of staples and the 
stapling position.

2
Note 

Depending on the selected Binding Position setting, different stapling 
positions are available.

Hole punching

Holes can be punched into the printed document.

The hole punch function is available only when punch unit is installed on 
optional finisher.

1 Click the Setup tab.

2 Select the "Hole-Punch" check box.

3 From the drop-down list, specify the number of punched holes.

Center Staple and Fold

You can fold and staple printouts in half.

1 Click the Setup tab.

2 Select the "Center Staple and Fold" check box.

2
Note 

The Center Staple and Fold function is only available when the optional 
finisher and saddle kit are installed.
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Selecting the output method

Not only can you print directly, but you can select "Secure Print", which 
requires a password to print, or "Save in User Box", which saves documents 
in the document folder.

The Save in User Box and Save in User Box and Print functions can only be 
used when an optional hard disk is installed.

The Save in User Box, Save in User Box and Print, and Proof and Print 
functions cannot be specified when the "Per Page Setting" setting is 
specified.

1 Click the Setup tab.

2 From the "Output Method" drop-down list, select the output method.

– Print: Prints immediately.
– Secure Print: Saves the document to be printed in the secured 

document box of this machine. When printing, you are required to 
enter the user ID and password in this machine’s control panel. 
Select when printing highly confidential documents.

– Save in User Box: Saves the document to be printed in a box on this 
machine.

– Save in User Box and Print: Saves the document in a box and prints 
at the same time.

– Proof and Print: After part of the document has been printed, this 
machine stops printing temporarily. Select to avoid misprinting 
large print jobs.
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Secure Print

If "Secure Print" was selected, enter the user ID and password in the dialog 
box that appeared.

2
Note 

To print the document, touch "Secure Print" in the Box mode of this 
machine, enter the user ID and password, and then select the document. 
For details, refer to "Print job management" on page 11-82.

Up to 8 characters (alphanumeric characters, spaces, and symbols !# $ 
% & ' ~ = \ | ; : * ` / ? @ _ - . , ( ) [ ] { } < >) can be entered in the "Secure 
Print ID" and "Password" text boxes.

When a password rule is enabled on this machine, passwords that are 
usable in Secure Print are limited and jobs are deleted when a password 
that does not meet the password rule is entered. For the password rules, 
refer to User manual [Copy Operations].

For details on the box functions of this machine, refer to User manual 
[Box Operations].
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Save in User Box

If "Save in User Box" or "Save in User Box and Print" is selected, enter the 
file name and box number to be saved in the File Name and User Box 
Number dialog boxes that appear.

2
Note 

The file name is displayed when the document is output on this 
machine’s control panel. Up to 30 characters (alphanumeric characters, 
spaces, and symbols !# $ % & ' ~ = \ | ; : * ` / ? @ _ - . , ( ) [ ] { } < >) can 
be entered in the "File Name" text box. Be sure to enter a user-friendly 
file name.
In User Box Number, specify the number of the box that was created. For 
public box, enter "1".

For details on the box functions of this machine, refer to User manual 
[Box Operations].
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Proof and Print

When a print job is sent, this machine stops printing temporarily after part of 
the document has been printed. The remaining print job is stored in this 
machine as a print job. When printing multiple copies, you can print the 
remaining part of the print job after checking the print results.

2
Note 

To print the document, touch "Proof Print" in the Box mode of this 
machine, and then select the document. For details, refer to "Print job 
management" on page 11-82.

Proof and Print can be specified when "Collate" is specified.

For details on the box functions of this machine, refer to User manual 
[Box Operations].
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Specifying user authentication settings

When the authentication settings have been applied on this machine, a user 
name and password must be entered.

1 Click the Setup tab.

2 Click the [User Authentication/Account Track] button.

3 Select the "User Authentication" check box, and then enter the user 
name and password.

4 Click the [OK] button.

2
Note 

If a print job is sent using a user name or password that is not a registered 
account on this machine or if a job is sent without the "User 
Authentication" check box selected, this machine cannot authenticate 
the operation and cannot print. When this occurs, the sent job is deleted.

When user authentication is specified on this machine and the Enhance 
Security mode is enabled or when Access Lock is enabled on the 
software DIP switch, the corresponding user may be locked out and 
denied access if the authentication information is not entered correctly.

For details on user authentication and Enhance Security mode, refer to 
User manual [Copy Operations].
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!
Detail 

For user authentication settings, consult the administrator of this 
machine.

Specifying account track settings

If account track settings have been specified on this machine, you must 
enter a user name and password in order to print a job.

1 Click the Setup tab.

2 Click the [User Authentication/Account Track] button.

3 Select the "Account Track" check box, and then enter the department 
name and password.

– A default password can also be registered and used rather than 
entering a password for each job. The default password can be 
specified in the printer driver setup dialog box, which can be 
displayed from the Printers window (for Windows XP/Server 2003, 
Printers and Faxes window).

4 Click the [OK] button.
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2
Note 

If a print job is sent using a department name or password that is not a 
registered account or if a job is sent without the "Track Account" check 
box selected, this machine cannot authenticate the operation and cannot 
print. When this occurs, the sent job is deleted.

When performing user authentication on the machine and Synchronize is 
specified, you can print by inputting the user name and password in User 
Authentication.

For the account track details, consult the administrator of this machine.
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6.3 Specifying the Per Page Setting tab settings

Printing documents with a front cover/back cover

1 Click the Per Page Setting tab.

2 Select the "Front Cover Page" and "Back Cover Page" check boxes.

3 To print on the front cover and back cover, select "Printed". To only 
add a blank page, select "Blank".

4 Select the input tray that contains the loaded paper for the front cover 
and back cover.

2
Note 

The front cover and back cover use the paper of the same input tray.

You cannot specify settings in "Back Cover Page" only. Specify settings 
in "Back Cover Page" and "Front Cover Page" at the same time.

The Save in User Box, Save in User Box and Print, and Proof and Print 
functions cannot be specified when the "Per Page Setting" setting is 
specified.
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Printing multiple pages

The "Per Page Setting" function comes in handy when you want to change 
the input tray during a print job or combine simplex printing and duplex 
printing when printing multiple pages.

Per Page Setting

You can specify the print type and input tray for each page.

1 Click the Per Page Setting tab.

2 Select the "Per Page Setting" check box.

3 From the "List Name" drop-down list, select the name of the desired 
list.

– When changing the list name, click the [Edit List Name] button after 
selecting the list name, and then apply the settings on the dialog 
box that appears.

4 Click the [Add] button, and then specify the page number, print type, 
and paper source in the dialog box that appears.
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2
Note 

For an existing list, click the [Edit] button to change the registered page 
numbers, or click the [Delete] button to delete them.

Click or  to change the page number starting with the smallest page 
number.
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6.4 Specifying the Overlay tab settings

Printing different original documents together (overlay)

An original document can be printed on top of form data that was created 
separately. This function is handy for fax cover letters and form letters.

You must pre-register forms to be printed. For details, refer to "Editing 
forms" on page 6-26.

1 Create the print data using any application.

2 From the "File" menu, select "Print".

3 Select the KONICA MINOLTA 362/282/222 PCL printer, and then click 
the [Preferences] button.

4 Click the Overlay tab.

5 Select "Print Overlay".
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6 From the list, select the form that you want to print.

7 Select the file name, and then click the [OK] button.

The Print dialog box appears again.

8 Click the [OK] button.

Overlay printing is performed.
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Editing forms

To use forms, the data for using forms must be pre-registered. To register a 
form, select "Create Overlay", and then specify the document that you want 
to register.

1 Create the form data using any application.

2 From the "File" menu, select "Print".

3 Select the KONICA MINOLTA 362/282/222 PCL printer, and then click 
the [Preferences] button.

4 Click the Overlay tab.

5 Select "Create Overlay".

6 Click the [Browse Files] button.
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7 Specify the storage location for the form data, and then enter the file 
name in the "File name" box.

8 Click the [Save] button.

9 Select the file name, and then click the [OK] button.

The Print dialog box appears again.

10 Click the [OK] button.

Instead of executing a print job, the form data is saved. The file 
extension is ".kmf".

2
Note 

When the created overlay data consists of multiple pages, the first page 
of data is registered as an overlay.

From the Overlay tab, the selected form data can be deleted by clicking 
the [Delete Overlay File] button.
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6.5 Specifying the Watermark tab settings

Printing a watermark

You can print specific text in the background as a watermark.

1 Click the Watermark tab.

2 Select the "Watermark" check box.

3 From the drop-down list, select the watermark that you want to print.

4 Specify the desired settings for "Type" and "1st Page Only".

– Overwrite: Prints the watermark with a white background.
– Transparent: Prints the watermark with a transparent background.
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Editing a watermark

You can change the fonts and position of the watermark and you can register 
a new one.

1 Click the Watermark tab.

2 Select the "Watermark" check box.

3 Click the [Edit] button.

4 Specify settings for the following:

– [Add]: Click to enter a new watermark in the watermark text box.
– [Delete]: Click to delete the selected watermark.
– Watermark Text: Enter the text to be printed as a watermark.
– Font Settings: Specifies the font and font size.
– Text Angle: Specifies the watermark print angle.
– Position: Specifies the watermark position with the horizontal and 

vertical scroll bars.
– Text Density: Specifies the watermark text density.
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Printing the document number

When printing multiple copies, you can print the number of each document.

1 Click the Watermark tab.

2 Select the "Distribution Number Stamping" check box.

3 Specify settings for the following:

– Pages to Print: Specifies the pages where the numbering is to be 
printed.

– Starting Number: Specifies the starting number.
– Density: Specifies the density of the number being printed.

2
Note 

The "Distribution Number Stamping" check box is not available if the 
"Collate" check box is not selected on the Setup tab.
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6.6 Specifying the Quality tab settings

Specifying settings

1 Click the Quality tab.

2 Specify settings for the following:

– Print with Black: Specifies the data to be printed in black. Prints in 
black except the white areas.

– Pattern: Selects the print pattern as "Fine" or "Coarse".
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6.7 Specifying the Font tab settings

Specifying settings

You can replace the TrueType fonts used in Windows with the printer fonts 
of this machine.

1 Click the Font tab.

2 Select the "Use Printer Fonts" check box.

3 Select the TrueType font that you want to replace.

4 From the "Printer Font to Use" drop-down list, select the printer font to 
replace the TrueType font.

5 Click the [OK] button.

2
Note 

Using the printer fonts will shorten the printing time, however, there may 
be a difference in the screen display and the print results.

When using TrueType fonts, select from the "Download Font Format" 
drop-down list the font type to be downloaded to the printer.
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6.8 Specifying the Option tab settings

2
Note 

If the installed options are not set from the Option tab, the option function 
cannot be used with the printer driver. When installing options, be sure to 
make the proper settings.
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Specifying settings

You can specify the options installed on this machine so that they can be 
used from the printer driver.

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", 
and then click "Printers". 
For Windows XP/Server 2003, click the [Start] button, and then click 
"Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the 
Control Panel from the Start menu, select "Printers and Other 
Hardware", and then select "Printers and Faxes".

2 Right-click the "KONICA MINOLTA 362/282/222 PCL" icon, and then 
click "Properties".

3 Click the Option tab.

4 Specify the installation status of each option.

2
Note 

To automatically set the installed options, enter the printer name or IP 
address of this machine in the "Printer Name or IP Address" box under 
"Option Information", and then click the [Gather Option Information] 
button. However, to execute the Gather Option Information function, the 
network settings of this machine must be specified in advance.
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6.9 Saving the driver settings

For PCL drivers, you can save the setting values of the changed driver and 
recall them as necessary.

Saving the driver settings

1 Change the driver settings from the Setup tab and the Per Page Setting 
tab.

2 Click the [Save/Restore Setting] button, and then select "Save Current 
Setting".
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3 Enter the file name in the "Name" text box.

4 Enter a message in the "Comment" text box as necessary.

5 Specify a folder in the "Save Location" box, and then click the [OK] 
button.

The settings are registered in a library.

2
Note 

The file extension is ".ksf".

You can save up to 25 items in the library.

Up to 64 characters can be entered in the "Name" text box. 

Up to 512 characters can be entered in the "Comment" text box. 
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Restoring the settings

1 Click the [Save/Restore Setting] button on the Printing Preferences 
dialog box, and then select "Restore Saved Setting".

2 From the "Library" list, select the desired settings file.

3 Click the [OK] button.

The setting values are recalled, and the Printing Preferences dialog box 
appears again.

Deleting the settings

1 Click the [Save/Restore Setting] button on the Printing Preferences 
dialog box, and then select "Edit Library".

2 From the "Library" list, select the desired settings file to be deleted.

3 Click the [Delete] button.

2
Note 

Even if the settings file is deleted from the "Library" list, it will remain on 
the hard disk of your computer. By specifying the file name in "Save 
Setting File in Library", you can save it in the "Library" list.
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7 Setting up the PostScript driver 

(Windows)

7.1 Settings

Common settings

The following describes the common settings and buttons that are displayed 
on all tabs.

Button Function

OK Click this button to close the dialog box and apply any settings that 
have been changed.

Cancel Click this button to cancel any settings that have been changed and 
close the dialog box.

Help Click this button to display the help for each item on the currently dis-
played dialog box.

Save Click this button to save the current settings and to view them at a later 
time.

Edit Click this button to change the saved settings.

Default Click this button to return the settings to their defaults, which were se-
lected when the driver was installed.
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2
Note 

To enable any installed options, you must specify the Option settings. For 
details, refer to "Specifying the Option tab settings" on page 7-26.

View When the [Paper View] button is clicked, a preview of the page layout 
as specified in the current settings is displayed and a preview image 
of the print job can be checked.
When the [Printer View] button is clicked, a printer figure is displayed 
showing any options, such as the paper tray, that are installed on this 
machine.

Button Function

Paper Printer
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Setup tab

Layout tab

Item Function

Orientation Specifies the orientation of the image being printed on the paper.

Original Size Specifies the size of the original document.

Output Size Specifies the output paper size. Automatically enlarges or reduc-
es when the Original Size setting is changed.

Zoom Specifies the enlargement and reduction ratio.

Paper Source Selects the paper source for printing.

Paper Type Selects the paper type for printing.

Copies Specifies the number of copies to print.

Collate Specifies whether to print multiple copies in sets.

Offset When printing multiple copies, shifts the output position of each 
set.

Output Tray Selects the tray where to output the printed pages.

Output Method Specifies output methods, such as "Secure Print" and "Save in 
User Box".

[User Authentication/Ac-
count Track]

For user management in the "User Authentication" and "Account 
Track", enter a user name, department name, and password.

Item Function

Combination Prints multiple pages on one page and specifies the booklet func-
tion. Details can be specified in Combination Details.

Rotate 180 Prints the image rotated 180°.

Double Sides Specifies duplex printing.

Binding Position Specifies the binding position.

Staple Specifies stapling.

Center Staple and Fold Folds the printouts in half and staples.

Hole-Punch Specifies hole punching.
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Per Page Setting tab

Watermark tab

Quality tab

Advanced tab

Item Function

Front Cover Page Attaches a front cover page.

Back Cover Page Attaches a back cover page.

Paper Source Selects the input tray for the front cover page and back cover 
page.

Transparency Interleave Outputs and inserts interleaves when printing overhead projector 
transparencies.

Paper Source Selects the input tray for the transparency interleaves.

Item Function

Watermark Prints a watermark (text stamp) on the page being printed. Water-
marks can be added, changed, or deleted.

Transparent Prints the watermark with a transparent background.

1st Page Only Prints the watermark on the first page only.

Repeat Prints several watermarks on a single page.

Item Function

Font Settings Selects whether to use TrueType fonts or the printer fonts when 
printing.

Item Function

Advanced Printing Features Specifies whether to enable metafile spooling.

PostScript Output Option Specifies the PostScript file output format.

Send PostScript Error Han-
dler

Specifies whether to print an error report when a PostScript error 
occurs.

Mirrored Output Reverses horizontally, then prints.

Negative Output Reverses black and white, then prints.

PostScript Pass through Allows applications to print directly without using a printer driver.
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Device Settings tab

2
Note 

To display the Device Settings tab in Windows 2000/XP/NT 4.0/Server 
2003, right-click the icon of the installed printer, and then click 
"Properties".

Item Function

Font Substitution Table Specifies the replacement of TrueType fonts with printer fonts.

Available PostScript Mem-
ory

Specifies the usable PostScript memory size.

Output Protocol Specifies the protocol for transmitting to the printer.

Send CTRL-D Before Each 
Job

Specifies whether to reset printer before printing.

Send CTRL-D After Each 
Job

Specifies whether to reset printer after printing.

Convert Gray Text to Post-
Script Gray

Specifies whether to convert gray text in a document to Post-
Script gray.

Convert Gray Graphics to 
PostScript Gray

Specifies whether to convert gray graphics in a document to 
PostScript gray.

Add Euro Currency Symbol 
to PostScript Fonts

Specifies whether to add the Euro currency symbol in a document 
to PostScript fonts.

Job Timeout Printer stops printing when a print job is not completed within the 
specified time.

Wait Timeout Printer stops printing when the printer does not receive data with-
in the specified time from when the job was sent.

Minimum Font Size to 
Downloaded as Outline

Specifies the minimum font size (pixels) when downloading Tru-
eType fonts as outline fonts. Fonts smaller than the minimum 
specified size are downloaded as bitmap fonts.

Maximum Font Size to 
Downloaded as Bitmap

Specifies the maximum font size (pixels) when downloading Tru-
eType fonts as bitmap fonts. Fonts larger than the maximum 
specified size are downloaded as outline fonts.
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Option Tab

2
Note 

To display the Device Information tab in Windows 2000/XP/NT 4.0/Server 
2003, right-click the icon of the installed printer, and then click 
"Properties".

You cannot click the [Gather Option Information] button if you are not 
connected to or able to communicate with this machine.

Settings tab

2
Note 

To display the Settings tab in Windows 2000/XP/NT 4.0/Server 2003, 
right-click the icon of the installed printer, and then click "Properties".

Item Function

Option Specifies the options that are installed on this machine.

Gather Option Information Communicates with this machine and reads the status of the in-
stalled options.

PageScope Web Connec-
tion

Starts up PageScope Web Connection.

Item Function

Display Constraint Mes-
sage

Displays a message when you want to perform a function that 
cannot be set when the printer is being used.

Use Print Server Properties 
Form

Uses the added registered paper in [Server Properties].
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7.2 Specifying the Setup tab settings

Printing to suit the paper size

You can enlarge or reduce documents created when printing to match the 
output paper size.

1 Click the Setup tab.

2 From the "Original Size" and "Output Size" drop-down lists, select the 
desired settings.

– You can also specify any enlargement or reduction ratio in the 
"Zoom" box.
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Saving a custom size

A custom size can be specified and saved in advance as described below.

1 From the "Original Size" or "Output Size" drop-down lists, select 
"Custom Size Settings".

The Custom Size Settings dialog box appears.

2 Specify settings for the following:

– Size: Specify the width and length of the custom size according to 
the selected measurement units.

3 Click the [OK] button.
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Selecting the output method

Not only can you print directly, but you can select "Secure Print", which 
requires a password to print, or "Save in User Box", which saves documents 
in the document folder.

The Save in User Box and Save in User Box and Print functions can only be 
used when an optional hard disk is installed.

The Save in User Box, Save in User Box and Print, and Proof and Print 
functions cannot be specified when the "Per Page Setting" setting is 
specified.

1 Click the Setup tab.

2 From the "Output Method" drop-down list, select the output method.

– Print: Prints immediately.
– Secure Print: Saves the document to be printed in the secured 

document box of this machine. When printing, you are required to 
enter the user ID and password in this machine’s control panel. 
Select when printing highly confidential documents.

– Save in User Box: Saves the document to be printed in a box on this 
machine.

– Save in User Box and Print: Saves the document in a box and prints 
at the same time.

– Proof and Print: After a part of the document has been printed, this 
machine stops printing temporarily. Select to avoid misprinting 
large print jobs.
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Secure Print

If "Secure Print" was selected, enter the user ID and password in the dialog 
box that appeared.

2
Note 

To print the document, touch "Secure Print" in the Box mode of this 
machine, enter the user ID and password, and then select the document. 
For details, refer to "Print job management" on page 11-82.

Up to 8 characters (alphanumeric characters, spaces, and symbols !# $ 
% & ' ~ = \ | ; : * ` / ? @ _ - . , ( ) [ ] { } < >) can be entered in the "Secure 
Print ID" and "Password" text boxes.

When a password rule is enabled on this machine, passwords that are 
usable in Secure Print are limited and jobs are deleted when a password 
that does not meet the password rule is entered. For the password rules, 
refer to User manual [Copy Operations].

For details on the box functions of this machine, refer to User manual 
[Box Operations].
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Save in User Box

If "Save in User Box" or "Save in User Box and Print" is selected, enter the 
file name and box number to be saved in the File Name and User Box 
Number dialog boxes that appear.

2
Note 

The file name is displayed when the document is output on this 
machine’s control panel. Up to 30 characters (alphanumeric characters, 
spaces, and symbols !# $ % & ' ~ = \ | ; : * ` / ? @ _ - . , ( ) [ ] { } < >) can 
be entered in the "File Name" text box. Be sure to enter a user-friendly 
file name.
In User Box Number, specify the number of the box that was created. For 
public box, enter "1".

For details on the box functions of this machine, refer to User manual 
[Box Operations].
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Proof and Print

When a print job is sent, this machine stops printing temporarily after part of 
the document has been printed. The remaining print job is stored in this 
machine as a print job. When printing multiple copies, you can print the 
remaining part of the print job after checking the print results.

2
Note 

To print the document, touch "Proof Print" in the Box mode of this 
machine, and then select the document. For details, refer to "Print job 
management" on page 11-82.

Proof and Print can be specified when "Collate" is specified.

For details on the box functions of this machine, refer to User manual 
[Box Operations].
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Specifying user authentication settings

When the authentication settings have been applied on this machine, a user 
name and password must be entered.

1 Click the Setup tab.

2 Click the [User Authentication/Account Track] button.

3 Select the "User Authentication" check box, and then enter the user 
name and password.
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2
Note 

If a print job is sent using a user name or password that is not a registered 
account on this machine or if a job is sent without the "User 
Authentication" check box selected, this machine cannot authenticate 
the operation and cannot print. When this occurs, the sent job is deleted.

When user authentication is specified on this machine and the Enhance 
Security mode is enabled or when Access Lock is enabled on the 
software DIP switch, the corresponding user may be locked out and 
denied access if the authentication information is not entered correctly.

For details on user authentication and Enhance Security mode, refer to 
User manual [Copy Operations].

!
Detail 

For user authentication settings, consult the administrator of this 
machine.

Specifying account track settings

If account track settings have been specified on this machine, you must 
enter a department name and password.

1 Click the Setup tab.

2 Click the [User Authentication/Account Track] button.
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3 Select the "Account Track" check box, and then enter the department 
name and password.

2
Note 

If a print job is sent using a department name or password that is not a 
registered account or if a job is sent without the "Track Account" check 
box selected, this machine cannot authenticate the operation and cannot 
print. When this occurs, the sent job is deleted.

When performing user authentication on the machine and Synchronize is 
specified, you can print by inputting the user name and password in User 
Authentication.

For the account track details, consult the administrator of this machine.
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7.3 Specifying the Layout tab settings
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Printing multiple pages on one page (N in 1)

You can print multiple documents pages on one page. You can also specify 
the "Booklet" setting to fold the printouts in half to make a booklet.

1 Click the Layout tab.

2 From the "Combination" drop-down list, select the number of pages to 
be printed on one page.

To change the border line and printing order settings, click 
[Combination Details] button, and then change the settings in the 
dialog box that appears.

2
Note 

When printing a job that contains pages of different sizes and 
orientations, images may be missing or overlapping when the document 
is printed.
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Duplex printing

You can print a document onto both side of a page. This comes in handy 
when you want to bind multiple-page documents.

1 Click the Layout tab.

2 From the "Double Sides" drop-down list, select "Double-Sided".

2
Note 

The binding orientation can be specified from the "Binding Position" 
drop-down list.

Setting the file margin

File margins are added to the document before it is printed.

1 Click the Layout tab.

2 From the "Binding Position" drop-down list, select the position of the 
binding margin.

Stapling

Multiple-page documents can be stapled.

The staple function is available only when optional finisher is installed.

1 Click the Layout tab.

2 From the "Staple" drop-down list, specify the number of staples and 
the stapling position.

2
Note 

Depending on the selected Binding Position setting, different stapling 
positions are available.
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Center Staple and Fold

You can fold and staple printouts in half.

1 Click the Layout tab.

2 From the "Center Staple and Fold" drop-down list, select "Center 
Staple and Fold".

2
Note 

The Center Staple and Fold function is only available when the optional 
finisher and saddle kit are installed.

Hole punching

Holes can be punched into the printed document.

The hole punch function is available only when punch unit is installed on 
optional finisher.

1 Click the Layout tab.

2 From the "Hole-Punch" drop-down list, specify the number of punched 
holes.

2
Note 

Depending on the selected Binding Position setting, different hole 
punching positions are available.
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7.4 Specifying the Per Page Setting tab settings

Printing documents with a front cover/back cover

1 Click the Per Page Setting tab.

2 From the "Front Cover Page" and "Back Cover Page" drop-down lists, 
select the desired printing settings.

To print on the front cover and back cover, select "Printed". To only 
add a blank page, select "Blank".

3 Select the input tray that contains the loaded paper for the front cover 
and back cover.

2
Note 

The front cover and back cover use the paper of the same input tray.

You cannot specify settings in "Back Cover Page" only. Specify settings 
in "Back Cover Page" and "Front Cover Page" at the same time.

The Save in User Box, Save in User Box and Print, and Proof and Print 
functions cannot be specified when the "Per Page Setting" setting is 
specified.
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7.5 Specifying the Watermark tab settings

Printing a watermark

You can print specific text in the background as a watermark.

1 Click the Watermark tab.

2 From the drop-down list, select the watermark that you want to print.

3 Specify settings for the following:

– Transparent: Prints the watermark with a transparent background.
– 1st Page Only: Prints the watermark on the first page only.
– Repeat: Prints several watermarks on a single page.
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Editing a watermark

You can change the fonts and position of the watermark and you can register 
a new one.

1 Click the Watermark tab.

2 To create a watermark, click the [Add] button.

To change a watermark, select the watermark to be changed, and then 
click the [Edit] button.

3 Specify settings for the following:

– Watermark Name: Specifies the watermark name being registered.
– Watermark Text: Specifies the watermark text.
– Font Name, Size, Style, Angle, Text Density, and Frame: Specifies 

the font, font size, style, text angle, text density, and frame of the 
watermark.

– Position: Specifies the watermark position with the horizontal and 
vertical scroll bars.

– Sharing: Specifies whether to share a watermark.

2
Note 

Only the administrator of the computer can select a setting under 
"Sharing".
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7.6 Specifying the Quality tab settings

Font Settings

You can replace the TrueType fonts used in Windows with the printer fonts 
of this machine.

1 Click the [Font Settings] button.

2 Specify settings for the following:

– Download Font Format: Select the TrueType font downloading 
method.

– Use Printer Fonts: Replace TrueType fonts with the printer fonts.

2
Note 

Using the printer fonts will shorten the printing time, however, there may 
be a difference in the screen display and the print results.

When using TrueType fonts, select from the "Download Font Format" 
drop-down list the font type to be downloaded to the printer.

Specify the font replacement list from the Device Settings tab.
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7.7 Specifying the Option tab settings

You can specify the options installed on this machine so that they can be 
used from the printer driver.

2
Note 

If the installed options are not set from the Option tab, the option function 
cannot be used with the printer driver. When installing options, be sure to 
make the proper settings.



Setting up the PostScript driver (Windows) 7

bizhub 362/282/222 7-27

Specifying settings

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", 
and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click 
"Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the 
Control Panel from the Start menu, select "Printers and Other 
Hardware", and then select "Printers and Faxes".

2 Right-click the "KONICA MINOLTA 362/282/222 PS" icon, and then 
click "Properties".

3 Click the Option tab.

4 Select the option, and then specify the installation status from the 
drop-down list below.

2
Note 

The installed option can be automatically registered in the "Option" list by 
clicking the [Gather Option Information] button when connected to this 
machine. However, to execute the Gather Option Information function, 
the network settings of this machine must be specified in advance.



7 Setting up the PostScript driver (Windows)

7-28 bizhub 362/282/222

7.8 Saving the driver settings

For PostScript drivers, you can save the setting values of the changed driver 
and recall them as necessary.

Saving the driver settings

1 Change the driver settings from the Setup tab and the Layout tab.

2 Click the [Save] button.
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3 Enter the file name in the "Name" text box.

4 Enter a message in the "Comment" text box as necessary.

5 Specify whether to share.

6 Click the [OK] button.

The settings are registered in a library.

2
Note 

Up to 30 public and 20 private watermarks can be registered.

Only the administrator of the computer can select a setting under 
"Sharing".

Up to 30 characters can be entered in the "Name" text box.
Up to 255 characters can be entered in the "Comment" text box.

Restoring the settings

% Select the settings to restore from the "Easy Set" drop-down list on the 
Printing Preferences dialog box.
The setting values are recalled, and the Printing Preferences dialog box 
appears again.
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Changing the settings

1 On the Printing Preferences dialog box, click the [Edit] button.

2 From the list, select the file that you want to change, and then change 
the setting.

To delete the file, click the [Delete] button.

3 Click the [Options] button, check the settings to recall, and then click 
the [OK] button.

4 Click the [OK] button.
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8 Setting up the VXL/VPS driver (Windows 

Vista/Server 2008)

8.1 Settings

The following describes the functions of the Windows Vista/Server 2008 PCL 
driver (VXL) and Windows Vista/Server 2008 PostScript driver (VPS).

Common settings

The following describes the common settings and buttons that are displayed 
on all tabs.

Button Function

OK Click this button to close the dialog box and apply any settings 
that have been changed.

Cancel Click this button to cancel any settings that have been changed 
and close the dialog box.

Help Click this button to display the help for each item on the current-
ly displayed dialog box.

Add (Favorite Setting) Click this button to save the current settings and to view them 
at a later time.

Edit (Favorite Setting) Click this button to change the saved settings.

Default Click this button to return the settings to their defaults, which 
were selected when the driver was installed.
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2
Note 

To enable any installed options, you must specify the Device Option 
settings. For details, refer to "Specifying the Configure tab settings" on 
page 8-39.

Printer Information Click this button to start up PageScope Web Connection and 
check the information of the machine. This is enabled when 
communication with the machine is possible.

View When the [Paper View] button is clicked, a preview of the page 
layout as specified in the current settings is displayed and a pre-
view image of the print job can be checked.
When the [Printer View] button is clicked, a printer figure is dis-
played showing any options, such as the paper tray, that are in-
stalled on this machine.

Button Function

PrinterPaper
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Basic tab

Layout tab

Item Function

Original Orientation Specifies the orientation of the original document.

Original Size Specifies the size of the original document.

Paper Size Specifies the output paper size. Automatically enlarges or 
reduces when the Original Size setting is changed.

Zoom Specifies the enlargement and reduction ratio.

Paper Tray Selects the paper tray for printing.

Paper Type Selects the paper type for printing.

Output Method For non-conventional printing, selects special output meth-
ods such as "Secure Print" or "Save in User Box".

[User Settings] Specifies the ID and password, or the file name and box 
number when performing "Secure Print" or "Save in User 
Box".

[Authentication/Account Track] Specifies the user name and password when performing 
user authentication, and the department name and pass-
word when performing account track on this machine.

Copies Specifies the number of copies to print.

Collate Specifies whether to print multiple copies in sets.

Offset When printing multiple copies, shifts the output position of 
each set.

Paper Settings for Each Tray Specifies the paper type for each paper tray.

Item Function

Combination Prints multiple pages on one page, or prints one sheet of an 
original document divided on multiple pages. Details can 
be specified by clicking the [Combination Details] button.

Rotate 180 Prints the image rotated 180°.

Skip Blank Pages Does not print blank pages in the data.
This function is only available with the Windows Vista/Serv-
er 2008 PCL driver (VXL).

Print Type Specifies duplex printing and booklet printing.

Binding Direction Specifies the binding position.

Binding Margin Specifies the binding margin. Click the [Binding Margin 
Settings] button to specify the margin values.
This function is only available with the Windows Vista/Serv-
er 2008 PCL driver (VXL).
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Finish tab

Cover Mode tab

Stamp/Composition tab

Item Function

Staple Specifies stapling.

Saddle Stitch Specifies to saddle stitch a printed document.

Punch Specifies hole punching.

Output Tray Specifies the tray where to output the printed pages.

Item Function

Front Cover Attaches a front cover page.

Front Cover Tray Selects the paper tray for the front cover.

Back Cover Attaches a back cover page.

Back Cover Tray Selects the paper tray for the back cover.

Per Page Setting Inserts paper between pages and switches the paper and 
tray for each page.
This function is only available with the Windows Vista/Serv-
er 2008 PCL driver (VXL).

Transparency Interleave Outputs and inserts interleaves when printing overhead 
projector transparencies.

Interleave Tray Selects the input tray for the transparency interleaves.

Item Function

Watermark Prints a watermark (text stamp) on the page being printed. 
Watermarks can be added, changed, or deleted by clicking 
the [Edit] button.

Create Overlay File Prints an original document on top of an overlay that was 
created separately.

Distribution Number Stamping Prints the number of the copy.
This function is only available with the Windows Vista/Serv-
er 2008 PCL driver (VXL).
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Quality tab

Other tab

Item Function

Resolution Specifies the print resolution. (The resolution cannot be 
changed on this machine.)

Pattern Selects the print pattern.
This function is only available with the Windows Vista/Serv-
er 2008 PCL driver (VXL).

Image Compression Specifies the compression ratio for an image.
This function is only available with the Windows Vista/Serv-
er 2008 PCL driver (VXL).

Print with Black Specifies the data to be printed in black.
This function is only available with the Windows Vista/Serv-
er 2008 PCL driver (VXL).

Font Settings Selects whether to use TrueType fonts or the printer fonts 
when printing.

Item Function

Excel Job Control Controls jobs so that they are not separated when printing 
in Microsoft Excel.

Remove White Background Removes the white background when creating an overlay 
file with Microsoft PowerPoint. If this check box is cleared, 
the background is not removed and the overlay file is cre-
ated according to the original document data.
This function is only available with the Windows Vista/Serv-
er 2008 PCL driver (VXL).

Check Driver Version Displays the version information of the printer driver.
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Configure tab

2
Note 

To display the Configure tab in Windows Vista/Server 2008, right-click 
the icon of the installed printer, and then click "Properties".

You cannot use the "Acquire Device Information" function if you are not 
connected to or able to communicate with this machine.

Settings tab

2
Note 

To display the Settings tab in Windows Vista/Server 2008, right-click the 
icon of the installed printer, and then click "Properties".

Item Function

Device Option Specifies the status of the options that are installed on this 
machine and the status of the user authentication and ac-
count track functions. Specify the status of each item from 
the "Setting" drop-down list.

Acquire Device Information Communicates with this machine to read the status of the 
installed options.

Acquire Settings Specifies the status of the connection that executes getting 
the option information.

Software Tools Starts up software tools such as PageScope Web Connec-
tion.

Item Function

EMF Spool When using an original system environment, select this 
check box if a metafile (EMF) spool is required.
This function is only available with the Windows Vista/Serv-
er 2008 PCL driver (VXL).

Display Constraint Message Displays a message when functions that cannot be speci-
fied at the same time were enabled from the printer driver.

Display paper set in Print Server 
Properties.

Uses the paper that was added in [Server Properties] of the 
printer folder.

Popup Authentication Dialog 
when printing

Displays the User Authentication/Account Track dialog box 
when a print job is specified to enter the user name and de-
partment name.

Save Custom Size Saves the custom paper sizes.
This function is only available with the Windows Vista/Serv-
er 2008 PCL driver (VXL).
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8.2 Specifying the Basic tab settings

Printing to suit the paper size

You can enlarge or reduce documents created when printing to match the 
output paper size.

1 Click the Basic tab.

2 From the "Original Size" and "Paper Size" drop-down lists, select the 
desired settings.

– You can also specify any enlargement or reduction ratio in the 
"Zoom" box.
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Specifying a custom size

When printing on paper of a custom size, you can select a preregistered 
custom paper size or specify a paper size value as described below.

1 From the "Original Size" or the "Paper Size" drop-down list, select 
"Custom Size".

The Custom Size Settings dialog box appears.

2 Specify settings for the following:

– Width: Specifies the width of the custom paper size according to 
the selected measurement unit.

– Length: Specifies the length of the custom paper size according to 
the selected measurement unit.

– Unit: Selects the measurement unit that specifies the size.

3 Click the [OK] button.

2
Note 

For custom sizes that are used often, it comes in handy if you add them 
to the paper size list. Add a custom paper size from the Settings tab. For 
details, refer to "Specifying the Settings tab settings" on page 8-41.
The "Save Custom Size" function is only available with the Windows 
Vista/Server 2008 PCL driver (VXL).
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Selecting the paper tray

You can specify the paper you want to use for printing by selecting the paper 
tray that contains the loaded paper.

1 Click the Basic tab.

2 From the "Paper Tray" drop-down list, select the desired paper tray.

2
Note 

If "Auto" is specified as the paper tray, you can select the paper type. If 
the paper tray setting is changed to a setting other than "Auto", the paper 
type is fixed to its preregistered setting. Specify a paper type by clicking 
the [Paper Settings for Each Tray] button. For details, refer to "Specifying 
the paper type for a paper tray" on page 8-11.

Specifying the paper type for a paper tray

You can specify the paper type for a paper tray.

1 Click the Basic tab.

2 Click the [Paper Settings for Each Tray] button.

The Paper Settings for Each Tray dialog box appears.

3 From "Paper Type Settings", select the desired paper tray, and then 
select the paper type to be specified from the "Paper Type" drop-down 
list.

4 Click the [OK] button.
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Selecting the output method

Not only can you print directly, but you can select "Secure Print", which 
requires a password to print, or "Save in User Box", which saves data in the 
boxes that were created on the HDD.

1 Click the Basic tab.

2 From the "Output Method" drop-down list, select the output method.

– Print: Prints immediately.
– Secure Print: Saves the document to be printed in "Secure Print 

User Box" of this machine. When printing, you are required to enter 
the ID and password in this machine’s control panel. Select when 
printing highly confidential documents.

– Save in User Box: Saves the document to be printed in a box on this 
machine.

– Save in User Box and Print: Saves the document in a box and prints 
at the same time.

– Proof Print: After a part of the document has been printed, this 
machine stops printing temporarily. Select to avoid misprinting a 
large volume of print jobs.
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Secure Print

If "Secure Print" was selected, enter the ID and password in the dialog box 
that appeared.

2
Note 

The ID and password that are required for "Secure Print" can be 
preregistered by clicking the [User Settings] button under "Output 
Method". If the ID and password are already registered, the dialog box to 
enter the ID and password does not appear when "Secure Print" is 
selected.

To print, specify "Secure Print Document Box" from the Box mode in this 
machine’s control panel, and then enter the ID and password. For details, 
refer to "Print job management" on page 11-82. For details on the box 
functions of this machine, refer to the User manual [Box Operations].

When password rules are enabled on this machine, the passwords that 
can be used for secured printing are limited and the jobs are deleted 
when a password that does not comply with the password rule is 
entered. For the password rules, refer to the User manual [Copy 
Operations].
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Save in User Box

When "Save in User Box" or "Save in User Box and Print" is selected, specify 
the file name to be saved and the box number for the save location in the 
dialog box that appears for entering the file name and box number.

2
Note 

The file name and box number that are required for "Save in User Box" 
can be preregistered by clicking the [User Settings] button under "Output 
Method". If the file name and box number are already registered, the 
dialog box to enter the file name and box number does not appear when 
"Save in User Box" is selected.

The file name is displayed when the document is output on this 
machine's control panel. Up to 30 characters (alphanumeric characters, 
spaces, and symbols !# $ % & ' ~ = \ | ; : * ` / ? @ _ - . , ( ) [ ] { } < >) can 
be entered in the "File Name" text box. Be sure to enter a user-friendly 
file name.

Be sure to create the box of the save location in advance with the box 
function of this machine. For details on the box functions of this machine, 
refer to the User manual [Box Operations].

When password rules are enabled on this machine, specify the box that 
was created on this machine.
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Proof Print

When a print job is sent, this machine stops printing temporarily after part of 
the document has been printed. The remaining print job is stored in this 
machine as a print job. When printing multiple copies, you can print the 
remaining part of the print job after checking the print results.

2
Note 

To print the document, release the held document from the Job mode in 
this machine’s control panel. For details, refer to "Print job management" 
on page 11-82.

Proof and Print can be specified when "Collate" is specified.

Specifying the user authentication settings

If the user authentication settings have been specified on this machine, you 
must enter a user name and password.

2
Note 

If a job is printed using a user name or password that is not a registered 
account on this machine, or if a job is printed without selecting a user 
under "User Authentication", the operation is not authenticated by this 
machine and the job is canceled.

When user authentication is specified on this machine and the Enhance 
Security mode is enabled or when Access Lock is enabled on the 
software DIP switch, the corresponding user may be locked out and 
denied access if the authentication information is not entered correctly.
For details on user authentication and Enhance Security mode, refer to 
User manual [Copy Operations].

If the user authentication settings are not specified on the Configure tab, 
user authentication cannot be performed. If using the user authentication 
function, be sure to specify the settings on the Configure tab. For details, 
refer to "Specifying the Configure tab settings" on page 8-39.
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1 Click the Basic tab.

2 Click the [Authentication/Account Track] button.

3 Select "Recipient User", and then enter the user name and password.

4 Click the [OK] button.

2
Note 

If printing is not allowed, printing cannot be performed even when used 
by a registered user. For details on the user authentication function, 
consult the administrator of this machine.
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Specifying the account track settings

If the account track settings have been specified on this machine, you must 
enter a department name and password.

2
Note 

If a job is printed using a department name or password that is not a 
registered account on this machine, or if a job is printed without "Account 
Track" selected, the operation is not authenticated by this machine and 
the job is canceled.

If the account track settings are not specified on the Configure tab, 
account track cannot be performed. If using the account track function, 
be sure to specify the settings on the Configure tab. For details, refer to 
"Specifying the Configure tab settings" on page 8-39.

1 Click the Basic tab.

2 Click the [Authentication/Account Track] button.

3 Enter the department name and password.

4 Click the [OK] button.

2
Note 

If printing is not allowed, printing cannot be performed even when used 
by a registered account. For details on the account track function, 
consult the administrator of this machine.
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8.3 Specifying the Layout tab settings

2
Note 

The "Skip Blank Pages" and "Binding Margin" functions are only 
available with the Windows Vista/Server 2008 PCL driver (VXL).
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Printing multiple pages on one page (N in 1, Poster Mode)

You can specify whether to print multiple pages of text on one page with N 
in 1 printing.

1 Click the Layout tab.

2 Select the "Combination" check box, and then specify the setting from 
the drop-down list.

– To change the "Border" settings, click the [Combination Details] 
button, and then change the settings in the dialog box that appears.

2
Reminder 

When printing a job that contains pages of different sizes and 
orientations, images may be missing or overlapping when the document 
is printed.

Specifying duplex/booklet printing

You can print a document onto both sides of a page or in a booklet format 
(two facing pages). This comes in handy when you want to bind multiple-
page documents.

1 Click the Layout tab.

2 From the "Print Type" drop-down list, select "2-Sided" or "Booklet".

2
Note 

The binding position can be specified from the "Binding Direction" drop-
down list.
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Setting the binding margin

Binding margins are added to the document before it is printed.

1 Click the Layout tab.

2 From the "Binding Direction" drop-down list, select the binding 
position.

3 Select the "Binding Margin" check box.

4 To set the width of the binding margin, click the [Binding Margin 
Settings] button, and then specify the desired settings in the Binding 
Margin Settings dialog box that appears.

– Shift Mode: To add a binding margin, select how the image is to be 
shifted.

– Front Side/Back Side: Sets the binding margin values. By clearing 
the "Same value for front and back sides" check box, you can 
specify separate values for the front and back sides.

– Unit: Selects the measurement unit that specifies the size.

2
Note 

The "Binding Margin" function is only available with the Windows 
Vista/Server 2008 PCL driver (VXL).
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8.4 Specifying the Finish tab settings

Stapling

Multiple-page documents can be stapled.

2
Reminder 

The staple function is available only when the optional finisher is installed.

1 Click the Finish tab.

2 Select the "Staple" check box.

3 From the drop-down list, specify the number of staples and the 
stapling position.

2
Note 

Specify the staple position noting the binding position specified in 
"Binding Direction".
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Specifying the center staple and fold setting

You can specify to center staple and fold a printed document. By specifying 
the center staple and fold setting, printed documents can be folded in half 
and stapled.

2
Reminder 

The center staple and fold function is available only when optional finisher 
and saddle kit are installed.

1 Click the Finish tab.

2 Select the "Center Staple and Fold" check box.

Hole punching

Holes can be punched into the printed document.

2
Reminder 

The hole punch function is available only when the punch kit is installed 
on the optional finisher.

1 Click the Finish tab.

2 Select the "Punch" check box.

3 From the drop-down list, specify the number of punched holes.

2
Note 

The hole-punch position changes according to the binding position 
specified from "Binding Direction".

Specifying the output tray

You can specify the tray to which the printed document is output.

1 Click the Finish tab.

2 From the "Output Tray" drop-down list, specify the output tray.
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8.5 Specifying the Cover Mode tab settings

2
Note 

The "Per Page Setting" function is only available with the Windows 
Vista/Server 2008 PCL driver (VXL).
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Printing documents with a front cover/back cover

1 Click the Cover Mode tab.

2 Select the "Front Cover" and "Back Cover" check boxes.

3 From the "Front Cover" and "Back Cover" drop-down lists, select the 
desired print settings.
To print on the front cover and back cover, select "Print". To only add 
a blank page, select "Blank".

4 Select the paper tray that contains the loaded paper for the front cover 
and back cover.

2
Note 

The same paper tray can be used for the "Front Cover" and "Back Cover" 
functions.

The "Back Cover" function cannot be specified alone. Be sure to specify 
the "Back Cover" settings when specifying the "Front Cover".

Printing multiple pages

You can specify the print type and paper tray for each page. This comes in 
handy when you want to change the paper tray during a print job when 
printing multiple pages.

1 Click the Cover Mode tab.

2 Select the "Per Page Setting" check box.

3 From the "Per Page Setting" drop-down list, select the desired list 
name.

4 Click the [Edit List] button.

The Per Page Settings – Edit List dialog box for specifying the print 
settings appears.
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5 Click the [Add] button.

A new row for specifying the print settings is added to "Settings List".

6 Select the row that was added to the list, and then specify the print 
settings in "Add/Edit".

– Page Number: Enters the page number. When entering multiple 
page numbers, separate the page numbers with commas such as 
"2, 4, 6" or enter a page range using a hyphen such as "6-10".

– Print Type: Specifies Print Insert, Insert Blank Sheet, Print (1-
Sided), and Print (2-Sided).

– Paper Tray: Specifies the paper tray.

7 Click the [OK] button.
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2
Note 

To change existing print settings, select the desired row and change the 
settings. To delete existing print settings, select the desired row, and 
then click the [Delete] button.

Click the [Up] or the [Down] button to change the page number starting 
with the smallest page number.

The list name can be changed by clicking the [Edit List Name] button.

The "Per Page Setting" function is only available with the Windows 
Vista/Server 2008 PCL driver (VXL).

2
Reminder 

The Save in User Box, Save in User Box and Print, and Proof and Print 
functions cannot be specified when the "Per Page Setting" setting is 
specified.

Printing with transparency interleaves

If "Transparency" is selected as the paper type, you can select the 
"Transparency Interleave" check box to enable the transparency interleave 
setting. By selecting the "Transparency Interleave" check box, overhead 
projector transparencies can be inserted between the printed pages.

1 Click the Cover Mode tab.

2 Select the "Transparency Interleave" check box.

3 From the "Transparency Interleave" drop-down list, specify the printing 
conditions.

4 From the "Transparency Interleave" drop-down list, select the paper 
tray that contains the paper to be used.
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8.6 Specifying the Stamp/Composition tab settings

2
Note 

The "Distribution Number Stamping" function is only available with the 
Windows Vista/Server 2008 PCL driver (VXL).

Printing a watermark

You can print specific text in the background as a watermark.

1 Click the Stamp/Composition tab.

2 Select the "Watermark" check box.

3 From the list, select the watermark that you want to print.

Editing a watermark

You can change the fonts and position of the watermark and you can register 
a new one.

1 Click the Stamp/Composition tab.

2 Select the "Watermark" check box.

3 Click the [Edit] button under "Watermark".

The Edit Watermark dialog box appears.
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4 To create a watermark, click the [Add] button.
To change a watermark, select the watermark from the "Current 
Watermark" list.

5 Specify settings for the following:

– Watermark Name: Enters the name of the watermark.
– Watermark Text: Enters the text to be printed as a watermark.
– [Add]: Click to create a new watermark.
– [Delete]: Click to delete the selected watermark.
– Position: Specifies the vertical and horizontal positions. The 

watermark position can also be specified by using the horizontal 
and vertical sliders in the dialog box.

– Text Angle: Specifies the watermark print angle.
– Font Name: Specifies the font.
– Size: Specifies the size.
– Style: Specifies the font style.
– Frame: Specifies the frame style.
– Density: Specifies the watermark text density.
– Sharing: Specifies whether to register the watermark as public or 

private.
– Transparent: Prints the watermark as a transparent image.
– 1st Page Only: Prints the watermark on the first page only.
– Repeat: Prints several watermarks on a single page.

6 Click the [OK] button.
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Printing different original documents together (overlay)

An original document can be printed on top of the overlay data that was 
created separately. This function comes in handy when creating fax cover 
letters or form letters.

2
Note 

You must create and preregister the overlay file to be printed. For details, 
refer to "Editing an overlay file" on page 8-30.

1 Create the print data using any application.

2 From the [File] menu, select "Print".

3 Select this machine in "Printer Name", and then click the [Properties] 
button or the [Preferences] button.

4 Click the Stamp/Composition tab.

5 Select the "Print in Overlay" check box.

6 From the list, select the overlay that you want to print.

7 Click the [Edit] button under "Print in Overlay".

The Edit Print In Overlay dialog box appears.



8 Setting up the VXL/VPS driver (Windows Vista/Server 2008)

8-30 bizhub 362/282/222

8 Specify the overlay printing method.

– Pages to Print: Specifies the pages to print.
– Overwrite: Specifies the sequence for printing the overlay on top of 

the original document.

9 Click the [OK] button.

The Stamp/Composition tab appears again.

10 Click the [OK] button.

The Print dialog box appears again.

11 Click the [Print] button.

The printing of the overlay is performed.

Editing an overlay file

To use an overlay, an overlay file must be created and added to the overlay 
file list. You can create and save a new overlay file by selecting the "Create 
Overlay File" check box, specifying the document that you want to create as 
an overlay file, then clicking the [Print] button on the Print dialog box. To add 
an existing overlay file that was created to the list, specify the file.
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Creating an overlay file

1 Create the overlay file data using any application.

2 From the [File] menu, select "Print".

3 Select this machine in "Printer Name", and then click the [Properties] 
button or the [Preferences] button.

4 Click the Stamp/Composition tab.

5 Select the "Create Overlay File" check box.

6 Click the [OK] button.

The Print dialog box appears again.

7 Click the [Print] button.

The dialog box to save the overlay file appears.
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8 Specify the storage location for the overlay file, enter the file name in 
the "File Name" box, and then enter the overlay name or a comment in 
the "Overlay Name" text box.

9 Click the [Save] button.

Instead of executing a print, the overlay file is saved and is added to 
the list to be used for the next operation. The file extension is ".KFO".
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Registering an overlay file

1 Click the Stamp/Composition tab.

2 Click the [Edit] button under "Print in Overlay".

The Edit Print In Overlay dialog box appears.

3 Click the [Browse Files] button to open the overlay file.

The overlay file is added to the "Select Overlay File" list.

2
Note 

By clicking the [Delete] button in the Edit Print In Overlay dialog box, the 
selected overlay file can be deleted from the overlay file list. The file itself 
is not deleted.
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Printing the document number

When printing multiple copies, you can print the number of each document.

1 Click the Stamp/Composition tab.

2 Select the "Distribution Number Stamping" check box.

3 Click the [Edit] button under the "Distribution Number Stamping" check 
box.

The Editing the numbering dialog box appears.

4 Specify the format and location.

– Pages to Print: Specifies the pages where the numbering is to be 
printed.

– Starting Number: Specifies the starting number.
– Density: Specifies the density of the number being printed.

2
Note 

The "Distribution Number Stamping" check box is not available if the 
"Collate" check box is not specified on the Basic tab.

The "Distribution Number Stamping" function is only available with the 
Windows Vista/Server 2008 PCL driver (VXL).
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8.7 Specifying the Quality tab settings

Adjusting the quality

1 Click the Quality tab.

2 Specify settings for the following:

Item Function

Resolution Specifies the print resolution. (The resolution cannot be changed on 
this machine.)

Pattern Select "Coarse" or "Fine" for the printing pattern.
This function is only available with the Windows Vista/Server 2008 
PCL driver (VXL).

Image Compression Specifies the compression ratio for an image.
This function is only available with the Windows Vista/Server 2008 
PCL driver (VXL).

Print with Black Specifies the data to be printed in black. Prints in black except the 
white areas.
This function is only available with the Windows Vista/Server 2008 
PCL driver (VXL).
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Font Settings

You can replace the TrueType fonts used in Windows with the printer fonts 
of this machine.

1 Click the Quality tab.

2 Click the [Font Settings] button.

3 Specify settings for the following:

– Download Font Format: Selects the TrueType font downloading 
method.

– Use Printer Fonts: Replaces the TrueType fonts with the printer 
fonts.

Konica Minolta PCL driver (VXL) for Windows Vista/Server 2008

Konica Minolta PostScript driver (VPS) for Windows Vista/Server 2008
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4 To use the printer fonts, change the fonts in "TrueType Font 
Substitution Table" as necessary.

– For the PCL driver (VXL) for Windows Vista/Server 2008, select the 
TrueType fonts you want to replace from the table drop-down list, 
and then select the printer font to be replaced from the "Printer Font 
to Use" drop-down list.

– For the PostScript driver (VPS) for Windows Vista/Server 2008, 
specify the font replacement list on the Configure tab.

2
Note 

Using the printer fonts will shorten the printing time, however, there may 
be a difference in the screen display and the print results.

By selecting the TrueType font download method from the "Download 
Font Format" drop-down list, you can select the TrueType font type to 
download when downloading the TrueType fonts and not using the 
printer fonts. When using TrueType fonts, select the font type to be 
downloaded to the printer.
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8.8 Specifying the Other tab settings

2
Note 

The "Excel Job Control" setting and the "Remove White Background" 
setting cannot be used with Windows Vista x64/Server 2008 x64.

The "Excel Job Control" setting can only be changed when the printer 
driver dialog box is displayed from the Printers window.

Item Function

Excel Job Control When printing multiple sheets in Microsoft Excel that have dif-
ferent page settings, the jobs may be separated by sheet de-
pending on the data. Select this function to control jobs so that 
they are not separated.

Remove White Background When printing an overlay file over Microsoft PowerPoint data, 
removes the white part so that the white background of the 
PowerPoint data does not conceal the overlay file. If this check 
box is cleared, the background is not removed and the job is 
printed according to the original document data.
This function is only available with the Windows Vista/Server 
2008 PCL driver (VXL).

Check Driver Version Displays the version information of the printer driver.
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8.9 Specifying the Configure tab settings

Selecting an option

The functions of this machine can be used from the printer driver if the 
installed options, and the user authentication and account track functions 
are specified.

2
Reminder 

If the installed options and the user authentication and account track 
functions are not specified on the Configure tab, the option functions 
cannot be used from the printer driver. When installing options or using 
the authentication function, be sure to make the proper settings.

1 Click the [Start] button, and then click "Control panel", "Hardware and 
Sound", and "Printers".

– If the control panel is in the classic view, double-click "Printers".

2 Right-click the icon of the installed printer, and then click "Properties".

3 Click the Configure tab.

4 Select the options to be specified under "Device Option".

5 Select the status of the option that is installed from the "Setting" drop-
down list.
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2
Note 

Click the [Acquire Device Information] button to communicate with this 
machine and read the status of the settings specified on this machine. 
You cannot use this function if you are not connected to or able to 
communicate with this machine. The connection can be specified by 
clicking the [Acquire Settings] button.

Starting up a software tool

You can start up tools such as PageScope Web Connection that can be used 
by this machine.

1 Click the Configure tab.

2 From the "Software Tools" drop-down list, select the function.

3 Click the [Start] button.



Setting up the VXL/VPS driver (Windows Vista/Server 2008) 8

bizhub 362/282/222 8-41

8.10 Specifying the Settings tab settings
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Specifying the default settings

You can change the default settings for displaying the confirmation 
messages or the dialog box for entering the authentication settings.

1 Click the [Start] button, and then click "Control panel", "Hardware and 
Sound", and "Printers".

– If the control panel is in the classic view, double-click "Printers".

2 Right-click the icon of the installed printer, and then click "Properties".

3 Click the Settings tab.

4 Specify settings for the following:

– EMF Spool: When using an original system environment, select this 
check box if a metafile (EMF) spool is required. This function is only 
available with the Windows Vista/Server 2008 PCL driver (VXL).

– Display Constraint Message: Specifies whether to display a 
message when functions that cannot be specified at the same time 
were enabled from the printer driver.

– Display paper set in Print Server Properties: Specifies whether to 
use the paper that was added in [Server Properties] of the printer 
folder. 

– Popup Authentication Dialog when printing: Displays the User 
Authentication/Account Track dialog box when a print job is 
specified to enter a user name or a department name.
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Registering custom paper sizes

You can register the custom paper sizes that you use often. The paper 
registered is shown in the paper size list and can be selected like the other 
paper sizes.

1 Click the Settings tab.

2 Click the [Save Custom Size] button.

The Save Custom Size dialog box appears.

3 Click the [Add] button.

The new paper size is added to "List of Custom Size".

4 Specify the paper name and size.

5 Click the [OK] button.
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2
Note 

Up to 10 custom paper sizes can be registered.

Up to 16 characters can be entered in the "Paper Name" text box.

From the Save Custom Size dialog box, the selected custom paper size 
can be deleted by clicking the [Delete] button. To edit a custom paper 
size, select the custom paper size and change the paper name and paper 
size.

The "Save Custom Size" function is only available with the Windows 
Vista/Server 2008 PCL driver (VXL).
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8.11 Saving the driver settings

You can save the setting values of the changed driver and recall them as 
necessary.

Saving the driver settings

1 Change the driver settings from the Basic tab and the Layout tab.

2 Click the [Add] button next to the "Favorite Setting" drop-down list.
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3 Specify settings for the following:

– Name: Enters the specified registration name.
– Icon: Specifies the icon. The settings can be registered even if the 

icon is not specified. 
– Sharing: Specifies whether to register the specified file as public or 

private.
– Comment: Enters the detailed description of the specified file, if 

necessary.

4 Click the [OK] button.

The specified settings are registered in the "Favorite Setting" drop-
down list.

2
Note 

Up to 30 shared settings and up to 20 private settings can be registered.

Up to 30 characters can be entered in the "Name" text box. Up to 255 
characters can be entered in the "Comment" text box.

Only the administrator can select a setting under "Sharing".

The settings that were specified can also be saved (exported) to a file. For 
details, refer to "Importing and exporting the driver settings" on 
page 8-49.
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Recalling the settings

You can select the settings to recall from the "Favorite Setting" drop-down 
list on the Printing Preferences dialog box.

The setting values are recalled, and the settings for the printer driver are 
changed.

Editing the settings

You can edit the recalled function items such as the specified names and 
comments. 

1 In the Printing Preferences dialog box, click the [Edit] button next to the 
"Favorite Setting" drop-down list.

2 From the list, select the specified name that you want to change, and 
then change the setting.
To delete a setting, click the [Delete] button.
To switch the order displayed, click the [Up] button or the [Down] 
button.
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3 Click the [Option] button, select the check box of the function that you 
want to recall, and then click the [OK] button.

4 Click the [OK] button.

2
Note 

The specified settings of the driver functions cannot be changed.

The "Per Page Setting" function is only available with the Windows 
Vista/Server 2008 PCL driver (VXL).
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Importing and exporting the driver settings

You can also save (export) or read (import) the settings that were specified 
to a file. This comes in handy when you want to use the same settings on 
another computer.

1 In the Printing Preferences dialog box, click the [Edit] button next to the 
"Favorite Setting" drop-down list.

2 From the list, select the specified name that you want to export, and 
then click the [Export] button.

The dialog box to save the specified file appears.

3 Specify the location to save the file and enter the file name.

4 Click the [Save] button.

The specified file is created. The file extension is ".KSF".

2
Note 

To read the specified file that was saved in the "Favorite Setting" drop-
down list, click the [Import] button and specify the file.
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9 Setting up the PPD driver (Mac OS 9.2)

9.1 Settings

The functions of this machine can be specified on the Page Setup and Print 
dialog boxes displayed from an application.

The settings can only be applied while using the application. When the 
application is exited, the settings return to their defaults.

Page Setup dialog box
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Page Setup items

2
Note 

Depending on the application, "Page Setup" may be displayed as "Paper 
Setup". In addition, you may have to select "Paper Setup"—"Options" 
from the "File" menu.

The dialog boxes differ depending on the application.

Menu Item Function

Page Attributes Paper Specifies the paper size.

Orientation Specifies the orientation.

Scale Specifies the enlargement and reduction ratio.

PostScript Op-
tions

Flip Horizontal Prints the image flipped horizontally.

Flip Vertical Prints the image flipped vertically.

Invert Image Prints a negative image.

Substitute Fonts Replaces some fonts with printer fonts.

Smooth Text Smooths text data.

Smooth Graphics Smooths graphic data.

Precision Bitmap 
Alignment

Corrects jagged graphic images.

Unlimited Download-
able Fonts

Does not limit downloading screen fonts.

Custom Page Siz-
es

Paper Size Specifies any paper size.

Margins Specifies the paper margins.

Custom Page Size 
Name

Enters the registered name for the specified paper 
size and margin after the [OK] button is clicked.

Units Selects the specified unit.
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Print dialog box

Print items

Menu Item Function

General Copies Specifies the number of copies to print.

Collated Prints multiple copies in sets.

Pages Specifies the print range to print.

Paper Source Selects the input tray.

Color Matching Print Color Specifies the color for printing.

Intent Selects the matching method.

Printer Profile Specifies the color adjustment profile of the out-
put device.

Background Print-
ing

Print in Specifies background printing.

Print Time Specifies the priority level and print time.

Save as File Format Specifies the PostScript file output format.

PostScript Level Specifies the PostScript level.

Data Format Specifies the format to save a document.

Font Inclusion Specifies whether to include the font data on a 
file.

Font Settings Font Documentation Adds information to the font key.

Font Downloading Specifies the conditions to download fonts.



9 Setting up the PPD driver (Mac OS 9.2)

9-6 bizhub 362/282/222

2
Note 

The dialog boxes differ depending on the application.

Layout Pages per sheet Specifies the number of pages to print on one 
page.

Layout direction Specifies the page order for printing multiple pag-
es on one page.

Border Specifies the borders around pages.

Job Logging If there is a PostScript 
error

Specifies the PostScript error report conditions.

Job Documentation Specifies the conditions for the operation record 
to be saved.

Job Documentation 
Folder

Specifies the folder to which the operation record 
is to be saved.

Cover Page Print Cover Page Attaches a cover.

Cover Page Paper 
Source

Selects the cover input tray.

Finishing Options 
1

Offset Specifies offset.

Output Tray Selects the output tray.

Binding Position Specifies the binding position.

Duplex Performs duplex printing.

Combination Specifies booklet printing.

Staple Performs stapling.

Hole-Punch Performs hole punching.

Finishing Options 
2

Center Staple and 
Fold

Folds the printouts in half and staples.

Front Cover Page Attaches a front cover page.

Back Cover Page Attaches a back cover page.

Paper Tray 
(Cover Page)

Selects the input tray for the front cover page and 
back cover page.

Transparency Inter-
leave

Inserts interleaves between overhead projector 
transparencies.

Paper Tray (Transpar-
ency Interleave)

Selects the input tray for the transparency inter-
leaves.

Wait Mode Stops printing temporarily after part of the docu-
ment has been printed so that the proof print can 
be checked.

Finishing Options 
3

Resolution Specifies the print resolution.

Menu Item Function
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9.2 Page Setup

Page Attributes (basic settings)

1 Select "Page Setup" or "Paper Setup" from the "File" menu.

2 Select "Page Attributes".

3 Specify settings for the following:

– Paper: Specify the paper size.
– Orientation: Specify the orientation.
– Scale: Specify the enlargement and reduction ratio.
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2
Note 

The folding function can be selected from the screen that is displayed 
when "Layout" is selected in the Print dialog box.

Custom Page Sizes

1 Select "Page Setup" or "Paper Setup" from the "File" menu.

2 Select "Custom Paper Sizes".

3 Click the [New] button.

4 Specify settings for the following:

– Paper Size: Specifies the paper size.
– Margins: Specifies the paper margins.
– Custom Page Size Name: Enter the registered name for the 

specified paper size and margins, and then click the [OK] button.
– Units: Selects the specified unit.

5 Click the [OK] button.

This registers the custom page settings which allows you to select the 
paper in the screen that appears when "Page Attributes" is selected.
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PostScript Options

1 Select "Page Setup" or "Paper Setup" from the "File" menu.

2 Select "PostScript Options".

3 Specify settings for the following:

– Visual Effects: Provides "Flip Horizontal", "Flip Vertical", and "Invert 
Image" (negative image).

– Substitute Fonts: Replaces some fonts with printer fonts.
– Smooth Text: Smooths text data.
– Smooth Graphics: Smooths graphic data.
– Precision Bitmap Alignment: Corrects jagged graphic images.
– Unlimited Downloadable Fonts: Does not limit downloading screen 

fonts.
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9.3 Printing

General (basic settings)

1 From the "File" menu, select "Print".

2 Select "General".

3 Specify settings for the following:

– Copies: Specifies the number of copies to print.
– Collated: Prints multiple copies in sets.
– Pages: Specifies the print range to print.
– Paper Source: Selects the input tray.
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2
Note 

The settings specified on this machine have precedence if multiple 
copies are specified in "Default Set" of this machine.

Layout (printing multiple pages on one page)

You can specify printing multiple pages on one page of paper or duplex 
printing.

1 From the "File" menu, select "Print".

2 Select "Layout".

3 Specify settings for the following:

– Pages per sheet: Specifies the number of pages to print on one 
page.

– Layout direction: Specifies the document page order.
– Border: Specifies the borders around pages.
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Printer specific options (finishing options 1 to 3)

You can specify printer-specific options. You can specify these options 
when using the staple or hole punch functions of this machine.

1 From the "File" menu, select "Print".

2 Select "Finishing Options 1 to 3".

3 Specify settings for the following:

– Offset: Specifies offset.
– Output Tray: Selects the output tray.
– Binding Position: Specifies the binding position.
– Duplex: Performs duplex printing.
– Combination: Specifies booklet printing.
– Staple: Performs stapling.
– Hole-Punch: Performs hole punching.
– Center Staple and Fold: Folds the printouts in half and staples.
– Front Cover Page: Attaches a front cover page.
– Back Cover Page: Attaches a back cover page.
– Paper Tray (Cover Page): Selects the input tray for the front cover 

page and back cover page.
– Transparency Interleave: Inserts interleaves between overhead 

projector transparencies.
– Paper Tray (Transparency Interleave): Selects the input tray for the 

transparency interleaves.
– Wait Mode: Stops printing temporarily after part of the document 

has been printed so that the proof print can be checked.
– Resolution: Specifies the resolution.
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2
Note 

The Center Staple and Fold function is only available when the optional 
finisher and saddle kit are installed.

The staple function is available only when optional finisher is installed.

The hole punch function is available only when punch unit is installed on 
optional finisher.

You cannot specify settings in "Back Cover Page" only. Specify settings 
in "Back Cover Page" and "Front Cover Page" at the same time.
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9.4 Specifying options

You can specify the options installed on this machine so that they can be 
used from the printer driver.

2
Reminder 

If the installed options on this machine are not set from "Options Installed 
1" or "Options Installed 2", the option function cannot be used with the 
printer driver. When installing options, be sure to make the proper 
settings.

To specify options

1 On the Apple menu, click "Chooser".

2 Select the printer name.

3 Click the [Setup] button.

4 Click the [Configure] button

The setting screen for adding options appears.

5 Select the option that is installed on this machine from "Options 
Installed 1" and "Options Installed 2".

6 Click the [OK] button.

The Chooser window appears again.

7 Close the Chooser window.
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2
Note 

The option settings are displayed automatically the first time the printer 
driver is selected. For details, refer to "Selecting a printer" on page 3-23.
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10 Setting up the PPD driver (Mac OS X)

10.1 Settings

The functions of this machine can be specified on the "Page Setup" and 
"Print" dialog boxes recalled from the application.

The settings can only be applied while using the application. When the 
application is exited, the settings return to their defaults.

Page Setup dialog box

Page Setup items

Menu Item Function

Page Attributes Paper Size Specifies the paper size.

Orientation Specifies the orientation.

Scale Specifies the enlargement and reduction ratio.

Custom Page Size Paper Size Specifies any paper size.

Printer Margins Specifies the paper margins.
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2
Note 

Depending on the application, "Page Setup" may be displayed as "Paper 
Setup". In addition, you may have to select "Paper Setup"—"Options" 
from the "File" menu.

The dialog boxes differ depending on the application.

To specify the "Custom Paper Size" settings for Mac OS X 10.4 and Mac 
OS X 10.5, select "Manage Custom Sizes" from the "Paper Size" drop-
down list.

Print dialog box

Print items

Menu Item Function

Copies & Pages Copies Specifies the number of copies to print.

Collated Do not select the "Collated" check box. Specify 
this setting in the sort function.

Pages Specifies the print range to print.

Layout Pages per Sheet Specifies the number of pages to print on one 
page.

Layout Direction Specifies the page order for printing multiple pag-
es on one page.

Border Specifies the borders around pages.

Output Options*2 Save as File Specifies the output format of a file.

Format Specifies the format of the file being output.
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Scheduler*1 Print Document Specifies the print time.

Priority Specify the priority level.

Paper Handling*1 Reverse page order 
(Page Order)

Prints pages in the reverse order.

Print Specifies the pages for printing.

Destination paper 
size *3

Specifies the output paper size.

ColorSync*1 Color Conversion Specifies the color conversion method.

Quartz Filter Specifies the color for printing.

Cover Page*1 Print Cover Page Specifies whether to attach a cover page.

Cover Page Type Selects to print "Confidential" or other comments 
on the cover page.

Error Handling Billing Info Enters the user information used for the account 
calculation.

PostScript Error is Specifies whether to print an error report when a 
PostScript error occurs.

Paper Feed Tray Switching Switches the paper source tray (this function can-
not be selected on this machine).

All pages from Selects the input tray.

First page from Selects the input tray.

Remaining from Selects the input tray.

Setup Paper Type Selects the paper type (this function cannot be se-
lected on this machine).

Front Cover Page Attaches a front cover page.

Back Cover Page Attaches a back cover page.

Paper Tray (Cover 
Page)

Selects the input tray for the front cover page and 
back cover page.

Transparency Inter-
leave

Inserts interleaves between overhead projector 
transparencies.

Paper Tray (Transpar-
ency Interleave)

Selects the input tray for the transparency inter-
leaves.

Menu Item Function
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2
Note 

The dialog boxes differ depending on the application.

The items indicated by "*1" are displayed in Mac OS X 10.3, Mac OS X 
10.4 and Mac OS X 10.5.
The items indicated by "*2" are displayed only in Mac OS X 10.3.
The items indicated by "*3" are displayed only in Mac OS X 10.4 and Mac 
OS X 10.5.

Finishing Collate Prints multiple copies in sets.

Offset Specifies offset.

Duplex Performs duplex printing.

Output Tray Selects the output tray.

Binding Position Specifies the binding position.

Combination Specifies booklet printing.

Staple Performs stapling.

Hole-Punch Performs hole punching.

Center Staple and 
Fold

Folds the printouts in half and staples.

Security Output Method Specifies output methods, such as "Secure Print" 
and "Save in User Box".

Secure Print Settings Specifies user ID and password for "Secure 
Print".

Save in User Box Set-
tings

Specifies the file name and box name for "Save in 
User Box".

User Authentication Checks if using user authentication and specifies 
user name and password.

Account Track Checks if account track settings have been ap-
plied and specifies the account name and pass-
word.

Menu Item Function
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10.2 Page Setup

Page Attributes (basic settings)

1 Select "Page Setup" or "Paper Setup" from the "File" menu.

2 Select "Page Attributes".

3 Specify settings for the following:

– Paper Size: Specifies the paper size.
– Orientation: Specify the orientation.
– Scale: Specify the enlargement and reduction ratio.
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Custom Page Size

1 Select "Page Setup" or "Paper Setup" from the "File" menu.

2 For Mac OS X 10.3, select "Custom Paper Size" from Settings.

– For Mac OS X 10.4 and Mac OS X 10.5, select "Manage Custom 
Sizes" from the Paper Size list.

3 Click the [New] button (Mac OS X 10.3) or the [+] button (Mac OS X 10.4 
and Mac OS X 10.5).

4 Enter the paper size name.

5 Specify settings for the following:

– Paper Size: Specifies any paper size.
– Printer Margins: Specifies the paper margins.

6 For Mac OS X 10.3, click the [Save] button.

– For Mac OS X 10.4 and Mac OS X 10.5, proceed to step 7.

7 Click the [OK] button.

This registers the custom paper size which allows you to select the 
paper size in the screen that appears when "Page Attributes" is 
selected.
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10.3 Printing

Copies & Pages (Standard settings)

1 From the "File" menu, select "Print".

2 Select "Copies & Pages".

3 Specify settings for the following:

– Copies: Specifies the number of copies to print.
– Collated: Do not select the "Collate" check box. Specify this setting 

in the sort function.
– Pages: Specifies the print range to print.
– Paper Size: Specifies the paper size. (Mac OS X 10.5 only)
– Orientation: Specify the orientation. (Mac OS X 10.5 only)
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2
Note 

The settings specified on this machine have precedence if multiple 
copies are specified in "Default Set" of this machine.

Layout (printing multiple pages on one page)

You can print multiple pages on one page.

1 From the "File" menu, select "Print".

2 Select "Layout".

3 Specify settings for the following:

– Pages per Sheet: Specifies the number of pages to print on one 
page.

– Layout Direction: Specifies the page order for printing multiple 
pages on one page.

– Border: Specifies the borders around pages.
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Paper Feed

You can specify the input tray for printing.

1 From the "File" menu, select "Print".

2 Select "Paper Feed".

3 Specify settings for the following:

– All pages from: Selects the input tray to print all pages.
– First page from: Selects the input tray to print the first page.
– Remaining from: Selects the input tray to print from the second 

page.
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Setup

You can specify the cover page settings.

1 From the "File" menu, select "Print".

2 Select "Setup".

3 Specify settings for the following:

– Paper Type: Selects the paper type.
– Front Cover Page: Attaches a front cover page.
– Back Cover Page: Attaches a back cover page.
– Paper Tray (Cover Page): Selects the input tray for the front cover 

page and back cover page.
– Transparency Interleave: Inserts interleaves between overhead 

projector transparencies.
– Paper Tray (Transparency Interleave): Selects the input tray for the 

transparency interleaves.

You cannot specify settings in "Back Cover Page" only. Specify 
settings in "Back Cover Page" and "Front Cover Page" at the same 
time.
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Finishing

You can specify these options when using the staple or hole punch finisher 
functions of this machine.

1 From the "File" menu, select "Print".

2 Select "Finishing".

3 Specify settings for the following:

– Collate: Prints multiple copies in sets.
– Offset: Specifies offset.
– Duplex: Performs duplex printing.
– Output Tray: Selects the output tray.
– Binding Position: Specifies the binding position.
– Combination: Specifies booklet printing.
– Staple: Performs stapling.
– Hole-Punch: Performs hole punching.
– Center Staple and Fold: Folds the printouts in half and staples.
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2
Note 

The Center Staple and Fold function is only available when the optional 
finisher and saddle kit are installed.

The staple function is available only when optional finisher is installed.

The hole punch function is available only when punch unit is installed on 
optional finisher.
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Security

Not only can you print directly, but you can select "Secure Print", which 
requires a password to print, "Save in User Box", which saves documents in 
the document folder, "Proof and Print", which prints the first set of multiple 
copies and temporarily stops printing, "User Authentication", which requires 
user authentication, and "Account Track", which manages the number of 
printed pages.

The Save in User Box function can only be used when an optional hard disk 
is installed.

1 From the "File" menu, select "Print".

2 Select "Security".

3 Specify settings for the following:

– Output Method: Specifies conditions for "Secure Print" and "Save 
in User Box".

– Secure Print Settings: Enters ID and password when "Secure Print" 
is selected from the "Output Method" drop-down list. Enter the ID 
and password on this machine’s control panel when printing.

– Save in User Box Settings: Enters the file name and box number 
when "Save in User Box" or "Save in User Box and Print" is 
selected from the "Output Method" drop-down list.

– User Authentication: Enters the user name and password when 
user authentication settings have been applied on this machine and 
when the check box is selected.

– Account Track: Enters the access name and password when the 
account track settings have been applied on this machine and 
when the check box is selected.
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!
Detail 

If a print job is sent using a user name or password that is not a registered 
account on this machine or if a job is sent without the "User 
Authentication" check box selected, this machine cannot authenticate 
the operation and cannot print. When this occurs, the sent job is deleted.

Up to 8 characters (alphanumeric characters, spaces, and symbols !# $ 
% & ' ~ = \ | ; : * ` / ? @ _ - . , ( ) [ ] { } < >) can be entered in the "Secure 
Print ID" and "Password" text boxes.

If a print job is sent using a department name or password that is not a 
registered account or if a job is sent without the "Track Account" check 
box selected, this machine cannot authenticate the operation and cannot 
print. When this occurs, the sent job is deleted.

The file name for Save in User Box is displayed when the document is 
selected on this machine’s control panel. Up to 30 characters 
(alphanumeric characters, spaces, and symbols !# $ % & ' ~ = \ | ; : * ` / ? 
@ _ - . , ( ) [ ] { } < >) can be entered in the "File Name" text box. Be sure 
to enter a user-friendly file name.
In User Box Number, specify the number of the box that was created. For 
public boxes, enter "1".

When user authentication is specified on this machine and the Enhance 
Security mode is enabled or when Access Lock is enabled on the 
software DIP switch, the corresponding user may be locked out and 
denied access if the authentication information is not entered correctly.

When performing user authentication on the machine and Synchronize is 
specified, you can print by inputting the user name and password in User 
Authentication.

For details on user authentication and Enhance Security mode, refer to 
User manual [Copy Operations].
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!
Detail 

Print the document from the control panel of this machine. For details, 
refer to "Print job management" on page 11-82.

Proof and Print can be specified when "Collated" is specified.

When a password rule is enabled on this machine, passwords that are 
usable in Secure Print are limited and jobs are deleted when a password 
that does not meet the password rule is entered. For the password rules, 
refer to User manual [Copy Operations].

For details on the box functions of this machine, refer to User manual 
[Box Operations].
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10.4 Specifying options

You can specify the options installed on this machine so that they can be 
used from the printer driver.

2
Reminder 

If the installed options on this machine are not set from "Printer Info", the 
option function cannot be used with the printer driver. When installing 
options, be sure to make the proper settings.

Specifying options

1 Open the "Print & Fax", "Printer Setup Utility" or "Print Center" screen.

– For Mac OS X 10.5, open the "Print & Fax" screen from "System 
Preferences" of the "Apple" menu.

– For Mac OS X 10.2/10.3/10.4, open the "Printer Setup Utility" or 
"Print Center" screen located in "Applications"-"Utilities" of "Hard 
Disk".

2 Display the "Printer Info".

– For Mac OS X 10.5, click the [Options & Supplies] button.
– For Mac OS X 10.2/10.3/10.4, select "Show Info" from the "Printer" 

menu.

3 Display the "Installable Options".

– For Mac OS X 10.5, click the [Driver] button.
– For Mac OS X 10.2/10.3/10.4, select "Installable Options".
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4 Select the options that are installed on this machine.

5 Click the [OK] button, the [Apply Changes] button or [ ], to close the 
Printer Info dialog box.
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10.5 Saving the driver settings

For Mac OS X drivers, you can save the setting values of the changed driver 
and recall them as necessary.

Saving the driver settings

1 Change the driver settings in "Copies & Pages" and "Layout".

2 From "Presets", click "Save As".

3 Enter the preset name in "Save Preset As".

4 Click the [OK] button.

The settings are registered in the preset settings.
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Restoring the settings

% Select "Presets" from the Print dialog box to recall the settings.
The setting values are recalled, and the printer driver dialog box 
appears again.

Changing the settings

1 Select "Presets" from the Print dialog box to change the settings.

2 Change the driver settings in "Copies & Pages" and "Layout".

3 From "Presets", click "Save".

To delete, click "Delete". To change the name, click "Rename".
The preset settings are changed.
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11 Various settings

11.1 Printer settings on the control panel

You can change the various printer settings on this machine’s control panel.

Printer settings

To display the Printer Setting screen

1 Press the [Utility/Counter] key.

2 Touch [Printer Setting].

3 Touch the desired setting button.

The setting screen of the desired 
setting appears.

Utility/
Counter
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4 Specify settings for the following:

2
Note 

To quit specifying the printer settings, touch [Enter] until the screen for 
the Copy, Fax, Scan, or Box mode appears.
The default screens are shown below and each setting can be specified.

MFP Set screen Default Set screen

PDL Set screen Test Print screen

Font screenBasic Setting screen
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MFP Set

!
Detail 

For details on displaying the MFP Set screen, refer to "Printer settings" 
on page 11-3.

Proof-Print Hold Time

The print data is deleted if the set time is not specified for printing the data. 
You can specify to print data that is being held in 10, 20, or 30 minutes. 
(Default setting: 10 min.)

% After changing the setting, touch 
[Enter].

Overwrite A4 <-> Letter

You can substitute letter size and 11e17-inch size with A4 or A3 size paper. 
When letter size paper is not loaded and letter size paper has been specified 
to print, you can print on A4 size paper, which is close in size to letter size 
paper, and not cause an error. (Default setting: OFF)

% After changing the setting, touch 
[Enter].
– ON: Substitutes letter size paper 

for A4 size paper when A4 size 
paper is not available. 
Substitutes 11e17-inch size 
paper with A3 size paper when 
11e17-inch size paper is not 
available.

– OFF: Does not substitutes letter 
size or 11e17-inch size paper with other paper sizes even when 
letter size or 11e17-inch size paper are not available.
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Document Hold Time

You can specify the minutes until a job that is being received is deleted when 
the memory has exceeded capacity when spooling. (Default setting: 5 M.)

% After using the keypad to type in a 
value, touch [Enter].
– 0to30: Specifies the time in which 

to delete the data.

2
Note 

If a value outside of the allowable range is specified, the setting cannot 
be changed even when [Enter] is touched. Type in a value within the 
allowable range.

To cancel changes to the settings, touch [Cancel].

PostScript Error Report

You can specify whether to print the error message when an error occurs 
during PS rasterization. (Default setting: OFF)

% After changing the setting, touch 
[Enter].
– ON: Prints the error message.
– OFF: Does not print the error 

message.
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Default Set

In Default Set you can specify the settings for "Basic" and "Font".

!
Detail 

For details on displaying the Default Set screen, refer to "Printer settings" 
on page 11-3.

Basic Setting - Tray

You can specify the input tray to use when none has been specified. (Default 
setting: Auto Paper Select)

% On the Basic Setting screen, touch 
[Tray] to display the setting screen. 
After changing the setting, touch 
[Enter].

Basic Setting - Paper Size

You can specify the paper size to use when no setting has been specified. 
(Default setting: Letter)

% On the Basic Setting screen, touch 
[Paper Size] to display the setting 
screen. After changing the setting, 
touch [Enter].

2
Note 

When selecting [8K], [16K], [envDL], or [env Monarch], you can only 
specify the paper size even when "envDL", "env Monarch", or "Postcard" 
has been selected. You cannot specify envelops and thick paper as a 
paper type. Touch [Others Sizes].
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Basic Setting - Original Direction

You can specify the orientation of the printed image when none has been 
specified. (Default setting: Portrait)

% On the Basic Setting screen, touch 
[Original Direction] to display the 
setting screen. After changing the 
setting, touch [Enter].
– Portrait: Prints the image 

vertically on the page.
– Landscape: Prints the image 

horizontally on the page.

Basic Setting - Print Method

You can specify whether to perform duplex printing when the print method 
has not been specified. (Default setting: Simplex)

% On the Basic Setting screen, touch 
[Print Method] to display the setting 
screen. After changing the setting, 
touch [Enter].
– 2-Sided Print: Performs duplex 

printing. You can select the 
binding orientation.

– Simplex: Performs simplex 
printing.
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Basic Setting - Sets

You can specify the number of copies to print when no setting has been 
specified. (Default setting: 1 Set)

% On the Basic Setting screen, touch [# 
of Sets] to display the setting screen. 
After using the keypad to type in a 
value, touch [Enter].

!
Detail 

For the PPD driver, the settings specified on this machine have 
precedence if multiple copies are specified in "Default Set - Basic Setting 
- # of Sets" of this machine.

2
Note 

A value outside the allowable range cannot be specified. Type in a value 
within the allowable range.

To cancel changes to the settings, touch [Cancel].
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Font - Font #

You can specify the font to use when none has been specified. (Default 
setting: 0)

% On the Font screen, touch [Font #] to 
display the setting screen. After 
using the keypad to type in a value, 
touch [Enter].

2
Note 

A value outside the allowable range cannot be specified. Type in a value 
within the allowable range.

To cancel changes to the settings, touch [Cancel].
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Font list

No. Font No. Font

0 Courier 32 Arial Bold Italic

1 CG Times 33 Times New Roman

2 CG Times Bold 34 Times New Roman Bold

3 CG Times Italic 35 Times New Roman Italic

4 CG Times Bold Italic 36 Times New Roman Bold Italic

5 CG Omega 37 Helvetica

6 CG Omega Bold 38 Helvetica Bold

7 CG Omega Italic 39 Helvetica Oblique

8 CG Omega Bold Italic 40 Helvetica BoldOblique

9 Coronet 41 Helvetica Narrow

10 Clarendon Condensed 42 Helvetica Narrow Bold

11 Univers Medium 43 Helvetica Narrow Oblique

12 Univers Bold 44 Helvetica Narrow Bold Oblique

13 Univers Medium Italic 45 Palatino Roman

14 Univers Bold Italic 46 Palatino Bold

15 Univers Condensed Medium 47 Palatino Italic

16 Univers Condensed Bold 48 Palatino Bold Italic

17 Univers Condensed Medium Italic 49 ITC Avant Garde Gothic Book

18 Univers Condensed Bold Italic 50 ITC Avant Garde Gothic Demi

19 Antique Olive 51 ITC Avant Garde Gothic Book 
Oblique

20 Antique Olive Bold 52 ITC Avant Garde Gothic Demi 
Oblique

21 Antique Olive Italic 53 ITC Bookman Light

22 Garamond Antiqua 54 ITC Bookman Demi

23 Garamond Halbfett 55 ITC Bookman Light Italic

24 Garamond Kursiv 56 ITC Bookman Demi Italic

25 Garamond Kursiv Halbfett 57 New Century Schoolbook Roman

26 Marigold 58 New Century Schoolbook Bold

27 Albertus Medium 59 New Century Schoolbook Italic

28 Albertus Extra Bold 60 New Century Schoolbook Bold Ital-
ic

29 Arial 61 Times Roman

30 Arial Bold 62 Times Bold

31 Arial Italic 63 Times Italic
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Font - Symbol Set

You can specify the symbol set to use when none has been specified. (North 
American model default setting: 29, Other model default setting: 19)

% On the Font screen, touch [Symbol 
Set] to display the setting screen. 
After using the keypad to type in a 
value, touch [Enter].

2
Note 

A value outside the allowable range cannot be specified. Type in a value 
within the allowable range.

To cancel changes to the settings, touch [Cancel].

64 Times Bold Italic 73 Letter Gothic

65 ITC Zapf Chancery 74 Letter Gothic Bold

66 Symbol 75 Letter Gothic Italic

67 SymbolPS 76 CourierPS

68 Wingdings 77 CourierPS Bold

69 ITC Zapf Dingbats 78 CourierPS Oblique

70 Courier Bold 79 CourierPS Bold Oblique

71 Courier Italic 80 Line Printer

72 Courier Bold Italic

No. Font No. Font
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Symbol set list

No. Symbol set No. Symbol set

0 Desktop 18 PC-775

1 ISO 4: United Kingdom 19 PC-8, Code Page 437

2 ISO 6: Ascii 20 PC-850 Multilingual

3 ISO11: Swedish 21 PC-852 Latin 2

4 ISO15: Italian 22 PC-858 Multilingual

5 ISO17: Spanish 23 PC-8 Turkish

6 ISO21: German 24 PC-8 Danish/Norw

7 ISO60: Danish/Norw 25 PC-1004

8 ISO69: French 26 PI Font

9 ISO 8859/1 Latin 1 27 PS Math

10 ISO 8859/2 Latin 2 28 PS Text

11 ISO 8859/9 Latin 5 29 Roman-8

12 ISO 8859/10 Latin 6 30 Windows 3.0 Latin 1

13 ISO 8859/15 Latin 9 31 Windows Baltic

14 Legal 32 Windows 3.1 Latin 1

15 Math-8 33 Windows 3.1 Latin 2

16 MC Text 34 Windows 3.1 Latin 5

17 Microsoft Publishing 35 PC-866
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Font - Number Lines

You can specify the number of lines per page when no setting has been 
specified. (North American model default setting: 60 lines, Other model 
default setting: 64 lines)

% On the Font screen, touch [Number 
Lines] to display the setting screen. 
After using the keypad to type in a 
value, touch [Enter].

2
Note 

A value outside the allowable range cannot be specified. Type in a value 
within the allowable range.

To cancel changes to the settings, touch [Cancel].

Font - Font Size

You can specify the font size to use when none has been specified. (Default 
settings: Scalable Font - 12.00 point, Bit Map Font - 10.00 pitch)

% On the Font screen, touch [Font Size] 
to display the setting screen. Touch 
the font type name, type in the value 
using the keypad, and then touch 
[Enter].
– Scalable Font: Specifies the 

scalable font size in points.
– Bit Map Font Size: Specifies the 

bitmap font size in pitchs.

2
Note 

A value outside the allowable range cannot be specified. Type in a value 
within the allowable range.

To cancel changes to the settings, touch [Cancel].
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Font - CR/LF Mapping

You can specify the control code substitution method when printing test 
data. (Default setting: OFF)

% On the Font screen, touch [CR/LF 
Mapping] to display the setting 
screen. After changing the setting, 
touch [Enter].
– OFF: Does not perform 

substitution.
– Mode1: Substitutes CR for CR-

LF.
– Mode2: Substitutes LF for CR-

LF. Substitutes FF for CR-FF.
– Mode3: Substitutes CR and LF for CR-LF. 

Substitutes FF for CR-FF.

PDL Set

You can specify the PDL (Printer Description Language) setting. (Default 
setting: Auto)

% After changing the setting, touch 
[Enter].
– Auto: Automatically switches 

between PCL and PostScript.
– PCL: Only uses PCL.
– PostScript: Only uses PostScript.

!
Detail 

For details on displaying the PDL Setting screen, refer to "Printer 
settings" on page 11-3.
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Test Print

You can output the following four types of reports.

For details on displaying the Test Print screen, refer to "Printer settings" on 
page 11-3.

% Touch the button for the desired 
setting.
– Check Job Details: Outputs a list 

of this machine’s settings.
– PCL Demo Page: Outputs a test 

page.
– PCL Font List: Outputs the PCL 

font list.
– PS Font List: Outputs the PS font 

list.
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11.2 Administrator settings

Some printer function settings can only be changed by an administrator.

To display the Administrator Management setting screen

1 Press the [Utility/Counter] key.

2 Touch [Admin. Management].

3 Type in the password using the 
keypad, and then touch [Enter].

4 Touch [Admin. 2].

Utility/
Counter
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5 Touch [Printer Setting].

6 Specify settings for the following:

2
Note 

To quit specifying the printer settings, touch [Enter] until the screen for 
the Copy, Fax, Scan, or Box mode appears.

Printer Setting

!
Detail 

For details on displaying the Printer Setting screen, refer to 
"Administrator settings" on page 11-17.
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Parallel Setting

You can specify the mode for using an optional parallel interface. (Default 
setting: ECP)

% After changing the setting, touch 
[Enter].
– Compatible: Corresponds to 

both Nibble and ECP.
– Nibble: Only for Nibble.
– ECP: Only for ECP.

Timeout

You can set the time until a communication timeout occurs. (Default setting: 
300 sec)

% After using the keypad to type in a 
value, touch [Enter].

2
Note 

The time specified here for a timeout enables the parallel, USB, or 
network interface.

A value outside the allowable range cannot be specified. Type in a value 
within the allowable range.

To cancel changes to the settings, touch [Cancel].
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No Matching Paper in Tray Setting

You can select the process for when there 
is no matching paper in the specified input 
tray.
Tray Priority: Feeds paper from a different 
input tray.
Tray Fixed: Displays a warning message 
without printing. If paper is specified that 
cannot be loaded in the specified input 
tray, the job is deleted.

Setting the IP Address

When using this machine as a network printer, an IP address must be 
assigned to this machine.

!
Detail 

For the procedure to assign an IP address to this machine, refer to 
"Setting the IP address for this machine" on page 4-7.

Frame Type Set

If connecting with NetWare, the frame type must be specified depending on 
the network environment.

1 Press the [Utility/Counter] key on this machine’s control panel, touch 
[Admin. Management], and then enter the administrator password.

2 Touch [Admin. 2].

3 Touch [Network Settings].

– If the [Network Setting 1]/[Network Setting 2] selection screen 
appears, touch [Network Setting 1].

4 Touch [Frame Type Set].

5 After changing the setting, touch 
[Enter].
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Counter

You can check the total number of printed pages.

1 Press the [Utility/Counter] key on this machine’s control panel.

2 Touch [Check Detail] on the lower-right corner of the screen.

3 After checking each counter, touch 
[Exit].
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11.3 Specifying the status settings for the functions 
(Software SW)

By specifying the Software SW numeric values (mode, bit, HEX) according to 
the usage conditions of this machine, the status of each function can be 
changed.

2
Reminder 

Do not change any modes or bits other than those described in this 
manual.

2
Note 

When "Enhance Security" is set to "ON", the software switch settings 
cannot be changed.

Software SW

Item Description

Mode Represents the setting with a three-digit number. Type in the 
value using the keypad.

Bit An eight-digit number that configures the mode status. Specify 
the status of the function by specifying the bit for each number 
from 7 to 0 with a binary number (1 or 0).

HEX The status of each function is displayed by a combination of 
hexadecimal numbers (0 to 9, A to F). When Bit Selection is 
"00110000", HEX Selection can be represented as "30".
The status of the mode is specified in Bit Selection or HEX Se-
lection.
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An example of the Bit Selection (binary numbers) and HEX Selection 
(hexadecimal numbers) displays are shown below.

Decimal 

number

Bit Selection (binary number) HEX Selection (hexadecimal 

number)

0 0000 0000 00

1 0000 0001 01

2 0000 0010 02

3 0000 0011 03

4 0000 0100 04

5 0000 0101 05

6 0000 0110 06

7 0000 0111 07

8 0000 1000 08

9 0000 1001 09

10 0000 1010 0A

11 0000 1011 0B

12 0000 1100 0C

13 0000 1101 0D

14 0000 1110 0E

15 0000 1111 0F

16 0001 0000 10

17 0001 0001 11

18 0001 0010 12

19 0001 0011 13

20 0001 0100 14

.

.

.

.

.

.

.

.

.

252 1111 1100 FC

253 1111 1101 FD

254 1111 1110 FE

255 1111 1111 FF
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To change the software SW

1 Log on to the administrator mode, and then touch [Admin. 2].

– For details on displaying the Administrator Management 2 screen, 
refer to "Administrator settings" on page 11-17.

The Initial Settings screen appears.

2 Touch [Software SW].

3 Touch [Mode Selection], and then 
use the keypad to type in the mode 
number.
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4 Touch either [Bit Selection] or [HEX Selection], and then specify the 
setting.

– To specify Bit selection, touch 
[Bit Selection], touch  or  to 
move the cursor to the bit to be 
changed, type in the value using 
keypad, and then touch [Set] on 
the lower right of the screen.

– To specify Hex Selection, touch 
[HEX Selection], specify the value 
by using keypad and by touching 
[A] to [F], and then touch [Set] on 
the lower right of the screen.

5 To change the setting for a different mode, repeat steps 3 and 4.

6 Touch [Enter] on the upper right of the screen until the first screen 
appears.
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Specifying whether to enable Access Lock, the Secure Print selection 

method, or whether to enable a password rule (mode 469)

Specify whether to lock access if the password is entered incorrectly, specify 
the selection method to check a Secure Print, or specify whether to apply a 
password rule.

Settings at the time of purchase

Specifying the settings

The grayed out cells are the settings at the time of purchase. The reference 
pages for each function are shown in the far right column.

Bit 7 6 5 4 3 2 1 0

Setting 0 0 0 0 0 0 0 0 (HEX: 00)

Bit Description Setting Description Page 

Refer-

ence

7 Specify whether to 
lock access when a 
password (account 
track and administra-
tor passwords) is en-
tered incorrectly three 
times.

0 Does not lock access p. 11-92

1 Locks access

6 --------------------- 0 * Do not change this bit 
when specifying settings 
for this function.

----------

5 Specify the Secure 
Print selection meth-
od.

0 Specifies the ID and pass-
word, and displays the cor-
responding document list.

p. 11-90

1 Displays the document list 
with an ID and enters the 
password when specifying 
the operation.

4 For security, specify 
whether to apply a 
password rule.

0 Do not apply a password 
rule

p. 11-85

1 Apply a password rule

3, 2, 1, 0 --------------------- 0000 * Do not change these bits 
when specifying settings 
for this function.

----------
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2
Note 

For the Access Lock function, refer to User manual [Copy Operations].

If applying a password rule, the conditions that are required in the 
password are described below.
8 alphanumeric characters (only 8 alphanumeric character for the 
administrator password, and 8 alphanumeric characters or more for the 
user authentication user password)
Only passwords with the same characters are not allowed.

!
Detail 

Before enabling password rules, check that the administrator password 
complies with the rules. If the password does not comply with the rules, 
you will not be able to log on to the Administrator mode.

If enabling password rules, passwords that do not comply with the rules 
will not be accepted. Check that the following passwords comply with 
the rules.
User Authentication user password
Account Track password
Administrator and service password
Secured Print password
User Box password
For the password rules, refer to User manual [Copy Operations].
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Specifying the deleting method for [Del.] in input screens (mode 478)

Specify the deleting method for [Del.] in input screens.

Select whether the character at the cursor's position or the character to the 
left of the cursor is deleted.

Settings at time of purchase

Specifying the setting

The grayed out cells are the settings at the time of purchase.

2
Note 

North American model default setting: 1

Other model default setting: 0

Bit 7 6 5 4 3 2 1 0

Setting (North American model) 1 0 0 0 0 0 0 0 (HEX: 80)

Setting (Other model) 0 0 0 0 0 0 0 0 (HEX: 00)

Bit Description Setting Description Page Refer-

ence

7 Specify the deleting 
method for [Del.] in 
input screens.

0 Deletes the character at 
the cursor’s position

----------

1 Deletes the character to 
the left of the cursor

6, 5, 4, 3, 
2, 1, 0

----------------------- 0000000 * Do not change these bits 
when specifying settings 
for this function.

----------
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11.4 Using PageScope Web Connection

PageScope Web Connection is a device management utility supported by 
the HTTP server built into the printer controller.

Using a Web browser on a computer connected to the network, machine 
settings can be specified from PageScope Web Connection.

Operating environment

Item Operating environment

Network Ethernet TCP/IP

Computer application Web browser:
Windows NT 4.0
Microsoft Internet Explorer 4 or later
Netscape Navigator 4.73 or 7.0

Windows 2000
Microsoft Internet Explorer 5 or later
Netscape Navigator 7.0

Windows XP/Server 2003
Microsoft Internet Explorer 6 or later
Netscape Navigator 7.0

Windows Vista/Server 2008
Microsoft Internet Explorer 7 or later
Netscape Navigator 7.0

If using Microsoft Internet Explorer 5.5, use Service Pack 1 or 
later.
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Accessing PageScope Web Connection

PageScope Web Connection can be accessed directly from a Web browser.

1 Start up the Web browser.

2 In the Address bar, type the IP address of this machine, and then press 
the [Enter] key.

– http://<IP_address_for_this_machine>/
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/

!
Detail 

For the procedure to assign an IP address to this machine, refer to 
"Setting the IP address for this machine" on page 4-7.

2
Note 

When accessing with PageScope Web Connection, do not use a proxy 
server.
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When performing user authentication

When performing user authentication or external server authentication, the 
following screen appears. Input the user name and password, and then click 
the [Log-in] button.

2
Note 

When user authentication is specified on this machine and the Enhance 
Security mode is enabled or when Access Lock is enabled on the 
software DIP switch, the corresponding user may be locked out and 
denied access if the authentication information is not entered correctly.

For details on user authentication and Enhance Security mode, refer to 
User manual [Copy Operations].

For the user name and password, ask your network administrator.
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Page structure

The page that appears immediately after PageScope Web Connection is 
accessed is called the User mode page. All users can view this page.

2
Note 

By entering the administrator password and clicking the [Log-in] button, 
you can display the Administrator mode page. For details, refer to 
"Logging on to Administrator mode" on page 11-34.

The configuration of the PageScope Web Connection page is shown below.

1
2

3

7

4 5

6

8

9
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2
Note 

The User Box tab can only be displayed when an optional hard disk is 
installed.

The Scan tab is the Fax/Scan tab when the optional fax kit is installed.

No. Item Description

1 KONICA MINOLTA Logo Click the logo to go to the Konica Minolta Web site at 
the following URL.
http://konicaminolta.com

2 PageScope Web Connection 
Logo

Click the PageScope Web Connection logo to display 
the version information.

3 Administrator mode logon 
button

Click to log on to the Administrator mode.

4 Status Display Displays the status of this machine’s printer and scan-
ner sections using icons. Update the data by clicking 
the [Renew] button on the Web browser.

5 Message Display Displays the status of the problem/error and other error 
information if an error has occurred in this machine. Up-
date the data by clicking the [Renew] button on the Web 
browser.

6 Tab Displays the categories that can be controlled by Pag-
eScope Web Connection. The following tabs are dis-
played in User mode.
• System
• Job
• User Box
• Print
• Scan

7 Menus Lists the information and settings for the selected tab. 
The menus that appear vary depending on the tab that 
is selected.

8 Information and Settings Dis-
play

Displays the details of the item selected from the menu.

9 User authentication logoff but-
ton

Displayed when logged in to user authentication. Click 
to log off from user authentication.
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Logging on to Administrator mode

You can switch between User mode and Administrator mode. However, in 
order to specify system or network settings, you must be logged on to 
Administrator mode.

% Enter the administrator password for this machine in the "Admin 
Password" box, and then click the [Log-in] button.
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The Administrator mode page appears.

To return to User mode, click the [Log-out] button.

2
Reminder 

When logged on to Administrator mode, the machine’s control panel is 
locked and cannot be used.

Depending on the status of the machine, you may not be able to log on 
to Administrator mode.

When logged on to Administrator mode, if no operation is performed for 
10 minutes, a timeout occurs and you will automatically be legged off 
from Administrator mode.

2
Note 

When the Enhance Security mode is enabled or when Access Lock is 
enabled on the software DIP switch, the corresponding user may be 
locked out and denied access if the authentication information is not 
entered correctly.

For details on Enhance Security mode, refer to User manual [Copy 
Operations].



11 Various settings

11-36 bizhub 362/282/222

Web Browser Cache

The newest information may not appear on the PageScope Web Connection 
page because older versions of pages are saved for the Web browser. In 
addition, problems may occur when the cache is used.

When using PageScope Web Connection, disable the cache for the Web 
browser.

!
Detail 

The menus and commands may vary depending on the Web browser 
version. For details, refer to Help for the Web browser.

If the utility is used with the cache enabled and the Administrator mode 
was timed out, the timeout may appear even after the utility is accessed 
again. In addition, since the machine’s control panel remains locked and 
cannot be used, the machine must be restarted (the main power turned 
off, then on again). In order to avoid this problem, disable the cache.

For Internet Explorer

1 On the "Tools" menu, click "Internet Options".

2 On the General tab, click the [Settings] button under "Temporary 
Internet Files".

3 Select "Every visit to the page", and then click [OK].

For Netscape Navigator

1 On the "Edit" menu, click "Preferences".

2 In the "Category" box, click "Advanced", then "Cache".

3 Under "Compare the page in the cache to the page on the network", 
select "Every time I view the page".
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User mode

The User mode provides functions for checking and operating the machine 
on a user level. You can select from five tabs (System, Job, User Box, Print, 
or Scan).

2
Note 

The User Box tab can only be displayed when an optional hard disk is 
installed.

The Scan tab is the Fax/Scan tab when the optional fax kit is installed.

This manual describes the printer related functions. For the box and 
scanner functions of this machine, refer to User manual [Box Operations] 
and User manual [Network Scanner Operations].

System tab

On the System tab, information and settings concerning the system 
configuration of this machine are displayed.

System tab - Summary

On the System tab, click "Summary". In addition, this is the initial page that 
appears when you access http://<IP_address_for_this_machine>/ with your 
Web browser.
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The Summary page shows the current system configuration and status of 
this machine.

Item Description

Device Information This area uses graphics and text to show the configuration of op-
tions installed on this machine.
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System tab - Detail - Paper Tray

Click the System tab, click "Detail", and then click "Paper Tray" in the sub-
menu that appeared.

You can check the status of the paper trays of this machine.

Item Description

Tray Displays information for each item.

Paper Size

Paper Type

Paper
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System tab - Detail - Output Tray

Click the System tab, click "Detail", and then click "Output Tray" in the sub-
menu that appeared.

You can check the status of the output trays of this machine.

Item Description

Output Tray Displays the tray name and status of each installed tray.
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System tab - Detail - HDD

Click the System tab, click "Detail", and then click "HDD" in the sub-menu 
that appeared.

You can check the status of the hard disk of this machine.

2
Note 

"HDD" can only be displayed when an optional hard disk is installed.

Item Description

Total Displays the total size of the installed hard disk.

Used Displays the amount of space used by the system.

Remain Displays the amount of free hard disk space.
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System tab - Detail - Interface Information

Click the System tab, click "Detail", and then click "Interface Information" in 
the sub-menu that appeared.

You can check the interface information of this machine.

Item Description

Interface Information Displays the network information.

Local I/F Displays the local interface information.
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System tab - Detail - Consumables

Click the System tab, click "Detail", and then click "Consumables" in the 
sub-menu that appeared.

You can check the consumable information of this machine.

2
Note 

The status may not be displayed correctly if the consumables are not 
installed.

"Staple Cartridge", "Saddle Staple Cartridge 1", "Saddle Staple 
Cartridge 2", and "Dust Box" are displayed according to whether the 
optional finishers are installed.

Item Description

Toner Displays information for each item.

Developing Unit

PC Drum

Staple Cartridge

Saddle Staple Cartridge 1

Saddle Staple Cartridge 2

Dust Box
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System tab - Counter

Click the System tab, and then click "Counter" in the menu.

You can check the counters that this machine manages.

2
Note 

"Fax" can only be displayed when the optional fax kit is installed.

Item Description

Counter Displays the total of the output counter (copies, prints, scans, and 
faxes).

Copy/PC Print Displays each counter.

Scanner/Fax

Paper Total Counter Displays the output counter for each paper size.
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System tab - Online Assistance

Click the System tab, and then click "Online Assistance" in the menu.

You can check support information concerning the product.

Job tab

From the Job tab, you can check jobs managed by this machine.

Item Description

Contact Name Displays information for each item.

Contact Information

Product Help URL

Corporate URL

Supplies and Accesso-
ries

Online Manual URL
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Job tab - Job List

Click the Job tab, click "Job List" from the menu, and then select each 
function (print operations).

You can check jobs that have been printed, that are being printed, or that are 
queued to be printed.

Sample Print page

2
Note 

The job number that was assigned when the job was queued in this 
machine appears as the job number.

Item Description

Print Displays the print job list and details.

TX Displays the fax and scan transmission job list and details.

RX Displays the fax reception job list and details.
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Print tab

You can check the printer default settings and print various test prints.

Print tab - Default Settings

Click the Print tab, click "Default Settings" from the menu, and then select 
each setting classification (general and PCL).

If a print job is sent whose settings are not specified, the settings specified 
here are used for printing.

Sample General Settings page

Item Description

General Settings Displays information for each item.

PCL Settings

PS Settings
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Print tab - Test Print

Click the Print tab, and then click "Test Print" in the menu.

You can print various configuration information, the demo pages, and the 
font information. Select the report that you want to print, and then click the 
[Print] button.

2
Note 

When this machine is processing a job, you may not be able to output 
reports.

Item Description

Configuration Page Prints the various configuration information pages of this machine.

PCL Demo Page Prints a demo page.

PCL Font List Prints the font list that is used by PCL.

PS Font List Prints the font list that is used by PostScript.
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Administrator mode

In Administrator mode, you can specify the system settings for this machine. 
You can select five tabs (System, User Box, Print, Scan, or Network).

For details on logging on to Administrator mode, refer to "Logging on to 
Administrator mode" on page 11-34.

2
Note 

The User Box tab can only be displayed when an optional hard disk is 
installed.

The Scan tab is the Fax/Scan tab when the optional fax kit is installed.

This manual describes the printer related functions. For the box, scanner, 
and network functions of this machine, refer to User manual [Box 
Operations] and User manual [Network Scanner Operations].

Basic operation

1 Click a tab, and then select an item from the menu.

2 Specify settings for the displayed items. Either enter a setting directly 
or select one from the drop-down list.

3 Click the [Apply] button to apply the settings.
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System tab

On the System tab, information and settings concerning the system 
configuration of this machine are displayed.

System tab - User’s Choice - User’s Choice 1

Click the System tab, click "User’s Choice", and then click "User’s Choice 1" 
in the sub-menu that appeared.

You can specify the related settings for process a mixed document.

Item Description

Mixed Original Detection Specify whether to set the mixed original detection mode to the de-
fault value.



Various settings 11

bizhub 362/282/222 11-51

System tab - User’s Choice - User’s Choice 2

Click the System tab, click "User’s Choice", and then click "User’s Choice 2" 
in the sub-menu that appeared.

You can specify the paper priority settings.

Item Description

Default Setting Sim-
plex/Duplex

Specify the default settings of the original document/Copy mode.
When "Duplex" is the default value in the Copy mode, "1-Sided>>1-
Sided" is not displayed. For details, consult your technical repre-
sentative.

Auto Paper/Auto Zoom Specify the auto function to be used as the priority.

Default Print Paper When the auto paper function is not used, specify the input tray to 
be used as the priority.

Zoom Ratio for Combine 
Booklets

When the 2in1, 4in1, or booklet functions are used, specify whether 
to automatically enable a suitable zoom ratio.
On: The "4in1" zoom ratio is 0.500, and the "2in1" and "Booklet" 
zoom ratio is 0.707.
Off: Does not automatically specify the zoom ratio.
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System tab - User’s Choice - User’s Choice 3

Click the System tab, click "User’s Choice", and then click "User’s Choice 3" 
in the sub-menu that appeared.

You can specify the settings of the power saving function.

Item Description

Low Power Mode Specify the time until the low power function operates (input range: 
1-240 minutes).

Sleep Specify whether to enable the sleep function. This setting can only 
be specified when "Disable Sleep Mode" is specified as "Yes" in Ad-
ministrator Management-Administrator Settings.

Time Specify the time until the sleep function operates (input range: 1-240 
minutes).

LCD Back-Light OFF Specify the time until the function to turn the LCD backlight off op-
erates (input range: 1-240 minutes).

Auto Reset Specifies whether to enable the auto reset function.
When the Enhance Security mode is enabled on this machine, this 
setting cannot be specified.

Time Specify the time until the auto reset function operates and returns to 
the default setting.

Auto Reset when Ac-
count is changed

Specify whether to return to the default setting when the password 
is entered or the key counter is removed.
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2
Note 

For details on Enhance Security mode, refer to User manual [Copy 
Operations].

System tab - User’s Choice - User’s Choice 4

Click the System tab, click "User’s Choice", and then click "User’s Choice 4" 
in the sub-menu that appeared.

You can specify the layout and quality print settings.
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2
Note 

The staple function is displayed only when optional finisher is installed.

The hole punching function is displayed only when punch unit is installed.

Item Description

4-In-1 Copy Order Specify the page order when the 4-in-1 combination function is 
used.

Default 
Quali-
ty/Density 
Modes

Density Specify the default settings of the copy density.

Quality 
Type

Specify the default settings of the copy quality.

Default 
Copy 
Density 
Levels

For Auto 
Mode

Specify the auto default settings of the copy density.

For Manual 
Mode

Specify the manual default settings of the copy density.

Print Exposure Specify the print density.

Default 
Finishing 
Mode

Output 
Mode 
(Sort)

Specify the offset default setting.

Output 
Mode 
(Staple)

Specify the staple default setting.

Output 
Mode 
(Punch)

Specify the hole punching default setting.
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System tab - User’s Choice - User’s Choice 5

Click the System tab, click "User’s Choice", and then click "User’s Choice 5" 
in the sub-menu that appeared.

You can specify the output settings.

Item Description

Sort/Non-Sort Auto 
Change

You can specify whether to switch between the sorting and non-
sorting function according to the number of copies.

Output 
Tray Set-
tings

For FAX Specifies the output tray for data received by fax (port 1/2).

For FAX 
(Network)

You can specify the output tray for data received by a network.

For Copy You can specify the output tray for copies.

For Printer You can specify the print output tray from a computer.

Auto Paper Select for 
Small Original

You can specify whether to specify the input tray when the auto pa-
per settings have been specified and the original document set on 
the original document glass is A5 size or smaller, or when an original 
document has not been loaded.
On: Copies using the priority paper.
Off: Displays the input tray select screen.
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2
Note 

The display of the output tray function may differ according to the status 
of the installed options.

System tab - User’s Choice - User’s Choice 6

Click the System tab, click "User’s Choice", and then click "User’s Choice 6" 
in the sub-menu that appeared.

You can specify the default screen settings.

Item Description

Default LCD Screen Specifies the priority function screen.

Priority Mail Screen Specifies the priority function screen.

Priority Device Specifies the priority function.

Image Quality (ADF) Specifies the quality level of the ADF.
Mode 1: Suitable for copying light original documents such original 
documents written in pencil.
Mode 2: Suitable for standard original documents.
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2
Note 

The Priority Mail Screen tab is the Priority Fax Screen tab when the 
optional fax kit is installed.

System tab - Administrator Management - Date & Time Setting

Enter the time and date for this machine.

Item Description

Year Enter the year.

Month Enter the month.

Day Enter the day.

Hour Enter the time.

Min Enter the minutes.

Time Zone Specify the time difference from GMT.

D.S.T. Specify the daylight savings time.
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System tab - Administrator Management - Administrator Settings

Click the System tab, click "Administrator Management", and then click 
"Administrator Settings" in the sub-menu that appeared.

You can specify the usage condition settings for the user.

Item Description

Max. Copy Sets Specify whether to limit the number of copies that can be specified 
per job.

The number of copy sets 
per job

Specify the number of copies that can be specified per job (input 
range: 1-99).

Disable Sleep Mode Specify whether to permit the user to disable the sleep function in 
the user’s choice function.

Restrict One-Touch Edit-
ing

Specify whether to prohibit the one-touch registration specified by 
the user settings.
When the Enhance Security mode is enabled on this machine, this 
setting cannot be specified.

Activity Report E-mail 
Address

Specify the destination e-mail address for sending the activity re-
port.
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2
Note 

For details on Enhance Security mode, refer to User manual [Copy 
Operations].

System tab - Administrator Management - Account Data

When performing account track with this machine, the "Account Data" and 
"Account Counter 1-3" menus are displayed in "Administrator Management" 
on the System tab.

2
Note 

For details on the account track, refer to User manual [Copy Operations].

Item Description

Account Data Registers the account data (account name, password, print maxi-
mum value) to an account number.

Account Counter 1 Displays the total counter per account.

Account Counter 2

Account Counter 3
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System tab - Administrator Management - User Authentication

When performing user authentication with this machine, the "User 
Authentication", "User List", and "User Counter 1-3" menus are displayed in 
"Administrator Management" on the System tab.

Item Description

User Authentication Registers the user information (user name and password) to a user 
number.

User List Displays the registered users.

User Counter 1 Displays the total counter per user.

User Counter 2

User Counter 3
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2
Note 

For details on user authentication, refer to User manual [Copy 
Operations].

When performing user authentication on the machine and Synchronize is 
specified, the total is added up in the account counter and User Counter 
1 to 3 are not displayed. Check Account Counter 1 to 3.

System tab - Online Assistance

You can change the online support information. To display this information, 
click the System tab in the User mode, then click "Online Assistance".

Item Description

Contact Name Specify information for each item.

Contact Information

Product Help URL

Corporate URL

Supplies and Accesso-
ries

Online Manual URL
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Print tab

On the Print tab, information and settings concerning the connecting 
interface and print default print settings are displayed.

Print tab - Local I/F

You can change the interface timeout settings.

2
Note 

"Mode" can only be displayed when optional local interface kit is 
installed.

Item Description

Timeout Enter the reception timeout for the interface port (input range: 10-
1000).

Mode Select the parallel port transmission method.
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Print tab - Default Settings - General Settings

You can specify the default setting values of the printer.

Item Description

PDL Setting Select the printer descriptive language.

Paper Size Select the paper size.

Tray Select the input tray.

Original Direction Select the print orientation.

Print Method Select whether to perform duplex printing.

# of Sets Select the number of copies to print. (input range: 1-999)

Overwrite A4 <-> Letter You can substitute letter size and 11e17-inch size with A4 or A3 size 
paper.

Proof-Print Document 
Hold Time

Specify the time until the proof and print data is deleted.

Document Hold Time Specify the time to delete the data when the memory has exceeded 
capacity. (input range: 0-30)
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Print tab - Default Settings - PCL Settings

You can specify the default setting values for the PCL mode.

Alternative Input Tray Select the process for when there is no matching paper in the spec-
ified input tray.
Priority Tray: Feeds paper from a different input tray.
Fixed Tray: Displays a warning message without printing. If paper is 
specified that cannot be loaded in the specified input tray, the job is 
deleted.

Item Description

Item Description

Font Name Select the font.

Symbol Set Select the symbol set.

Line/Page Enter the number of lines per page (input range: 5-128).

Font Size Enter the font size for the scalable font and the bitmap font (input 
range: Scalable Font 4.00-999.75, Bit Map Font 0.44-99.00).

CR/LF Mapping Select the CR/LF operation.
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Print tab - Default Settings - PS Settings

You can specify the default setting values of the PS mode.

Item Description

PostScript Error Report Specify whether to enable the printing of errors.
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Print tab - IPP Configuration

You can change the device information.

Scan tab

On the Scan tab, the settings at transmission and the information and 
settings concerning the address book limitations are displayed.

!
Detail 

For details on the Scan tab settings, refer to User manual [Network 
Scanner Operations].

The Scan tab is the Fax/Scan tab when the optional fax kit is installed.

Item Description

Printer Name Specify the device name (up to 127 alphanumeric characters and 
symbols).

Printer Location Specify the device location (up to 127 alphanumeric characters and 
symbols).

Printer Information Specify the printer description (up to 127 alphanumeric characters 
and symbols).
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Network tab

On the Network tab, information and settings concerning the network 
connection are displayed.

2
Note 

"IP Relay Settings" on the Network tab is displayed when optional fax kit 
or scanner unit is installed.
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Network tab - Common Setting - TCP/IP

You can specify the TCP/IP settings.
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2
Reminder 

To apply any changes to settings for "DHCP Configuration", "IP 
Address", "Subnet Mask", "Gateway Address", or "Self-Domain Name", 
restart this machine (turn the main power off, then on again).

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.

Item Description

TCP/IP Configuration Specify whether to enable TCP/IP.

DHCP Configuration Specify whether to enable the DHCP server.

IP Address Specify the IP address of this machine (format: "***.***.***.***", input 
range for ***: 0-255 Note that the following values cannot be entered 
in the most significant byte: 0, 127, 224-255).

Subnet Mask Specify the subnet mask connecting to a network (format: 
"***.***.***.***", input range for ***: 0-255).

Gateway Address Specify the default gateway address connecting to a network (for-
mat: "***.***.***.***", input range for ***: 0-255 Note that the following 
values cannot be entered in the most significant byte: 0, 127, 224- 
255).

RAW Port Number Specify the RAW port number (input range: 1-65535).

Self-Domain Name Specify the domain name for this machine. (up to 64 alphanumeric 
characters and symbols (! # $ % & ’ * + - . / = ? _ ` { | } ~))

Port Number Specify the port number of your device (entry range: 1-65535).

DNS Configuration Specify whether to use the DNS server.

Host Name Input the host name connecting to a network. (up to 64 alphanumeric 
characters and symbols (-))

Domain Name Specify the domain name for this machine (up to 64 alphanumeric 
characters and symbols (! # $ % & ’ * + - . / = ? _ ` { | } ~ @)).

DNS Server Address Register a maximum of three DNS servers (format: "***.***.***.***", in-
put range for ***: 0-255 Note that the following values cannot be en-
tered in the most significant byte: 0, 127, 224-255).

DNS Query Timeout Specify the time for an inquiry timeout to the DNS server.

SLP Setting Specify whether to enable the SLP function.

LPD Setting Specify whether to enable the LPD function.
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Network tab - Common Setting - IP Filtering

You can specify the IP address filter function.

You can specify the access limitations by specifying the IP address of the 
host.

Item Description

Allow Address Specify whether to enable authorization of an IP address setting.

Area 1—3 Enter the IP address being authorized (format: "***.***.***.***-
***.***.***.***", input range for ***: 0-255, and "0.0.0.0" cannot be en-
tered).

Refuse Address Specify whether to enable rejection of an IP address setting.

Area 1—3 Enter the IP address being rejected (format: "***.***.***.***-
***.***.***.***", input range for ***: 0-255, and "0.0.0.0" cannot be en-
tered).
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2
Note 

The rejection setting is given priority when the same address range is 
specified by both Allow Address Area and Refuse Address Area.

When the Allow Address Area setting is enabled, the address area that is 
not specified is specified as the rejection setting.

For DNS server and DHCP server sending and receiving, the IP Filtering 
setting is not applied.

When allowing (not allowing) a single IP address, the three methods 
described below can be specified.

Enter the IP address in the start address and leave the end address 
empty. For example, "192.168.11.22 - empty").

Leave the start address empty and enter the IP address in the end 
address. For example, "empty - 192.168.11.22").

Enter the same IP address in the start address and the end address. For 
example, "192.168.11.22 – 192.168.11.22").
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Network tab - Common Setting - IPP

You can specify the IPP print settings.

Item Description

Printer URI Displays the URI of the printer that can be used for IPP printing.

Enable IPP Specify whether to enable IPP printing.

Accept IPP Jobs Specify whether to enable IPP print jobs.

Operations-Supported Specifies the print operations supported by IPP.
Setting values: Print-Job, Validate-Job, Cancel-Job, Get-Job-At-
tributes, Get-Jobs, Get-Printer-Attributes
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Network tab - Common Setting - NetWare

You can specify the NetWare settings.

Item Description

Enable NetWare Specify whether to enable NetWare.

Frame Type Select the frame type.

Bindery/NDS Select Bindery/NDS.

Print Server Name Enter the print server name (up to 63 alphanumeric characters, ex-
cluding / ¥ : ; * [ ] < > | + = ?).

Print Server Password Specify the print server password (up to 63 alphanumeric characters 
and symbols (spaces ! " # $ % & ’ ~ = ¥ | ; : + * ` / ? @ _ - . , ( ) [ ] { } 
< >)).(The password is displayed by "••••".) If changing the pass-
word, delete "****", and then input the password.

Preferred File Server Enter the preferred file server name of bindery (up to 47 alphanumer-
ic characters, excluding / ¥ : ; , * [ ] < > | + = ?).

Preferred NDS Context Enter the preferred NDS context name (up to 191 alphanumeric 
characters, excluding / ¥ : ; , * [ ] < > | + = ?).
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2
Reminder 

To apply any changes to settings for "Enable NetWare", "Frame Type", 
"Print Queue Scan Rate", "Mode", or "Printer Number", restart this 
machine (turn the main power off, then on again).

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.

Preferred NDS Tree Enter the preferred NDS tree name (up to 63 alphanumeric charac-
ters, excluding / ¥ : ; , * [ ] < > | + = ?).

Print Queue Scan Rate Enter the print queue scan rate (input range: 1-65535 seconds).

Mode Select "PServer" or "NPrinter/RPrinter" as the operation mode of the 
print server.

Printer Number Enter the Nprinter/Rprinter printer number (input range: 0-255, 255 
is automatically given).

Item Description
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Network tab - Common Setting - NetWare Status

"NetWare Server" and "Queue Name" appear as the NetWare connection 
status.
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Network tab - Common Setting - Windows

You can specify the Windows print settings.

Item Description

Enable Windows Printing 
Service

Specifies whether to enable the Windows print (SMB print) service.

NetBIOS Name Enter the NetBIOS name (up to 15 alphanumeric characters and only 
hyphens (-)).

Printing Service Name Enter the print service name (up to 13 alphanumeric characters, ex-
cluding spaces / \ ,).

WorkGroup Name Enter the work group name (up to 15 alphanumeric characters, ex-
cluding spaces \ * + = | : ; " ? < > ,).
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2
Reminder 

To apply any changes to settings for "NetBIOS Name", "Printing Service 
Name", or "WorkGroup Name", restart this machine (turn the main power 
off, then on again).

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.

2
Note 

Only the PCL printer driver can be used with Windows printing.
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Network tab - Common Setting - AppleTalk

You can specify the AppleTalk settings.

Item Description

AppleTalk Specify whether to enable AppleTalk.

Printer Name Enter the printer name (up to 31 alphanumeric characters, excluding 
= ~).

Zone Name Specify the zone name (up to 31 alphanumeric characters, excluding 
= ~).

Current Zone Displays the current zone name.
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2
Reminder 

To apply any changes to settings for "Printer Name" or "Zone Name", 
restart this machine (turn the main power off, then on again).

When turning the machine off, then on again with the main power switch, 
wait about 10 seconds to turn the machine on after turning it off. The 
machine may not operate correctly if it is turned on immediately after 
being turned off.
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Network tab - User Authentication

When performing authentication on an external server with this machine, the 
"User Authentication" menu is displayed on the Network tab.

Item Description

Active Directory Up to 10 domain names can be specified in Active Directory. Enter 
the domain name (up to 64 alphanumeric characters).

NTLM Enter the NT server domain name (up to 15 alphanumeric charac-
ters).

NDS Enter the NDS tree name (up to 63 alphanumeric characters).
Enter the NDS context name (up to 127 alphanumeric characters).
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2
Note 

For details on the authentication of external servers, refer to User manual 
[Copy Operations].
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11.5 Print job management

Specifying job operations

You can specify the job operations on this machine by setting a printer driver.

2
Note 

The five printer drivers that can be set on this machine are as follows:
Konica Minolta PCL printer driver for Windows
Konica Minolta PostScript printer driver for Windows 2000/XP/Server 
2003
Konica Minolta PCL printer driver (VXL) for Windows Vista/Server 2008
Konica Minolta PostScript printer driver (VPS) for Windows Vista/Server 
2008
PPD printer driver for Mac OS X

Specifying settings (for Windows)

1 Click the [Properties] button or the [Preferences] button on the printer 
driver setup dialog box.

2 Click the Setup tab.

– For the Windows Vista/Server 2008 printer drivers, click the Basic 
tab.

3 From the "Output Method" drop-down list, select the output method.

– Print: Prints immediately.
– Secure Print: Enters the ID and password on this machine’s control 

panel, then prints.
– Save in User Box: Specifies the file name and box number and 

saves the document to be printed in a box on this machine.
– Save in User Box and Print: Specifies the file name and box number 

and saves the document in a box and prints at the same time.
– Proof and Print (Proof Print): After part of the document has been 

printed, this machine stops printing temporarily. Select to avoid 
misprinting a large volume of print jobs.
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2
Note 

The Save in User Box and Save in User Box and Print functions can only 
be used when an optional hard disk is installed.

The Save in User Box, Save in User Box and Print, and Proof and Print 
functions cannot be specified when the "Per Page Setting" setting is 
specified.

Up to 8 characters (alphanumeric characters, spaces, and symbols !# $ 
% & ' ~ = \ | ; : * ` / ? @ _ - . , ( ) [ ] { } < >) can be entered in the "Secure 
Print ID" and "Password" text boxes.

The file name for Save in User Box is displayed when the document is 
selected on this machine’s control panel. Up to 30 characters 
(alphanumeric characters, spaces, and symbols !# $ % & ' ~ = \ | ; : * ` / ? 
@ _ - . , ( ) [ ] { } < >) can be entered in the "File Name" text box. Be sure 
to enter a user-friendly file name.
In User Box Number, specify the number of the box that was created. For 
public boxes, enter "1".
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Specifying settings (for Mac OS X)

1 From the "File" menu, select "Print".

2 Select "Security".

3 Specify settings for the following:

– Output Method: Specifies conditions for "Secure Print" and "Save 
in User Box".

– Secure Print: Enters ID and password when "Secure Print" is 
selected from "Output Method". Enter the ID and password on this 
machine’s control panel when printing.

– Save in User Box: Enters the file name and box number when "Save 
in User Box" or "Save in User Box and Print" is selected from the 
"Output Method" drop-down list.

2
Note 

The Save in User Box and Save in User Box and Print functions can only 
be used when an optional hard disk is installed.

When a password rule is enabled on this machine, passwords that are 
usable in Secure Print are limited and jobs are deleted when a password 
that does not meet the password rule is entered. For the password rules, 
refer to User manual [Copy Operations].

Up to 8 characters (alphanumeric characters, spaces, and symbols !# $ 
% & ' ~ = \ |; : * ` / ? @ _ - . , ( ) [ ] { } < >) can be entered in the "Secure 
Print ID" and "Password" text boxes.
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The file name for Save in User Box is displayed when the document is 
selected on this machine's control panel. Up to 30 characters 
(alphanumeric characters, spaces, and symbols !# $ % & ' ~ = \ | ; : * ` / ? 
@ _ - . , ( ) [ ] { } < >) can be entered in the "File Name" text box. Be sure 
to enter a user-friendly file name.
In User Box Number, specify the number of the box that was created. For 
public boxes, enter "1".

Job storage

Depending on the printer driver "Output Method" settings, a print document 
can be stored in this machine as a print job.

To print a stored job, you must recall the job in Box mode using this 
machine’s control panel.
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Recalling jobs (Proof Print)

For details on using the keys on the control panel, refer to User manual [Copy 
Operations].

For details on the box functions of this machine, refer to User manual [Box 
Operations].

1 Press the [Box] key on this machine’s control panel.

2 Touch [Proof Print].

3 From the job list, select the job you 
want to print.

4 Touch [Action].
The Action screen appears.

– To change the settings of the 
printing conditions, proceed to 
step 5.

– If you are not changing the 
settings of the printing 
conditions, proceed to step 7.

5 Touch [Change Settings].

The Change Settings screen appears.
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6 Change the printing conditions on the Change Settings screen, and 
then touch [Enter].

The operation setting screen appears again.

7 Touch [Print].

The stored job is changed to an 
active job, then printed.

2
Note 

To delete and not print a job, touch [Delete].

Jobs in [Proof Print] or [Secure Print] are deleted after being printed or 
when this machine is turned off.

Recalling jobs (Secure Print)

For details on using the keys on the control panel, refer to User manual [Copy 
Operations].

For details on the box functions of this machine, refer to User manual [Box 
Operations].

1 Press the [Box] key on this machine’s control panel.

2 Touch [Secure Print].
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3 Enter the ID and password in Secure 
Print, and then touch [Enter].

4 From the job list, select the job you 
want to print.

5 Touch [Action].

The Action screen appears.

6 Touch [Print].

The stored job is changed to an 
active job, then printed.
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2
Note 

To delete and not print a job, touch [Delete].

Jobs in [Proof Print] or [Secure Print] are deleted after being printed or 
when this machine is turned off.

When the Enhance Security mode is enabled on this machine or when the 
setting is specified to enter password when the operation of the selection 
method of the Secure Print is specified by the software DIP switch, it is 
not necessary to enter the password in step 3. When Secure Print is 
selected in steps 4 and 5, enter the password in the password screen that 
appears.
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Printing with this machine when authentication and account track 

settings have been applied

If account track settings have been specified on this machine, you must 
enter a department name and password in the print driver in order to print a 
job.

If authentication settings have been specified on this machine, you must 
enter a user name and password in the print driver in order to print a job.

2
Note 

If a print job is sent using a user name or password that is not a registered 
account on this machine or if a job is sent without the "User 
Authentication" check box selected, this machine cannot authenticate 
the operation and cannot print. When this occurs, the sent job is deleted.

If a print job is sent using a department name or password that is not a 
registered account or if a job is sent without the "Account Track" check 
box selected, this machine cannot authenticate the operation and cannot 
print. When this occurs, the sent job is deleted.

When user authentication is specified on this machine and the Enhance 
Security mode is enabled or when Access Lock is enabled on the 
software DIP switch, the corresponding user may be locked out and 
denied access if the authentication information is not entered correctly.

For details on user authentication and Enhance Security mode, refer to 
User manual [Copy Operations].

The five printer drivers that can be set on this machine are as follows:
Konica Minolta PCL printer driver for Windows
Konica Minolta PostScript printer driver for Windows 2000/XP/Server 
2003
Konica Minolta PCL printer driver (VXL) for Windows Vista/Server 2008
Konica Minolta PostScript printer driver (VPS) for Windows Vista/Server 
2008
PPD printer driver for Mac OS X

When performing user authentication on the machine and Synchronize is 
specified, you can print by inputting the user name and password in User 
Authentication.
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Specifying settings (for Windows)

1 Click the [Properties] button or the [Preferences] button on the printer 
driver setup dialog box.

2 Click the Setup tab.

– For the Windows Vista/Server 2008 printer drivers, click the Basic 
tab.

3 Click the [User Authentication/Account Track] button.

4 Select a check box, and then enter each item.

– If the "User Authentication" check box is selected, enter the user 
name and password.

– If the "Account Track" check box is selected, enter the department 
name and password.

5 After specifying the settings, click the [OK] button to begin printing.

If the entered password is a password registered on this machine, the 
job is printed. For Account Track, the number of pages to print is 
counted as a job for the specified account.



11 Various settings

11-92 bizhub 362/282/222

Specifying settings (for Mac OS X)

1 From the "File" menu, select "Print".

2 Select "Security".

3 Select a check box, and then enter each item.

– If the "User Authentication" check box is selected, enter the user 
name and password.

– If the "Account Track" check box is selected, enter the department 
name and password.
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12 Troubleshooting

12.1 Unable to print

This chapter explains the troubleshooting procedures for possible 
malfunctions.

Perform the troubleshooting procedures described below if this machine 
does not print after you have sent a print job.

Symptom Probable cause Action

The message "No printers 
are connected" or "Print 
error" appears.

The printer driver selected for 
printing is not compatible with 
the printer controller.

Check the printer name select-
ed.

The network cable, parallel ca-
ble, or USB cable is disconnect-
ed.

Check that the cable is connect-
ed properly.

An error has occurred in this ma-
chine.

Check this machine’s control 
panel.

Available memory space is not 
sufficient.

Perform a test print to check 
whether printing is possible.

A postscript error ap-
pears.

Available computer memory 
space is not sufficient.

Perform a test print to check 
whether printing is possible.

There is an error in the applica-
tion software settings.

Refer to the user’s manual of the 
application software to check 
the settings.

The file printing settings are in-
correct.

Change the settings and try to 
print again.
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The machine does not 
start printing although the 
print job was completed 
on the computer.

The printer driver selected for 
printing is not compatible with 
the printer controller.

Check the printer name select-
ed.

The network cable, parallel ca-
ble, or USB cable is disconnect-
ed.

Check that the cable is connect-
ed properly.

An error has occurred in this ma-
chine.

Check this machine’s control 
panel.

A print job is queued in this ma-
chine, delaying printing.

Check the job order on the Ac-
tive Jobs list of the machine’s 
control panel.

"Save in User Box" was select-
ed for the print job.

Check if the print job is stored 
on the Box screen of this ma-
chine’s control panel.

"Secure Print" was selected for 
the print job.

Check if the print job is held on 
the Secure Print screen of this 
machine’s control panel.

If the account track settings 
have been applied, an unregis-
tered account name (or pass-
word) may have been entered.

Enter the correct account name 
(or password).

If the authentication settings 
have been applied, an unregis-
tered user name (or password) 
may have been entered.

Enter the correct user name (or 
password).

Available computer memory 
space is not sufficient.

Perform a test print to check 
whether printing is possible.

The connection of this machine 
to the network is not yet estab-
lished (while connecting to a 
network).

Consult with the network admin-
istrator.

The Enhance Security mode 
may be enabled on this ma-
chine.

Specify the authentication set-
tings in the Enhance Security 
mode. For details, consult with 
the network administrator.

A password rule may be ena-
bled on this machine.

Enter the password that meets 
the password rule.

Available memory space is not 
sufficient.

Add memory.

Symptom Probable cause Action
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2
Note 

Up to 29 document print jobs (including "Proof Print" and "Secure Print") 
can be stored in the memory of this machine. If more than 29 jobs are 
stored, new jobs cannot be received. Check whether there are print jobs 
remaining in "Proof Print" and "Secure Print" in Box mode on this 
machine’s control panel. If jobs are remaining, print or delete the stored 
jobs.

If the problem persists after all of these procedures have been performed, 
read the User manual [Copy Operations].
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12.2 Unable to specify desired settings or unable to print 
as specified

Perform these troubleshooting procedures if you cannot specify the desired 
settings in the printer driver, or if the print results do not represent the 
settings that have been specified.

2
Note 

Some of the printer driver functions cannot be combined with other 
functions.

Symptom Probable cause Action

A printer driver setting 
cannot be selected.

Some functions cannot be com-
bined.

Do not try to select settings that 
are not available.

The "Conflicts" message 
with "Unable to Select" or 
"Function Canceled" ap-
pears.

An incorrect combination of 
functions has been specified.

Check the settings and specify 
the functions correctly.

Printing is not performed 
as specified.

Incorrect settings are specified. Check each setting in the printer 
driver.

A combination of functions, al-
though possible in the printer 
driver, is not possible with this 
machine.

The paper size, orientation, and 
other settings specified in the 
application have priority over 
those specified in the printer 
driver.

Enter the correct settings in the 
application.

The watermark cannot be 
printed.

The watermark is not correctly 
set.

Check the watermark settings.

The watermark density is set to 
a level that is too low.

Check the density settings.

Watermarks cannot be printed 
in graphics applications.

No watermark can be printed in 
this case.

The staple function can-
not be specified.

Stapling is not possible if "Paper 
Type" is set to "Thick" or 
"Transparency".

Check each setting in the printer 
driver.

The staple function requires op-
tional finisher.

Install the required optional fin-
isher and enable it using the 
printer driver.

Stapling cannot be per-
formed.

If there are a large number of 
pages to be printed, stapling 
cannot be performed.

Print by specify the number of 
pages per set for the number of 
pages that can be stapled.

Stapling is not possible if the 
document contains pages of dif-
ferent sizes.

Check the document.
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The stapling position is 
not as expected.

The orientation setting is not 
correct.

Check the stapling position in 
the printer driver setup dialog 
box.

The hole punch function 
cannot be specified.

Hole punching cannot be speci-
fied if "Booklet", "Transparen-
cy", "Thick2", "Thick3", or 
"Envelope" is selected.

Check each setting in the printer 
driver.

For the hole punch function, the 
punch unit must be installed on 
optional finisher.

Install the required optional fin-
isher and enable it using the 
printer driver.

The pages are not 
punched.

Printed pages may be fed out 
without being punched if the pa-
per is loaded into the paper 
source with an incorrect orienta-
tion.

Check the orientation setting.

The hole punch position is 
not as expected.

The orientation setting is not 
correct.

Check the punch position on the 
Layout tab of the printer driver 
setup dialog box.

The form is not printed 
properly.

Available computer memory 
space is not sufficient.

Simplify the form to reduce the 
data size.

The image is not printed 
properly.

Available computer memory 
space is not sufficient.

Simplify the image to reduce the 
data size.

Paper is not fed from the 
specified paper source.

Paper will not be fed from the 
specified paper source if that 
paper source is loaded with pa-
per of a different size or orienta-
tion.

Load the paper source with pa-
per of the appropriate size and 
orientation.

The numbering function is 
not performed.

The "Collate" (for Windows) or 
"Collated" (for Mac OS X) check 
box is selected on the print set-
up dialog box.

Clear the "Collate" (for Win-
dows) or "Collated" (for Mac OS 
X) check box.

Proof and Print is no be 
performed.

Symptom Probable cause Action
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13 Appendix

13.1 Specifications

Item Specifications

Model Built-in printer controller

Power supply Common with the main body

Processor RM5231

RAM 192 MB

Hard Disk 40 GB (optional)

Interface • Standard:
Ethernet (10Base-T or 100Base-TX), USB (1.1 or 2.0)
• Optional:
IEEE 1284

Frame type Ethernet 802.2
Ethernet 802.3
Ethernet II
Ethernet SNAP

Supported protocols TCP/IP
IPX/SPX
NetBEUI
AppleTalk (EtherTalk)

Print speed 22 pages/minute (bizhub 222, Letter)
28 pages/minute (bizhub 282, Letter)
36 pages/minute (bizhub 362, Letter)

Printer language PCL5e emulation
PCL6 (XL 2.1) emulation
PostScript 3 emulation

Operating environment condi-
tions

Temperature 10 to 30 °C
Humidity 15 to 85% RH

Resolution Data 
processing

600 e 600 dpi 

Printing 600 e 600 dpi 

Supported paper sizes Maximum standard size

Printer fonts PCL:
Latin 80 fonts,
Postscript 3 emulation:
Latin 136 fonts

Compatible computers IBM PC or compatible, Macintosh (PowerPC, Intel Processor)
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Supported 
operating 
systems

Server Windows NT 4.0, Windows 2000 (Service Pack 4 or later), Win-
dows Server 2003, or Windows Server 2008

Client Windows 2000, Windows XP, Windows Vista, or Windows NT 
4.0
Mac OS 9.2 or later, Mac OS X 10.2, Mac OS X 10.3, Mac OS 
X 10.4, Mac OS X 10.5

Printer driver PCL6:
• Windows 2000 (Service Pack 4 or later), Windows XP (Serv-

ice Pack 2 or later), or Windows Server 2003 printer driver
• Windows NT 4.0 (Service Pack 6a) printer driver
• Windows Vista, Windows Vista x64 printer driver
• Windows Server 2008, Windows Server 2008 x64 printer 

driver
PS3:
• Windows NT 4.0 printer driver
• Windows 2000, Windows XP (Home/Professional), Win-

dows Server 2003 printer driver
• Windows XP Professional x64, Windows Server 2003 x64 

printer driver
• Windows Vista, Windows Vista x64 printer driver
• Windows Server 2008, Windows Server 2008 x64 printer 

driver
• Mac OS 9.2 PPD file
• Mac OS X 10.2 printer driver
• Mac OS X 10.3/10.4 printer driver
• Mac OS X 10.5 printer driver

Utility PageScope Web Connection
Web browser:
Windows NT 4.0
Microsoft Internet Explorer 4 or later recommended
Netscape Navigator 4.73 or 7.0

Windows 2000
Microsoft Internet Explorer 5 or later recommended
Netscape Navigator 7.0

Windows XP/Server 2003
Microsoft Internet Explorer 6 or later recommended
Netscape Navigator 7.0

Windows Vista/Server 2008
Microsoft Internet Explorer 7 or later
Netscape Navigator 7.0

* If using Microsoft Internet Explorer 5.5, use Service Pack 1 or 
later.

Item Specifications
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13.2 Configuration page
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13.3 Font list

PCL font list
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PS font list
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PCL demo page
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13.4 Glossary

Term Definition

10Base-T/100Base-
TX/1000Base-TX

An Ethernet standard, which is a cable consisting of twisted copper 
wire pairs. The transmission speed of 10Base-T is 10 Mbps, of 
100Base-TX is 100 Mbps, and of 1000Base-TX is 1000 Mbps.

AppleTalk A generic name for the protocol suite developed by Apple Computer 
for computer networking

Bindery A database for managing a user or group account information, secu-
rity information, server and service information using NetWare 2.x or 
3.x.

bit Abbreviation for Binary Digit. The smallest unit of information (data 
quantity) on a computer or printer. Displays data using 0 or 1.

BMP Abbreviation for Bitmap. A file format for saving image data which 
uses the .bmp extension. Commonly used on Windows platforms. 
You can specify the color depth from monochrome (2 values) to full 
color (16,777,216 colors). Images are not usually compressed when 
saved.

BOOTP Abbreviation for Bootstrap Protocol. A protocol in which a client 
computer on a TCP/IP network automatically specifies the network 
settings from the server. Currently, DHCP, which is an advanced 
protocol based on BOOTP, is mainly used.

Brightness Brightness of a display screen

Byte Unit of information (data quantity) on a computer or printer. Config-
ured as 1 byte equals 8 bits.

Client A computer that uses the services provided by a server through a 
network

Default Gateway A device, such as a computer or router, used as a "gateway" to ac-
cess computers not on the same LAN

DHCP Abbreviation for Dynamic Host Configuration Protocol. A protocol in 
which a client computer on a TCP/IP network automatically specifies 
the network settings from the server. With collective management of 
the IP address for DHCP clients on the DHCP server, you can avoid 
duplication of an address and you can build a network easily.

DNS Abbreviation for Domain Name System. A system that acquires the 
supported IP addresses from host names in a network environment. 
DNS allows the user to access other computers over a network by 
specifying host names, instead of difficult to memorize and under-
stand IP addresses.

DPI (dpi) Abbreviation for Dots Per Inch. A resolution unit used by printers and 
scanners. Indicates how many dots per inch are represented in an 
image. The higher the value, the higher the resolution.

Driver Software that works as a bridge between a computer and a periph-
eral device.

Ethernet LAN transmission line standard

Frame Type Type of communication format used in a NetWare environment.
Communication is not possible if the same frame type is not used.

FTP Abbreviation for File Transfer Protocol. A protocol for transferring 
files over the Internet or an intranet on the TCP/IP network.
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Gateway Hardware and software used as the point where a network is con-
nected to a network. A gateway also changes data formats, ad-
dresses, and protocols according to the connected network.

Grayscale Monochrome image expressive form using the gradation information 
from black to white

Hard Disk Large capacity storage device for storing data. The data can be 
stored even if the power is turned off.

Host Name Displayed name of a device over a network

HTTP Abbreviation for HyperText Transfer Protocol. A protocol used to 
send and receive data between a Web server and a client (Web 
browser). Documents containing images, recordings, and video clips 
can be exchanged with the expressive form information.

IEEE 1284 Abbreviation for Institute of Electrical and Electronic Engineers 1284. 
A parallel port standard that was developed for printers.

Install To install hardware, operating systems, applications, printer drivers 
on to a computer

IP Address A code (address) that is used to identify individual network devices 
over the Internet. A maximum of three digits for four numbers are 
displayed such as 192.168.1.10. IP addresses are assigned to devic-
es, including computers, which are connected to the Internet.

IPP Abbreviation for Internet Printing Protocol. A protocol that sends and 
receives print data and controls printers over the Internet on a 
TCP/IP network. Data can also be sent to printers in remote areas to 
print over the Internet.

IPX/SPX Abbreviation for Internetwork Packet Exchange/Sequenced Packet 
Exchange. A protocol developed by Novel, Inc. that is commonly 
used under a NetWare environment.

LAN Abbreviation for Local Area Network. A network which connects 
computers on the same floor, in the same building, or in neighboring 
buildings.

Local Printer A printer connected to a parallel or USB port of a computer

LPR/LPD Abbreviation for Line Printer Request/Line Printer Daemon. A print-
ing method over a network in a Windows NT system or UNIX system. 
Using TCP/IP, you can output print data from Windows or Unix to a 
printer over a network.

MAC Address Abbreviation for Media Access Control address. With a special ID 
number for each Ethernet card, data can be sent and received be-
tween the cards. A number consists of 48 bits. The first 24 bits con-
sist of a special number for each manufacture controlling and 
assigning IEEE. The last 24 bits consist of a number that the manu-
facturer assigns uniquely to the card.

Memory Storage device for storing data temporally. When the power is 
turned off the data may or may not be erased.

NDPS Abbreviation for Novell Distributed Print Services. Provides a highly 
efficient printing solution in an NDS environment. By using the NDPS 
as a printer server, you can output from the desired printer, automat-
ically download the printer driver of a newly installed printer, simplify 
and automate complicated management environments related to 
printer use, and integrate management related to the network print-
er.

Term Definition
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NDPS Broker An object that shows the NDPS broker. Controls three NDPS print 
services which are: release management service, event notification 
service, and service registration server.

NDPS Manager An object that shows the NDPS manager. Controls all the printer 
agents on a server using a software program.

NDS Abbreviation for Novell Directory Services. The servers and printers 
on a network and the shared resources of the user’s information, as 
well as the user’s access authority over these items can be consoli-
dated in the hierarchy structure.

NetBEUI Abbreviation for NetBIOS Extended User Interface. A network proto-
col developed by IBM. By simply specifying the computer name, you 
can build a small-scale network.

NetBIOS Abbreviation for Network Basic Input Output System. A communica-
tion interface developed by IBM.

NetWare Network operating system developed by Novell. NetWare IPX/SPX 
is used as the communication protocol.

Nprinter/Rprinter Remote printer support module for using a printer server under a 
NetWare environment. Use NetWare 3.x with Rprinter, and NetWare 
4.x with Nprinter.

NWadmin A Novell NetWare utility administrator tool.

OHP/OHT OHP (overhead projector) transparencies which are used for presen-
tations

OS Abbreviation for Operating System. Basic software for controlling 
the system of a computer.

Outline Font A font using lines and curves to display an outline of a character. 
Large-size characters can be displayed on a screen or printed with 
no jagged edges.

Parallel Interface Data transmission method for sending and receiving data of multiple 
signals simultaneously. IEEE 1284 is commonly used as the printer 
connection.

Pconsole A utility tool that controls the print job, print queue, print server, and 
printer.

PDF Abbreviation for Portable Document Format. An electronically for-
matted document which uses the .pdf extension. Based on the Post-
Script format, you can use the free Adobe Acrobat Reader software 
to view documents.

PDL Abbreviation for Page Description Language. The language for spec-
ifying the print image per page to a printer when printing using a 
page printer.

Plug-and-play Ability to automatically find and use the appropriate driver when a 
peripheral device is connected to a computer

PostScript A typical page-descriptive language developed by Adobe and is 
commonly used for high quality printing

PPD Abbreviation for PostScript Printer Description. A file used to de-
scribe the resolution, usable paper size, and the PostScript printer 
model special information.

Preview A function that allows you to view an image before processing a print 
or scan job

Term Definition
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Print Job Print request transmitted from a computer to a printing device

Print Queue A software system which queues the generated print job in the de-
vices

Printer Buffer Memory domain temporarily used for data processing of a print job

Property Attribute information
When using a printer driver, various functions can be specified in the 
file properties.
In the file properties, you can check the attribute information of the 
file.

Protocol The rules that allow computers to communicate with other comput-
ers or peripheral devices

Proxy Server A server that is installed to act as an intermediary connection be-
tween each client and different servers to effectively ensure security 
over the entire system for Internet connections

Pserver Print server module under a NetWare environment that monitors, 
changes, pauses, restarts, or cancels a print job

Queue Name Name specified to each device that allows printing when network 
printing

Resolution Displays the ability to reproduce the details of images and print mat-
ter correctly

RIP Abbreviation for Raster Image Processor. Process that develops pic-
ture images from described text data using the PostScript page de-
scription language. The processor is usually integrated in the printer.

Screen Font A font for displaying text and symbols on a CRT monitor

Shared Printer A printer setup that allows the printer to be used by multiple comput-
ers connected to a server over a network

SLP Abbreviation for Service Location Protocol. A protocol capable of 
finding services over a TCP/IP network and automatically specifying 
a client.

SMB Abbreviation for Server Message Block. A protocol that shares files 
and printers over a network and which is mainly used by Microsoft 
Windows.

SMTP Abbreviation for Simple Mail Transfer Protocol. A protocol for send-
ing and forwarding e-mail.

SNMP Abbreviation for Simple Network Management Protocol. A manage-
ment protocol in a network environment using TCP/IP.

Spool Abbreviation for Simultaneous Peripheral Operation On-Line. For 
printer output, data is not sent directly to the printer, it is temporarily 
stored in another location, then sent to the printer collectively.

Subnet Mask The unit used to divide a TCP/IP network into small networks (sub-
networks). It is used to identify the bits in a network address that are 
higher than the IP address.

TCP/IP Abbreviation for Transmission Control Protocol/Internet Protocol. 
The de facto standard protocol used by the Internet that uses IP ad-
dresses to identify each network device.

Term Definition
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TrueType An outline font that was developed by Apple Computer and Micro-
soft. It is used as a standard by Macintosh and Microsoft Windows 
and can be used both on a display and in print.

Uninstall To delete software installed on a computer

USB Abbreviation for Universal Serial Bus. A general interface standard 
for connecting a mouse, printer, and other devices to a computer.

Web Browser Software such as Internet Explorer and Netscape Navigator for view-
ing Web pages

Term Definition
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13.5 Index

A

Account track 5-25, 6-19, 7-16, 
8-17, 10-6, 10-15, 11-90
Add Printer Wizard 3-12
Administrator mode 11-34, 11-49

B

Back cover 5-21, 6-21, 7-22, 8-24, 
9-6, 10-5
Basic tab 8-9
Bindery 4-23
Bindery emulation 4-23, 4-25
Bindery/NDS 11-73
Binding direction 8-19
Binding margin 8-20
Binding Position 9-6, 10-6
Booklet 8-19
Booklet printing 5-15
Border 8-19, 9-6, 10-4

C

Center staple and fold 9-6, 10-6
Collate 5-19, 10-6
Collated 9-5, 10-4
Color selection 8-35
Color settings 8-35
Combination 8-19, 9-6, 10-6
Configure tab 8-39
Copies 9-5, 10-4
Copies & pages 10-4, 10-9
Cover Mode tab 8-23
CR/LF mapping 11-64
Custom page sizes 8-10, 8-43, 9-4, 
10-3, 10-8

D

Driver settings 8-45
Duplex 8-19, 9-6, 10-6
Duplex printing 5-15, 11-63

E

Editing a watermark 6-29, 7-24, 
8-27
Editing forms 6-26
Enable NetWare 11-73
Enable Windows Printing Service 
11-76
Enlargement and reduction 5-12
Exporting 8-49

F

File margin 6-12, 7-20
Finish tab 8-21
Finishing 9-6, 10-6, 10-13
Flip Horizontal 9-4
Flip vertical 9-4
Font list 13-6
Font settings 8-36, 9-5
Font size 11-64
Font tab 6-32
Front cover 5-21, 6-21, 7-22, 8-24, 
9-6, 10-5

G

General 9-5
Glossy mode 8-35

H

Hole punching 8-22
Hole-Punch 5-17, 6-13, 7-21, 9-6, 
10-6
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I

Image compression 8-35
Importing 8-49
Input tray 5-13, 11-63
Installer 3-6
Installing the printer driver 3-3, 3-7, 
3-21
Interfaces 2-8
Invert image 9-4
IP address 4-7
IPP printing 4-17

L

Layout 9-6, 9-11, 10-4, 10-10
Layout direction 10-4
Layout tab 7-18, 8-18
Line/page 11-64
Logging on to administrator mode 
11-34
LPR printing 4-13

M

Mac OS 3-21
Mac OS 9.2 3-28, 9-3
Mac OS X 3-21, 3-23, 3-26, 10-3
Macintosh 3-21, 4-34
Mode 11-62

N

N in 1 6-11, 7-19, 8-19
NDPS 4-31
NDS 4-27, 4-29
NetBIOS 11-76
NetWare 4-23
Network 4-3
Network connection 3-4, 4-5
Novell Distributed Print Service 4-31
Nprinter 4-23

O

Offset 5-19, 9-6, 10-6
OHP interleaving 9-6
Operating environment 2-7
Operating system 2-7
Option tab 6-33, 7-26
Options 8-39, 9-14, 10-18
Orientation 5-10, 9-4, 10-3
Original direction 11-63
Original size 5-11, 8-9
Output method 5-18, 6-14, 7-11, 
8-12, 10-6
Output options 10-4
Output size 5-11
Output tray 8-22, 9-6, 10-6
Overlap width line 8-19
Overlay 5-22, 8-29
Overlay file 8-33
Overlay tab 6-24

P

Page attributes 9-4, 9-7, 10-3, 10-7
Page setup 9-3, 9-7, 10-3, 10-7
Pages 9-5, 10-4
Pages per sheet 9-6, 10-4
PageScope Web Connection 4-9, 
11-29
Paper 9-4
Paper feed 10-5, 10-11
Paper size 8-9, 8-11, 10-3
Paper source 5-13, 6-9, 9-5
Paper tray 8-11
Paper type 5-14, 10-5
Parallel connection 3-4
Pattern 6-31, 8-35
PCL 3-3
PCL demo page 11-48
PCL driver 6-3, 8-3
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PCL font List 11-48
PCL settings 11-47
PDL setting 11-63
Per page setting 5-21, 8-24
Per page setting tab 6-21, 7-22
Plug and Play 3-9
Poster mode 8-19
PostScript 3-3
PostScript driver 7-3
PostScript error report 11-65
PPD driver 9-3, 10-3
Print 2-5, 9-5, 9-10, 10-4, 10-9
Print job 11-82
Print server mode 4-25, 4-29
Print type 5-15, 8-19
Print with black 6-31
Printer controller 2-3
Printer driver 3-3, 3-21
Printer fonts 5-24
Printer margins 10-3
Printer specific options 9-12
Printing methods 5-3
Printing multiple pages on one page 
5-16, 6-11, 7-19, 9-11, 10-10
Printing operations 5-3
Proof and print 6-14, 7-11, 11-82
Proof print 8-12
PS font list 11-48
PS settings 11-47

Q

Quality adjustment 8-35
Quality tab 6-31, 7-25, 8-35

R

Recalling jobs 11-86, 11-87
Remote printer mode 4-23, 4-27
Resolution 8-35, 9-6

S

Saddle stitch 8-22
Save in user box 6-14, 7-11, 8-12, 
10-6, 10-15, 11-82
Saving the driver settings 6-35, 
7-28
Scale 9-4, 10-3
Secure print 6-14, 7-11, 8-12, 
10-6, 10-15, 11-82
Security 10-6, 10-15
Selecting a printer 3-23
Setting up the system 2-10
Settings tab 8-42
Setup 10-5, 10-12
Setup tab 6-7, 7-9
Skip blank pages 5-20
SMB printing 4-10
Software tools 8-40
Specifications 13-3
Stamp/Composition tab 8-27
Staple 5-17, 6-13, 7-20, 9-6, 10-6
Stapling 8-21
Starting up a software tool 8-40
Stop 9-6
Substitute fonts 9-4
Supported operating systems 3-3
Symbol set 11-64

T

Test printing 5-4
Timeout 11-62
Transparency interleave 8-26, 10-5
Tray 11-63
Troubleshooting 12-3
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U

Unable to print 12-3
Uninstalling the printer driver 3-30
USB connection 3-4
User authentication 5-25, 8-15, 
10-6, 10-15
User mode 11-37

V

Various settings 11-3

W

Watermark 5-23, 8-27
Watermark tab 6-28, 7-23
Windows 3-4

Z

Zone 11-78
Zoom 5-12, 8-9
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